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Introduccion a la Programacion Object Pascal con Rad Studio Delphi XE & Lazarus

Delphi — Object Pascal para versiones © Embarcadero XE & Lazarus free Pascal

Delphi/Lazarus son entornos de programacion del tipo RAD (Disefio Rapido de Aplicaciones) basado en el

lenguaje Object Pascal, creado por Borland y continuado por Embarcadero. Su caracteristica principal es que
posee un control de bases de datos muy amplio, compatible con Oracle y a partir de las versiones XE permite
aplicaciones multiplataforma dentro de su framework Firemonkey. Rad Studio incorpora también C++ Builder.

Lazarus es la version gratuita, multiplataforma y open source compatible y similar a la versién Delphi 7.
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Ejercicio 1. Crear una ventana “hola mundo” y un botdn para cerrar.
En primer lugar, antes de trabajar con Delphi, es aconsejable que crees una carpeta (subdirectorio) con tu
nombre para guardar ahi los ejercicios.
e Crear un proyecto nuevo:
» Delphi XE: Elige del menu: File »New » Aplication (o VCL Forms application)
v Lazarus: Elige del menu: Archivo — Nuevo -Proyecto — Aplicacidn
Te aparecera una ventana o formulario vacio (Form). En el panel izquierdo Inspector de objetos (Object
Inspector), veras las propiedades (Properties) de la ventana y de los objetos que en ella pongas.
e Cambiar el nombre de la ventana: En el panel Inspector de objetos (Object Inspector), pestafia Properties
(Propiedades), haz clic en Caption y en su casilla escribe: Ventana para poner un rétulo a la ventana.
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Standard, haz clic en el componente Label Abc (Etiqueta) y luego = TcomboBox  Cuadro combinado
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Puedes cambiar la propiedad Color y Font para cambiar el @ (TFont) crDefault
color y tipo de letra favorita: Sive 12 .
Con la etiqueta Labell seleccionada, busca la propiedad: b » Font y pulsa en

la flecha izquierda para ver sus subpropiedades. Cambia el valor Size a 12.

e Poner el boton de Salir: En la ficha Standard de la paleta, selecciona el componente RS ¥ErA (=]
Button (o« ]) y haz un clic en la ventana de tu proyecto para soltarlo encima este boton.
Cambia su propiedad Caption por: &Salir (El & subraya la letra principal hotkey)
Para cambiar el tamafio botdn puedes usar sus propiedades With y Height o arratra los
tiradores de sus esquinas con el raton.

e Asignar la accion al botén Salir: Pulsa doble clic sobre el botdn Salir para abrir laventana f:::-o-oco0ooo

de cédigo. Observa que ya nos ha escrito el inicio y final del subprograma o procedimiento:
procedure TForml.ButtonlClick(Sender: TObject);
begin

end;
Para indicar una accion a un objeto escribir el nombre del objeto, un punto y su accién: Form1l.close;
Si no pones el nombre del objeto, te refieres a la ventana en general: s6lo deberas escribir la palabra: close
cerrar la ventana) en el lugar indicado:

Procedure TForml.ButtonlClick(Sender: TObject); // -> en Delphi // -> en C++ Builder:
Begin {
close; // -> Al final de una linea de cédigo, poner punto y coma (;) Close();
}
end;

e Compilar y probar el programa: Pulsa el boton Run I o eligelo del menu Ejecutar (Run).
En el modo de ejecucion puedes comprobar su funcionamiento: al pulsar en el boton se cierra la ventana.
e Guardar el proyecto:

- Para guardar la ventana del formulario y su cédigo asociado elige del menu: File » Save as... Holal.pas
- Para guardar el proyecto completo: elige del menu: File » Save project as... Hola (*.dpr o *.pdroj)
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Ejercicio 2. Crear un contador de botones. Cambiar el nombre de los botones.

e Crea un nuevo proyecto. = o g Button2
Delphi: File » New » Application (VCL Forms) Ea”f_'l .o\ O Ventana =
Lazarus: Archivo » Nuevo Proyecto » Aplicacion apHon: \ MRt et
e Busca en la paleta Estandar los siguienes q - 0 i i)
componentes y ponlos sobre el formulario, [
(ventana vacia) como en la imagen: — [ D _ :
[ oneral | ... Salir .
- 3 componentes tButton //I/p ....... | S | — ij-\?\“‘“‘%autmna
- 1 componente tPanel [JJ Buttonl

e Selecciona cada componente afiadido y en el Objet inspector (F11) cambia las siguientes propiedades:
En el Buttonl.Caption: Poner a cero
En el Button2.Caption: Contar
En el Button3.Caption: Salir
En el Panell. Caption: 0 ;
En el Panell. Color: clWhite (blanco)
e Selecciona cada componente creado y en el Objet inspector (F11) cambia los siguientes eventos, pulsando
doble clic sobre el evento: On clic o directamente sobre el componente:

Eventos: (pulsar doble clic en cada objeto)

Cédigo en Delphi / Pascal Cédigo en En C++ Builder
En el Botdnl: procedure TForml.ButtonlClick(Sender: TObject);
begin Panell->Caption="0";
Panell.Caption:='0";
end;

En el Boton2: procedure TForml.Button2Click(Sender: TObject);

begin Panell->Caption=
Panell.caption:=IntToStr(Strtoint(Panell.caption)+1); IntToStr(StrToInt(Panell->Caption)+1);
end;

En el Boton3: procedure TForml.Button3Click(Sender: TQbject);

begin Close();
Close;
end; Cambia la variable del tipo numérico entero a cadena de texto

Comentarios al ejercicio:
Algunos componentes tienen propiedades del tipo de texto, numérico o Iogicas.
No se pueden igualar o comparar propiedades de tipos diferentes. Para ello se debe realizar una conversion
de un formato a otro:
» IntToStr convierte un valor numérico en un valor de texto para que se puedra mostrar en el panell
»  Strtolnt Convierte un valor de tipo texto en su valor numeérico

Probar la aplicacion:
Pulsa el boton Run P> o eligelo del men( Ejecutar (Run) para comprobar su funcionamiento.

Guardar el proyecto: Crea una carpeta que se llame: Contador.
e Escoge: File » Save as... Para guardar el archivo de cddigo en la carpeta con el nombre: Contadorl.pas
e Escoge: File » Save project as... Para guarda el proyecto en la carpeta con el nombre contador.dproj
En Lazarus: Escoge del menu Archivo - Guardar todo.
Primero nos pide el proyecto: Contador.lpi (Lazarus Project) y luego la unidad: Contadorl.pas

Conversiones de tipos de datos

IntToStr (Integer to String) » Cambia del tipo de nimero entero a cadena de texto
StrTolInt (String to Integer) » Cambia del tipo cadena de texto a niUmero entero

Otros:

StrToDate (Texto a fecha) StrToFloat (texto a decimal flotante)
InToEx (Entero a Extended) DateToStr (Fecha a Texto)
DateTimeToStr (Fecha/hora a texto) FloatToDecimal (Decimal flotante a decimal)
FloatToStr (Decimal flotante a texto) StrToTime (Texto a hora)

Formatfloat (Decimal flotante a texto con formato)



Teoria: Objetos, componentes y clases:

» Un componente es una clase de objeto. Por eso, un componente le solemos llamar a un objeto disponible en
la Toolbar.

» Un objeto es un conjunto de datos de la misma clase o tipo. Por eso empieza generalmente por la letra T,
porque pertenencen a clases de tipo genérica (T class) (TForm es la clase de los formularios, TButton la clase
de los botones, etc.)

» Una clase es una plantilla o estructura que contiene la definicién del tipo de datos que emplea. Ejemplo:

TForml = class(TForm)

El objeto Formulariol pretenece a la clase Formularios

Verdadero

Estructura condicional. Toma de decisién

if comparacién then accién_verdadera else accion_falsa ;
Realizara una accion u otra segun si cumple una comparacion
Nota. Asignhar o comparar un valor.

= Para asignar un valor a un objeto o variable se indica con [: =| Ejemplo: progressBar1.position := 100;
= Para comparar el valor de un objeto o variable se indica con | =] Ejemplo: if ProgressBarl.position = 100..

(En lenguajes C, C++, para asignar un valor es = y para comparar ==
Otros comparadores son:

Comparador simbolo ejemplo

Igual = if ProgressBarl.position=100 then Showmessage (‘Has llegado a 100’);
Mayor > if ProgressBarl.position>100 then Showmessage (‘Te has pasado de 100’);
Menor < if ProgressBarl.position>100 then Showmessage (‘Aun no has llegado a 100);
Mayor o igual >= if edad>=100 then Showmessage (‘Has llegado o te has pasado de 100’);
Menor o igual <= if edad<=100 then Showmessage (‘Aln no has llegado a 100’);

Distinto <>0 I= if edad <> 100 then Showmessage (‘No es 100’);

Ejercicio ventana con barra de progreso

= Crea un nuevo proyecto: File » New » Application VCL (o VCL Forms application).

Disefio: : __® o
* Aflade al formulario un objeto w@ ........... Transferencia.. ~~  lror]n - jmkde
barra de progreso tProgressBar Enabled [+ True e
(de la paleta win32), dos Interval 00 : , ,
botones (tButtons), una etiqueta MName Timerl | | Transfiriendo archivos a mi cuentasl. - - - - - - - - -
tLabel (de la paleta Standard) y

Tag a
un componente tTimer (Paleta [Propertes | ProgressBar1 E( f

System) Max
= Distribuye y cambia las Min o - Cancelar
. Mame ProgressBarl - : o
propiedades de la ventana- Orientation pbHorizontal - © - By i
formularlo ComO en |a Imagen Position El ..................................................

Eventos: (Suceso que desencadena una accion)
» Pulsa doble clic sobre el evento OnTimer del Timerl para mostrar el cddigo de su procedure y afiade:

procedure TForml.TimerlTimer(Sender: TObject);

begin
ProgressBarl.position := ProgressBarl.position+1; //-> incrementa la barra una posicidn
if ProgressBarl.position=100 then //-> si 1llega a 100..
begin
Timerl.Enabled:=False; // -> Para el temporizador
ShowMessage('Transferencia realizada'); // -> muestra un mensaje
Application.Terminate; //-> termina el programa
end;
end;

Opcional: Puedes impedir cerrar la ventana si en el evento del form: Closequery pones la variable canClose:=false;
Ejemplo: ShowMessage('No puedes cerrar la ventana mientras se transfieren los archivos'); canClose:=false;
» Probar la aplicacién: Pulsa Run > para comprobar su funcionamiento.
= Guardar el proyecto: Crea una carpeta que se llame: Transferencia
o Escoge: File » Save as... Para guardar el archivo: Transferencial.pas
o Escoge: File » Save project as... Para guarda el proyecto Transferencia.dpr
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Uso del Timer y posicion del objeto:

= Crea una nueva aplicacién VCL (libreria visual) escogiendo del menu: File - New — VCL Form Applicaton.
= Afiade un botdn Button1 en un formulario nuevo. Cambiar su propiedad Caption por: Pulsame.

= En el evento del botdn OnMouseMove:
Buttonl.Left := Buttonl.Left + 1;

Ejecuta y prueba (Run P): Al intentar pulsar el botdn, este
se desplaza hacia laderecha. T T

= Anula esta Ultima linea de cAdigo convirtiéndola en un T @il I I Il T T DD DDl

comentario: aflade // delante Buttonl TEutton
~ . . Caption |Pdlsame
= Afiade un componente Ttimer de la paleta System. T riae | ——————————

Poner su propiedad Interval a 10 y si propiedad enabled .. o L

en False: ooiiiiiiiiiiiiiiiiioin

En el evento del botén OnClick: DU Timer1 TTmer
Timerl.Enabled := True; © . lEnabled |[]False

En el evento del Timer OnTimer: <o - - (Interval 10
Buttonl.Left := Buttonl.Left + 1; - - - [Name Tirner 1

Ejecuta y prueba (Run P): Al pulsar el botdn, activamos el temporizador Timer que desplaza un pixel a la derecha la
posicidn del botdn a cada pulso de su intervalo, de duracién 10 milisegundos.

Para guardar primero la unidad y luego el proyecto, escoge del menu: File » Save project as...

Calcula tu edad. Uso de variables de fecha y decimal

Una variable almacena un valor temporalmente para utilizarlo después.
Se nombran o declaran al inicio del procedimiento en la

., . P [——— -]
seccion var y pueden ser de fecha (datetime), numéricas €3 Formé [s ][0 Fecha_ini TDateTimePicker

(integer), decimales sencillas o dobles (single o double), = oo

de texto (string), etc...

= Crea una nueva aplicacién:
Delphi: menu: File - New — VCL Form Applicaton.
Lazarus: Archivo — Nuevo — Proyecto/Aplicacion
= Afiade un botdn Buttonl y dos etiquetas labels Abc
= Aflade un selector de fecha. Delphi: DatetimePicker de la
paleta Win32. Lazarus: DateEdit de la paleta Misc
= Cambia el nombre de los DatetimePicker por:
Fecha_ini y Fecha_fin
= Pulsa doble clic sobre el botdn y escribe en el evento del botdn OnClick:
Procedure ...Button1Click(Sender: TObject);

var
dias:double; //-> creo una variable decimal doble
hoy:Tdatetime; //-> creo una variable de fecha-hora

begin
dias:=Fecha_Fin.Date-Fecha_ini.date; // -> resto las dos fechas

hoy:=date();
Showmessage('Hoy es '+ datetostr(hoy)+
end;
= Pulsa Run P o F9 para comprobar su funcionamiento.

y han transcurrido '+floattostr(dias)+' dias');

A4 !

Variante del ejercicio. Calcula tu edad: - - - Escoge tu fecha de nadmiento - - - -
= Con el componente Calendar o MonthCalendar cambia el formulario como en la ‘ I
. marzo de 2014 L)
imagen - iy o i do. |
. , . | u. ma. mi U, ¥, Ed. 0.
= Escribe en el evento del botén OnClick: | 24 25 26 le—. 1 2
procedure TForml.ButtonlClick(Sender: TObject); /'3 4 5 6 7 8 9
var Co1m11 12 13 14 15 18
dias:double; //-> creo una variable para guardar los dias S| 17 1819 21 22 3
anos:double; // -> creo una variable para guardar los afios )35 2 728 29 30
hoy:Tdatetime; //-> creo una variable para guardar el dia de hoy 312 3 4 56
begin : [ Hoy: 20/03/2014
hoy:=date(); // -> guardo en la variable el dia de hoy [ oooooo il
dias:=hoy-Calendarl.Date; //-> calculo los dias transcurridos Dol llll Caloularedad | DT
anos:=dias/365; //-> calculo los afos transcurridos 0 o

Showmessage('Tienes '+FormatFloat('##0.##',dias)+' dias o '+FormatFloat('##0.##',anos)+ ' afios');
end;

Ejecuta y guarda (Run): Pulsa Run > o F9 para comprobar su funcionamiento.
Para guardar primero la unidad y luego el proyecto, escoge del menu: File » Save project as...



Teoria: Conceptos basicos de programacion.

Procedimientos v funciones:

Un Procedimiento (procedure) es una subrutina o subprograma que puede ser llamado desde varias partes del

programa principal. A diferencia de una funcidn, éste no devuelve ningln valor de respuesta, pero si puede recoger

datos o parametros del lugar desde el que se llamé utilizando el “Sender” como paso de parametros.

» Funcién: Es un procedimiento o subrutina que ademas devuelve un valor de respuesta (Result)

» Pardmetro: Es una variable o un valor que es pasado a un procedimiento o funcidn.

» Sender: Es un parametro que informa a un procedimiento o funcidon desde qué componente (objeto) ha sido
llamado. Se utiliza mucho para agrupar varios botones con un procedimiento parecido (lineas de codigo comunes).

Ejemplo de sender: Procedure TForm1.Button1Click(Sender: TObject);
En este ejemplo, asignando el mismo evento begin . ,
a ambos botones. una ventana de mensaie if Sender = Buttonl then showmessage(‘*Has pulsado’ +
B ’ i ) buttonl.caption)
mostrara el texto de cada boton. else if Sender = Button2 then showmessage(*Has pulsado’ +
button2.caption);
end;
Ejemplo de funcién: Function EsPrimo (N: Integer): Boolean
La funcidn recoge un parametro de entraday var; /] Funcion Numeros Primos----
devuelve otro de salida i: Integer; //Para contador del bucle
e o . begin
Se especifica en su declaracion el tipo y valor de EsPrimo := True;
entrada (entre paréntesis) y de retorno. En este Fori:=2 toN-1do
caso el tipo es boolean. if (N mod Test) = 0 then //mod resto de la division es cero
begin
. EsPrimo := False;
Luego puedes ser llamada desde cualquier break; //salta fuera del bucle
procedure si se declara en la seccion publica o end;
privada. end;
end;

Llamada a la funcidn:
If Esprimo(7) = true then showmessage(‘Es primo’);

Bucles v bifurcacion: ‘ [-

Bifurcacién simple: '
e if ...then ... else: IF edad >= 18 THEN labell.caption:='Mayor de edad’
Equivale al SI condicional ELSE labell.caption:='Mayor de edad’;

No se afiade “;” de final de linea antes del
Else. Sila condicion ocupa varias lineas es necesario afiadir Begin —

f
End case edad o

0..18: Labell.caption:='menor edad’;
18..60: Labell.caption:='mayor edad’;
60..99: Labell.caption:='anciano’;
o Case: else Labell.caption:="no vale’;
Bifurca las acciones dependiendo de diversos resultados de end;
un parametro del tipo ordinal.

(Numero o caracter ordenado alfab.)

Bifurcacién multiple:

%m- i while i<10 doi:= i+1;
While: Repite la ejecucion infinitas veces hasta que
se cumpla la condicion.
Finito (Contador): L

For ... To, o For... Downto: for i:=1 to 100 do

Ejecuta una accion un namero determinado de veces. Begin . ) .
o To: Incrementa cada vez el bucle Labell. caption: ="Paso nimero” + i;

Beep; // tono sonoro

o Downto: Decrementa cada vez el bucle. End;

Ejemplo-ejercicio Password:

= Crea un nuevo proyecto (File — New — Windows Application) (Archivo — Nuevo — Aplicacion)
= Aflade un Button de la paleta Standard y cambia sus propiedades: r
Enabled = false ; Caption = OK
= Afiade por encima un Edit con propiedad PasswordChar = * ;
= Pulsa doble clic en el Editl y escribe, dentro de su procedure, el cédigo:
If Editl.text = ‘danone’ then buttonl.enabled:=true;

= Pulsa doble clic en el Buttonl y escribe: Showmessage('Vale’); Lo
Comprueba P y guarda la unidad con el nombre Clavel y el proyecto: Clave | [Button1.Enabled = False

Form1 - a X ]
i \Edit1.Passwordchar= *

HhERE

i:: Ll Ok
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Ejercicio de conversidon de variables. Convertidor de Euros. Para Delphi 7+ Lazarus

e Ingredientes:

Empieza un proyecto nuevo #& Form1 (=]
Windows Aplicacion en Delphi

0 Nuevo — Proyecto —
Aplicacion en Lazarus.

Afade al formulario los
siguientes componentes de la i i

paleta Standard: SRR
= 2 botones (TButton) [ox | ik
= 2 cuadros de texto (TEdit)
= 1 etiqueta (TLabel) Abc

e Preparacion:
En el panel: Object Inspector

[S] Label1: TLabel

(F11), pestafia de propiedades (Properties) Propiedades Eventos Favoritos Restr
Edit 1 y Edit2: Cambiar su propiedad Text al valor: 0 > -:ohversor€ a$

Botones 1y 2: Cambiar su propiedad Caption al texto de la figura superior.

. . i : v Font (TFont)
Label 1: Cambiar la propiedad Caption al texto de la figura. On |On
La propiedad Font — Style a Negrita (Bold) y el tamafio (Size=12) > 12
e Coccion:
Pulsar doble clic sobre el botén 1 para afiadir al evento Onclic las siguientes lineas de comando:
(Lineas a afiadir en negrita) Comentarios

procedure TForml.ButtonlClick(Sender: TObject);

var variables a utilizar:
numerol,numero2:double;

begin numerol y nimero2 del tipo numéricas con decimales
numerol:=strtofloat(editl.text);

numero2:=numerol/166.386; NU ; :
! umerol vale el texto del Edit1 convertido
edit2.text:=floattostr(numero2);

end; Numero2=numero2/166,386 (poner punto decimal)
El texto del Edit2 serd el valor de la variable nimero2
convertida a string

Ejercicio Propuesto:
Pulsa doble clic sobre el botdn 2 y afiade el cddigo al bot6n2 para que multiplique el valor de Editl por
166,386

Variantes al programa:
Para evitar tener que crear variables que almacenen el valor temporalmente, podriamos haber realizado la
conversion directamente del siguiente modo:
Edit2.text:=floattostr(strtofloat(editl.text)/166.386)
Sin embargo, es mas practico y analizable, dividir el cédigo en varias lineas.
Para controlar error de introducir texto en un Edit para valor numérico:
Se puede controlar con un MaskEdit, 6 usando la funcién Format, FormatFloat/FloatToStrF o evaluando
si es numérico antes de realizar operaciones matematicas: IsNan (Is Not a Number). Véase la ayuda.

Guardar el proyecto: Guarda el proyecto y su unidad (conversorl.pas) en una carpeta independiente
\Projects\Conversor con el nombre del proyecto: Conversor.dpr

Crear y asignar un icono a la aplicacion:

» Para Windows 7: Delphi 7 Incorporaba Image Editor que permitia crear imagenes *.ico. Para Delphi XE:

Utilizar un programa como Microangelo (www.microangelo.us) o similar para crear iconos *.ico

Para Windows 10: Delphi XE 10.2 puede cargar un logo en formato PNG a 150 y 44 pixels.

Poner titulo al programa y cargar el Icono correspondiente:

Elige del menu: Proyect » Options - Solapa: Aplication. Load Icon que previamente has guardado.

En la solapa Versioninfo: Rellenar la Version 1.0 y el nombre de la compaiiia.

Vuelve a compilar el proyecto y sal del programa Delphi guardando todos los cambios.

Comprueba cémo ha cambiado el archivo de la aplicacion (conversor.exe). Es el tnico archivo que

necesitas para el funcionamiento de esta aplicacion.

Distribucién e instalacion de la aplicacion:

Instalacion independiente para Windows:
Utiliza el Programa InstallShield o InnoSetup (www.jrsoftware.org) para generar el programa de
instalacion: Indicando en este, dénde se encuentra el proyecto Conversor.dpr y/o el ejecutable.

Instalacién mutiplataforma: Mas adelante se explica como se genera el archivo *.apk en la subcarpeta
Android (debug o release) y se sube a la PlayStore de Google. Delphi XE 10.2 permite generar también
para la tienda de Windows 10 o la Appstore de Apple.

v

v v v v



http://www.microangelo.us/

Ejercicio: Navegador OfiChrome (CutreChrome)

= Crea un nuevo proyecto File » New » Application VCL (o VCL Forms application).

Disefio: -
Properties |Edit]l TEdi! sy I
® Afiade al formulario " jgn alTop 2 Cutre Crhome == |
un objeto Edit Alignment taLeftiustify || MEEP://www.google.es {
(de la paleta AlignWithMargins ||| False ?::::::::::::::::::::::::T’:::::::::::::::::::55555:*'
Standard) y un Mame Edit1 2 o o | : - o o o
. Text http:/ /www.google.es |~ © [ ...
Objeto e e
WebBrowser (de .-""" oot

la paleta Internet Properties| WebBrowser1 =" - - -

- Distribuye y Align alClient
- Mame WebBrowser 1
cambia las Offline False
propiedades de la Cursar aDefault
ventana-formulario  |CustomHint
como en la imagen  |DragCursor aDrag
DragMode dmManual

® Selecciona el Edit 1 y en la pestafia Events pulsa doble clic sobre el evento:

OnKeyPress. Escribe el codigo:

procedure TForml.EditlKeyPress(Sender: TObject; var Key: Char);

begin

Properties |Events | Editl TEdit

OnChange

OnClick

OnKeyDown

OnkeyPress Edit1KeyPress

if key=#13 then WebBrowserl.Navigate(Editl.Text); //si la tecla presionada es la n2 13 = INTRO

end;

Comentarios: Al pulsar la tecla INTRO en el editl pone en la direccion del navegador, el texto del Editl

Algunos Codigos de tecla ASCII: Valor Jm‘ Form1 TForm 1
Retroceso {backspace}, #8 Action
Tab {tab} #3 ActiveControl
Supr {delete} o {del} #127 Align alNane
Entrar {enter} o~ #13 BorderStyle bsSizeable
Esc {esc} #27 Borderwidth ]
] y ] ) Caption Cutre Crhome
* Probar la aplicacion: Pulsa Run > para comprobar su funcionamiento. ClientHeight 414
» Guardar el proyecto: Crea una carpeta que se llame: OfiChrome Clientiidth 409
. . ) Col IBtnF.
o Escoge: File » Save as... Para guardar el archivo: OfiChrome.pas o Er::nl e
o Escoge: File » Save project as... OfiChrome.dpr Width 4325
WindowMenu
Meioras: WindowState wsMaximized

En la ventana: En la propiedad de la ventana Form1 cambia su estado por maximizado: WindowState:
wsMaximized y el texto de la ventana (Caption) por CutreChrome

® Afiade un Panell alineado al Top

= Donde pondremos tres botones y el Editl
como de muestra en la imagen.

= Afladimos las acciones alos botones:
En el boton parar:  WebBrowserl.Stop;

(@) Cutre Crhome =N =R
w o [
Inido || Stop ehitp://wwnw.google.es @ Ir-»
\ b 7 = 3 ?'l
Align |alLeft Align | alClient AlignalRight

En el boton Inicio:  WebBrowserl.Navigate('http://www.google.es");
En el boton Ir: WebBrowserl.Navigate(Edit1l.Text);
» Puedes cambiar el objeto Edit1 por un ComboBox1, afiadienlo los eventos:

KeyPress: if key=#13 then
begin

WebBrowserl.Navigate(ComboBox1.Text); Inido || Stop

Ir -

ComboBox1.Items.Add(ComboBox1.Text); Www.oﬁmeg-a.es

end;

ComboBox1Select: WebBrowserl.Navigate(ComboBox1.Text);
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Ejercicio Navegador CutreChrome para movil Firemonkey (versiones XE para méviles)

= Crea un nuevo proyecto mobil en XE5/6: (File » New » FireMonkey
Mobile Application). En XE7: New — Multidevice application

= Escoge la plantilla Header/Footer con encabezado y pie. Mobil
Samsung Galaxy S2

» En el cuerpo, afiade un componente WebBrowser alineado al
cliente.

» En el encabezado, quita la etiqueta Label y afiade de la paleta
adicional un componente ClearingEdit llamado Direccion y en su
propiedad text pon tu web de inicio favorita y afiade un botén con
el texto: Ir ,nombre: btnIR y con el estilo lookup: donetoolbutton

» En el footer afiade dos botones para ir adelante y atras alineados
a izquierda y derecha con apariencia stilelookup:
priortoolbuttonbordered y nexttoolbuttonbordered llamados:

® @ @
http:/www.ofimega.es X o/ o
@ e
Direccion binlr
Webbrowser1
btnAtras btnAdelante
& © &
& o Cutre Chrome 8 —
[l ] [

btnAtras y btnAdelante y un label alineado al cliente y textAlign
Center con el nombre de la aplicacién: Cutre Chrome.

Botones adelante y atras:
WebBrowserl.GoBack; y WebBrowserl.GoForward;
Boton para ir:
procedure THeaderFooterForm.btnIrClick(Sender: TObject);
begin
WebBrowserl.URL := Direccion.Text;
end;
Al teclear en direccion:
procedure THeaderFooterForm.DireccionKeyDown(Sender: TObject; var Key:
var KeyChar: Char; Shift: TShiftState);
begin
if Key = vkReturn then
begin
WebBrowserl.URL := Direccion.Text;
btnIr.SetFocus; //pone el foco para quitar el teclado
end;

Mejoras:

= En el control Edit, optimizar el Virtual Keyboard seleecionando vktURL como el tipo de

teclado virtual adecuado en la propiedad KeyboardType.
= Establecer la propiedad KillFocusByReturn a True

Word;

KeyboardType vktURL
KillFocusByReturn True

= Cambiar el Edit por un EditCombobox al que podamos afiadir elementos a modo de historial al pulsar en Ir:

encontrado:=false;
for i := @ to Direccion.Items.count-1 do
begin
if Direccion.Items[i]=Direccion.Text then encontrado:=true;
end;
if encontrado=false then
begin
//limita la lista a 10
if Direccion.Items.count>10 then Direccion.Items.Delete(9);
Direccion.Items.Add(Direccion.Text); //afiadir a la lista...
end;

Compilar:

= Compilar por emulardor: Para probar la emulacién de Android se debe
instalar las android SDK manager y escoger en el Target el emulador:
rxe5_android (muy lento)

= Compilar en el mévil: El teléfono o dispositivo android debemos
conectarlo al PC y activar las opciones del desarrollador (pulsando
varias veces en el numero de compilacion) y activar en el modo
desarrollador: Depuracion USB M. Entonces, al instalar el driver ABD
en Windows, nos buscara y mostrara nuestro dispositivo en la lista.
Luego activar el target para compilar en el mévil Android.

Guardar proyecto: CutreChrome.dproj

= CutreChrome
£ 4,1 Build Configurations {Debua)

Target Platforms (Andraoid)

= Android - Android SDK 22.6.2
=77 Target

*wd
+-[77 Configuration

[ i0s Device
[ ios simulator

O

r

r



Ejercicio Firemonkey 1. Calcular el area de un triangulo con estilo

Versidn para Firemonkey: Form Elﬁ

= Crea un nuevo proyecto. (File » New » Multidevice o Firemonkey - . " 7 oo ool
desktop application). HD Application. En XE7: New — Multidevice - - - " 5 25 D mii e

applicaton oo o o pE——

® En la etiquetas Labels, poner el rétulo en la propiedad Text. ;oo Base =— Editl .

= Poner los componentes de la imagen: © Altura: = Edit2 -

* En el evento: OnClick del bot6n Buttonl poner: L

Ciiocooon Caledar e

Edit3.Text:=FormatFloat ('###.##',StrtoFloat(Editl.Text) * oo oo oo LI
StrtoFloat(Edit2.Text) / 2 ); Dl Areas - = Edit3

FormatFloat: Convierte un valor decimal de coma flotante en un texto con
el formato de nimero indicado.

= Afadir al Form1 un componente: StyleBook1

= Pulsar doble clic sobre el componente StyleBook1 y cargar
(Load...) de la carpeta:

Users\Public\Documents\RAD Studio\12.0\Styles el estilo:
AquaGraphite.style — Apply and close

Calcular

= Cambia la propiedad del formulario Form1. Stylebook: por StyleBook1

#

Probar la aplicacion:
Formd TForml

Pulsa el botdn Run > o eligelo del ment Ejecutar / Run para comprobar

su funcionamiento. Properties | Events
Guardar el proyecto: Crea una carpeta que se llame: Contador. Quility cclystemDefault A
= Escoge: File » Save as... Para guardar el archivo de cédigo en la carpeta ShowFullScreentcon|_|Félse

| bre: A 1 #|StyleBook hd
cone n.om re: Areas :pas StyleLookup
= Escoge: File » Save project as... Para guarda el proyecto en la carpeta StyleName
con el nombre Areas.dpr Tag o
ToD 0

Ejercicio FireMonkey2. Uso de los componentes de FireMonkey
Variacion al ejercicio anterior de areas del triangulo:

Properties | SpinBox1 TopinBox

Los componentes con valor
numérico como SpinBox y

" . Max 100
NulmberBo_x, utilizan su proplec_iad | Célculo de triangulos Min ]
Value y evitan tener que cambiar e Name SpirBox1
formato de nimero. styleBook1
Calcular - Value i
Label1 =14 ; ValueType vitFloat
¢ Crea un nuevo proyecto. @ Are @ 8 W
(F|Ie » New » Multidevice o o Lahel2 = o )
Firemonkey desktop [_) Hipotenusa
application). HD Application
. Poner los componentes de la Calcula Label3 2
imagen: Button1 | |
1 GropupBox, 2 RadioButtons, 2 Properties | NumberBox1
SpinBox, 1 NumberBox, 1 Mame MumberBox1
Button, 4 Labels y un StyteBook Properties | RadioButtonl value o
- IsChecked True ValueType vitFloat
Name RadioButton 1 TextAlign taCenter

El tipo de Valor ValueType de los
cuadros numéricos sera Float para permitir decimales (decimal de coma flotante).

e Cambia la propiedad del formulario Form1. Stylebook: por StyleBookl. Resource: Transparent
e Pulsa doble clic sobre el boton Buttonl y en el evento: OnClick del boton Buttonl afiadir el cédigo en negrita:

procedure TForml.ButtonlClick(Sender: TObject);
begin
if RadioButtonl.IsChecked =true then //si esta activado Area..
NumberBox1.Value:=SpinBox1.Value*SpinBox2.Value/2
else NumberBox1.Value:=Sqrt(Sqr(SpinBox1.Value)+Sqr(SpinBox2.Value));
end;
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¢ Llamaremos al mismo evento: OnChange en los dos RadioButton y al evento OnCreate del formulario Form1
para que se cambie el texto de las etiquetas al empezar el programa o al cambiar de selector:

procedure TForm4.RadioButtonlChange(Sender: TObject);

begin

if RadioButtonl.IsChecked then

begin Célculo de triangulos
Labell.Text:="Base:"';
Label2.Text:="Altura:"'; —Calcular
Label3.Text:="Area:';

end @ Area

elsv:e O Hipotenusa

begin

Labell.Text:="Cateto a:"; :
Label2.Text:='Cateto b:"; Area:
Label3.Text:="Hipotenusa:';

end;
end;

Probar la aplicacién:
Pulsa Run * para comprobar su funcionamiento =
Guardar el proyecto: Crea una carpeta que se llame: Contador.
= Escoge: File » Save as... Para guardar el archivo de cddigo en la carpeta con el nombre: triangulos1.pas
= Escoge: File » Save project as... Para guarda el proyecto en la carpeta con el nombre triangulos.dpr

..{F;a Build Configurations (Debug)
=} ) Target Platforms (Win32)
£7 32-bit Windows

Activar la version para Windows 64-bit:

1. En el panel Project Manager, pulsa con el boton Derecho del mouse sobre

£4-hit Windows
Target Platforms. Assign Remnote Profile..
Add Platform... Edit Profile...
Escoge 64 bits Windows. :
Remaove Profile
2. Pulsa con el botdn derecho del mouse sobre la plataforma 64 bits y escoge: -Iw -
. Remove Platform...
Activate. H{ Tool Pa
3. Compila de nuevo la aplicacion y comprueba que se muestra en la carpeta B v | lﬁ

Win64\Debug la aplicacién exe.

Nota: Si tu FM RAD Studio corre bajo x86 (Win32) podras compilar en 64 bits pero no podras ejecutarlo.

..{F;. Build Configurations (Debug)
=% # ] Target Platforraaoyom
08X Add Elatform...

£7 32-bit Windows

Activar la plataforma Mac OsX y ejecutar en un Mac:

1. Escoge del menu: Tools > Options > Environment Options > Connection
Profile Manager page. Click en Add

2. Escribe el nombre del profile: “ConexionMac”. Plataforma OsX

3. Pon el nombre de tu equipo Mac en lared o su IP

4. En el panel Project Manager, pulsa con el botdn Derecho del mouse sobre
Target Platforms. Add Platform...Escoge: OSX. [] Make the selected platform active

5. Pulsa con el botdn derecho del mouse sobre la plataforma OSX y escoge:
Assign Remote Profile. Ok

6. Selecciona Add... para abrir la ventana de conexidn con
un equipo mac por red.

7. Escribe el nombre de la conexién: ConexionMac

Select a platform:

05X

Profile information

This wizard will assist you in creating a remote profile, Remote profiles are required in order to

deploy and run a project on a remote machine. A remote profile may also be required in order to

build a cross-platform C++ application [P
o

L2

Please spedify ¢

Host machine information

Entonces, el IDE estara conectado con tu Mac.
Si pulsas F9 se ejecutard la aplicacidn en tu Mac

password to be used when connecting to the host.
ConexidnMac

Platform: Host name:

=

05X

Profile name: Please spedfy the host machine name for this profile, You canalso s

Port number:
64211

»
‘ » Password:

Enter password

| Set as defal

-

<< Back MNext >3 Finis|



Ejercicio Else If — variables y crear objetos. Adivina un namero.

Creamos un nuevo proyecto VCL aplicacién en Delphi y afiadimos al formulario los siguientes...
Ingredientes:

» 2 TLabels A
1 TEdit bbI Adivina un humero en 60 segundos..
» ITButtonfoes ] Escribe un nurmero del 1.al 100y pulsa el botan vale o Intro

Preparacion:
Creamos 2 variables en la seccién de variables
publicas(al principio): Bueno e Intentos:
var
Forml: TForml1;
- Bueno: integer; Vale |
- Intentos: integer;
Coccion:
Al crearse el formulario se genera un nimero aleatorio del 1 al 100 y se guarda en la variable buena:
procedure TForml.FormCreate(Sender: TObject);

begin
Randomize; // activa el generador aleatorio (baraja)
bueno:=random(100); //crea un num aleatorio entre 0 y 100 y lo guarda en la variable bueno
intentos:=0; //pone la variable intentos a cero

end;

Acciones: Al pulsar el boton Vale, se crea una variable num y se evalla si la variable num es igual o0 mayor a
la variable bueno:
procedure TForm1.Buttonl1Click(Sender: TObject);

var
num:integer;
begin
intentos: =intentos+1;
If Editl.text='"' then showmessage('Escribe un nimero') // -> si no escriben nada =" '
else
begin
num:=strtoint(Editl.text); //-> Variable num guarda el dato del Edit1

if num>bueno then showmessage('Es mas bajo')

else if num<bueno then showmessage('Es mas alto')

else if num=bueno then acierto;

Editl.text:=""; //-> borra el nim del Editl

end;
end;
Se crea un procedimiento manual llamado acierto sin parametros:
procedure Tforml.acierto;
var
izinteger;
begin
Editl.visible:=false;
Label2.Caption:='Acertaste, es el '+inttostr(bueno);
Labell.Caption:='Te ha costado '+ inttostr(intentos)+' intentos y has tardado '+ inttostr(60-
ProgressBarl.position)+' segundos';

for i:=1to 100 do /I Bucle finito: repite el bucle 100 veces

begin
with TButton.Create(self) do  //se autocrea un boton que aparecera aleatoriamente en el form
begin

SetBounds (Random (panell.Width-100), Random (Panell.Height-50), 100, 50);
Parent := Panell;
Caption := Label2.Caption;
end;
end;

Mejoras:
» Afiadir una barra de progreso: progressbarl ] (Paleta win32) Progressbar: Max: 60 Position: 60

» Afadir un Temporizador: Timer (Paleta System)

» Interval: 1000 (Repetira el evento cada 1 segundo) E;‘g‘;ﬁd“re TForm1.TimeriTimer
. . - L, . ProgressBarl.Position:=ProgressBar1l.Position-1;
En el evento del timer OnTimer afiadir el codigo de la if pﬁ’ogressBarl_Position=0 tghen
derecha para evaluar el tiempo tardado en acertar y begin
decrementar la barra de progreso. Showmessage('Se acabd el tiempo');
Timerl.enabled:=false;
»  Guarda la unidad (Adivinal.pas) y el proyecto end‘_:lose;

(Adivina.DPR) end:
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Ejercicio calculadora. Uso del parametro sender y de las variables

Creamos un nuevo formulario. File — New - Application

& Calculadora =101 x| |ngredientes: (Componentes)

.................................... 3 LabelS. ValOI’ 1 _ Va|0r 2 _ RESU|tadO

Lo Vel o ol 2 Edits BRI Editl — Edit2

.................... 4 potones:

Ciwaerz 08 i Button1: Sumar

......... Button2: Restar

----------- Sumar | Flestar | 2oooooanc Button3: Multiplicar

___________ , D B Button4: Dividir
........... Multlpllcarl Driveidir | R 1 Panel: Caption: 0

. Resultado - 0 | """"" Acciones:

s ————————————— - -+ - -+ -| Pylsar doble clic en el botén 1 para escribir la accién dentro

.................................... del procedure.
panell.caption:=editl.text + edit2.text; - da error

Primer programa:

- Escribe el cddigo correcto en negrita: procedure TForm1.Button1Click(Sender: TObject);

Comprueba que funciona el botén, begin " . inttostr(strtoint(editl.text) +

, panell.caption:=Inttostr(strroint(editl.tex
(Pulsar Run > 6 F9) strtoint(edit2.text));
p end;

- ldem deberiamos escribir los otros tres

botones, pero en lugar de ello vamos a crear dos variables plblicas para var

cada nimero. Busca la seccion Var al inicio de la unitl.pas y escribe el Form1: TForm1:

codigo en negrita: numerol:double:

. . . numero2:double;
- Ahora cambia el cédigo del boton 1 por este otro:

Comprueba que funciona el botén, (pulsar Run I 6 F9)

Segundo programa: procedure TForm1.Button1Click(Sender: TObject);
begin

numerol:=strtofloat(editl.text); // convierte a decimal flotante el editl
d - numero2:=strtofloat(edit2.text); // convierte a decamal flotante el edit2
= rocedure. . L panell.caption:=floattostr(numerol+numero2);
Idem deberiamos escribir los end:

otros tres botones, pero en
lugar de ello vamos a utilizar el mismo procedure para todos los botones, utilizando el parametro sender y
evaluando cudl es el botdn pulsado con la funcién IF ... ELSE IF...

Cambia el codigo por el que

Llamada al mismo

procedure TForm1.Button1Click(Sender: TObject);

se muestra. begin
Luego escogemos para los numerol:=strtofloat(editl.text); // convierte a decimal flotante el editl
otros tres botones el evento numero2:=strtofloat(edit2.text); // convierte a decimal flotante el edit1
“On clic” y le asignamos el if sender=buttonl then
mismo procedure que para el panell.caption:=floattostr(numerol+numero2)
botén 1: else if sender=button2 then
Object Inspector | Panell.captlon:=floattostr‘(numer‘ol—numer‘oz)
else if sender=button3 then
Buttonz: TButton LI panell.caption:=floattostr(numerol*numero2)

else if sender=button4 then

i Ewventz
Properties | panell.caption:=floattostr(numerol/numero2)

OnClick, - end;
OnDraghirop  EBGttond Click L

OnDrags e . . -
------- De este modo, los tres botones realizan el mismo procedure pero utilizamos
el parametro Sender con IF ... else if para evaluar qué botén se ha pulsado en cada caso.

Mejoras: ¢ Qué pasa si dividimos un niumero por cero? > Devuelve un error el programa.

Escoge del menu: Program - Reset para desbloquear el programa.

En el caso de dividir deberiamos evaluar que si numero2=0 entonces muestre un mensaje de que no se
puede realizar la operacion. Para ello, afiadir la siguiente linea:

If nUmero2=0 then showmessage(*No se puede dividir por cero);
(Sin olvidar poner un begin — end cuando escribimos varias lineas de cédigo dentro de un IF)

Guarda este proyecto en tu carpeta con el nombre: Calculadora.DPR y su unidad pas: Calculadoral.PAS



Ejercicio While. Factorial en la calculadora.

While: Repite la ejecucion infinitas veces hasta que se cumpla la condicion.
En matematicas, factorial o permutacion multiplica un nimero por el siguiente inferior hasta 1.

Ejemplo:5!=5*4*3*2* 1= 120

Abre el proyecto anterior: CALCUALDORA y afiade el siguiente botdn: Button5. Aflade el codigo que se muestra y

comprueba su funcionamiento P

@ Calculadora

| Factorial

procedure TForml.Button5Click(Sender: TObject);
var
resultado:double;
begin
resultado:=strtofloat(editl.text);
numerol:=resultado-1;
while numerol>@ do

begin

resultado:= resultado*numerol;

numerol:=numerol-1;

end;
panell.caption:=floattostr(resultado);
end;

Al finalizar, guarda este proyecto en tu carpeta con el nombre: CALCULADORA?2

Ejercicio FOR. Exponencial en la calculadora.

For ... To: Ejecuta una accién un nimero determinado de veces.

En matematicas, exponencial multiplica un nimero por si mismo tantas veces como diga el exponente.

Ejemplo: 543 =5 * 5 * 5= 625

Abre el proyecto: CALCUALDORA? y aiade el siguiente botdn: Button6. Afiade el codigo que se muestra y comprueba su

funcionamiento P:

ﬁ Calculadora

-0l

Guarda este proyecto en tu carpeta con el nombre: CALCULADORA3

Mejora en el aspecto de los componentes:

Botones planos con imdgenes:

Sustituye los botones del tipo button por los del tipo

SpeedButton de la paleta adicional.
Pon su propiedad Flat: True.

Cambia el texto del botdn por una imagen
(propiedad Gliph) disefiada por ti en Paint.

Afadir incrementadores de valor:

Anade dos componentes UpDown de la
paleta Win32 y cambia las propiedades que
se indican en la figura para incrementar los
valores del edit con flechas.

procedure TForml.Button6Click(Sender: TObject);
var
resultado:double;
X,veces:integer;
begin
resultado:=strtofloat(editl.text);
numerol:=resultado;
veces:=strtoint(edit2.text);
for x:=1 to veces do

begin

resultado:= resultado*numerol;

end;
panell.caption:=floattostr(resultado);
end;

Object Inspector A
Additional | wfint pDowvan: TUpD own _:J
2 eyl FE Properties | Eventsl
' ! fssoviate  [Edtl ) 4]
; Tz0Ciate i -
[SpeedButtan +Congtraints [TSizeConztrain
Curzor crDefault
e Enabled True
5 Height 21
HelpContest 0
........ Wﬁm
InCrement 1)
Left 209
= Max ™, |100
Ej kin 0
UpDown Ngme . ﬂJpDDwn1]
Orientation udhertical
ParentShowHing True —
Fopuphdenu
Pogition I
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Ejercicio 2. Lanzar un dado en un juego:

En este ejercicio al pulsar el boton Lanzar se activa
el timer y al pulsar el botén Parar desactiva el
timer y muestra el dato del timer. Por lo tanto, el programa
dispondra de tres eventos o acciones:
1. procedure botonLanzarClick(Sender: TObject);
2. procedure botonpararClick(Sender: TObject);
3. procedure TimerlTimer(Sender: TObject);

Necesitamos crear antes de los procedures una
variable X que es la que contendra el valor del dado. Sera del

Lanzar el dado

L

tipo numérica entera (Integer) y la declararemos en el apartado VAR al principio del programa.

En los tres procedimientos siguientes, so6lo tendremos que escribir el texto en negrita El resto se escribe

var ] Los comentarios:
MainForm: THainForm; Puedes apuntar comentarios en tus programas utilizando:
x:integer; //-> variable para contador . .
implementation I -» La doble barra: Para una linea
{} -» Las llaves para varias lineas

automaticamente al pulsar doble clic en el componente o sobre el evento adecuado del componente (F11)

begin
timerl.enabled:=true;
end;

procedure TMainForm.botonLanzarClick

procedure TMainForm.botonpararClick

begin

timerl.enabled:=false;

labell.caption:="has sacado un '+ inttostr(x);
end;

{poner interval del timerl a 50
poner en el var general x: integer}
begin

if x<6 then x:=x+1 else x:=1;
labell.caption:=inttostr(x);
end;

procedure TMainForm.TimerlTimer(Sender: TObject);

{Si X es menos que 6 suma 1 y si pasa de 6 valdra 1 }
{Ponemos al texto de la etiqueta el valor de x }

Uso de una variable como “Flag” (bandera de permiso)

Utilizar el mismo botdn paralanzar y parar:

Borra el botén 2, haciendo clic en él y pulsando Suprimir

Crea otra variable llamada lanzar del tipo integer, por defecto, esta variable valdra 0: Lanzar:integer;

La variable lanzar es un “flag” o
bandera que al comparar con ella,
el mismo botdn realizard una
accion u otra. Cambia el cédigo
del botén lanzar por este otro:

(se aconseja escribir también los
comentarios)

Variantes y mejoras:

1.- Aflade el componente
Imagelist (W32) al que se le
afiaden (add) las imagenes bmp
de las 6 caras de un dado.(que
previamente has dibujado con la
aplicacion: Tools - Image Editor —
File - New - Bitmap)

2.- Afilade un componente Imagel (additional) y afiade al timer:

Extension: Librerias Jedi:

Si tienes instaladas las librerias JVCL — JEDI, utiliza el componente en la paleta: JVVisual: JVDice @

procedure TForml. TMainForm.botonLanzarClick (Sender: TObject);
begin

if lanzar=@ then// Si lanzar vale cero ...

begin
timerl.enabled:=true;
buttonl.caption:="Parar’;

// Activa el timer
// En el botén 1 pondra Parar

lanzar:=1; // y sube la bandera
end

else // Y sino...

begin

timerl.enabled:=false; // Desactiva el timer
buttonl.caption:="Lanzar'; // En el botdén 1 pondra Lanzar
lanzar:=0; // y baja la bandera

end

end;

con sus propiedades: Autostop Interval: 800 y Rotate true.

imagelistl.GetBitmap(x, imagel.picture);



Ejercicio de Captura y pulsacion de botén de ratdon:

En los eventos del raton (mouse):

On mouse down, On mouse up y On mouse Move,

los parametros X y Y son automaticos y nos devuelven la
informacion de la posicion del mouse.

En los eventos del ratdn (mouse) On mouse down y On mouse up,
también existe el pardmetro Button que nos informa si el botén
pulsado o liberado es el izquierdom (mbleft) o el derecho
(mbright).

EﬁfFurnﬂl

=101 x|

Pulza una tecla el mousze sobre el formulano: Label3

|zquierdo: 130
Labell

|zquierdo: 50
Label2

» Crear un proyecto nuevo llamado: Mouse.dpr y afiade al formulario, los componentes que se muestran en la figura.
» Con el formulario seleccionado, busca en petafia Events, el evento onMouseDowny pulsa doble clic para crear el

procedure.
» Agrega el cddigo siguiente:

procedure TForm1.FormMouseDown(Sender: TObject; Button: TMouseButton;

Shift: TShiftState; X, Y: Integer);

begin
if Button = mbLeft then
begin
labell.Caption:="'Izquierdo:' +inttostr(X); //guarda posicién X del ratén
label2.Caption:="'Izquierdo:' +inttostr(Y); //guarda posicién Y del ratén
end
else if Button = mbRight then
begin
labell.Caption:="derecho:"' + inttostr(X);
label2.Caption:="derecho:"' + inttostr(Y);
end;
end;

» Comprueba (Run P> 6 F9) y guarda el proyecto y la unidad en tu carpeta al finalizar.

Ejercicio de Captura y pulsacion de Teclado. Tecla

Para detectar cuando el usuario pulsa una tecla, se emplea los eventos: on key press y on key down (en la pestaia Events

del Object Inspector)

En los eventos on key press y on key down. Los procedures nos
informan, con la variable key, del codigo de la tecla pulsada.

Ord (Char) — devuelve el valor numérico ASCII que le corresponde
un caracter

Crear un proyecto nuevo llamado: Tecla.dpr y afiade al
formulario, tres labels con los captions (rétulos) que se muestran
en la figura:=>

Con el formulario seleccionado, busca en petafia Events, el
evento onkeypress y pulsa doble clic para afiadir el procedure.
Agrega el codigo siguiente:

v

v

v

procedure TForml.FormKeyPress(Sender: TObject; var Key: Char);
begin
labell.caption:=key;

label2.caption:=IntToStr(Ord(key)); //Ord(key) devuelve el numero ordinal de la tecla pulsada (1 a 256)
if key = #27 then close;//Si pulsan la tecka escape se termina el programa

end;

» Comprueba (Run P> 6 F9) y guarda el proyecto y la unidad en tu carpeta al finalizar.

Variante al ejercicio de la

calculadora: procedure TForml.FormKeyPress(Sender: TObject; var Key: Char);
i var
» Capturar la tecla de la operacidn con el num: integer;
teclado: begin

case key of

v

Recupera el proyecto de la calculadora

#13, #61:0perarClick(opeigual);{teclas intro}

» Asigna al formulario la propiedad #43 : ButtoniClick(mas);
. B
KeyPreview = True #45 : ButtonlClick (menos);
» Afiade el siguiente procedure al #42 : ButtonlClick (por);

elevento OnKeyPress del formulario — end:
)

#47 : ButtonlClick (div);
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Ejercicio 3. Crear un contador de tiempo. Practicar con tipos de variables.

Variables publicas y privadas: Crearemos dos variables para almacenar dos datos: la hora de inicio y la
hora final. Si estas variables van a ser utilizadas en todo el programa, se crea al principio, en el apartado var
(publicas), si no se crea el apartado var dentro del procedure (privadas).
ejemplo:
var
Forml: TForml;
horainicio: double; //no existe el tipo time, se elige el tipo numérico doble. Permite decimales doble

precisién
horafin: double;
I: Integer; // numérico entero)
S: string; // del tipo cadena de texto
otros tipos de variables:
Integer Shortint SmallInt Longint Byte Word
Cardinal Boolean ByteBool WordBool LongBool Char
Practica:
e Crear una nueva aplicacién VCL llamada CRONO. Afade al formulario (ventana) los siguientes
componentes:

» 3 botones [tt]
» 3 paneles [[]de color blanco como se muestra en la figura:

» |Tipo de componente: TButton
Name: button1
J=. D ) Caption: Empezar

... |Tipo de componente: TButton
Empezar Parsr : Name: button2
Caption: Parar

Hora de |n||:|n\J Hara firet — » |Tipo de componente: TPanel
i Name: Panel2

Caption: Hora fin

D’r\ ———» |Tipo de componente: TPanel

Name:Panell
Caption: Hora inicio

Tipo de componente: TPanel
Name: Panel3
Caption: Crono

L, |[Tipo de componente: Tbutton
Name: button3
Caption: Salir

var

e Anfadir las siguientes variables al inicio de la unidad: Forml: TForml;
horainicio: double;
horafin: double;

¢ Afadir las lineas de cddigo a los procedures:

Nivel avanzado

procedure TForml.ButtonlClick(Sender: TObject); Coémo crear un archivo INI que guarde la hora de

begin
horainicio:=time; entrada.
panell.Caption := 'Hora de inicio: ' + TimeToStr(Time);
end; - Es necesario afiadir INIFILES a la seccion USES
de la unidad.
procedure TForm1.Button1Click(Sender: TObject);
procedure TForml.Button2Click(Sender: TObject); var
begin datosini:TIniFile;
horafin:=time; R , HORAENTRADA:STRING;
panelZ.Capt}on :=‘ Hora d<'e paro: + T1meToS‘Fr‘§T}me); begin
hoﬁz;«;ii; caption:= 'Crono: ' + TimeToStr(horainicio- HORAENTRADA:=TIMETOSTR(TIME);
end; datosini:= TIniFile.Create('DATOS.INI'),
-->crea el archivo datos.ini
datosini.WriteString('Eduardo’, 'Entrada’,
procedure TForml.Button3Click (Sender: TObject); HORAENTRADA); -->afiade a la seccion
begin [Eduardo] entrada=12:15
close; DATOSINI.FREE; --> cierra el archivo datos.ini
end; end:



Encriptacion de caracteres por teclado

Crear un proyecto nuevo llamado: Tecla_encriptada.dpr, similar al

anterior pero con las variaciones de la imagen.

Anade el siguiente procedure al elevento OnKeyDown del formulario: Original -+ -+ Encriptada
Labell B LabelEnc
procedure TForm1.FormKeyDown(Sender: TObject; var Key: Word; SR
Shift: TShiftState); Label? Ll LabelF ne?

var
codigo:byte; //variable numérica de 256 valores

begin
label2.Caption:=inttostr(key);
if (Key=VK_RETURN) then Label2.caption:='Has pulsado Enter';
if (Key=VK_ESCAPE) then Label2.caption:="'Has pulsado Esc';
codigo:=key+spineditl.Value;
labelEncl.Caption:=inttostr(codigo);
labelEnc2.Caption:=chr(codigo);

end;

Encriptacion de caracteres de texto

» Crear un proyecto nuevo llamado: Texto_encriptado.dproj,

similar al anterior pero con las variaciones de la imagen —
» Afiade el siguiente procedure al pulsar el boton:

procedure TForm1.Button1Click(Sender: TObject);
var
original,encriptado:string;
i;integer;
begin
original:=edit1.Text;
encriptado:=original;
fori:=1 to Length(original) do
encriptadoli]:=chr(ord(original[i])+spinedit1.Value);
edit2.Text:=encriptado;
end;

Encriptacion de texto en un Memo o en un Richedit:

Virtual Keys Codes
VK_RETURN Enter key
VK_SHIFT Shift key
VK_CONTROL Ctrl key
VK_LBUTTON Left mouse
VK_RBUTTON Right mouse
VK_CANCEL Control+Break
VK_BACK Backspace key
VK_TAB Tab key
VK_ESCAPE Esc key
VK_UP Up Arrow key
VK_RIGHT Right Arrow key
VK_DOWN Down Arrow key
E zcoge un valor de encriptacion y» pulza una tecla:. : :
P Onginal oo r s Eneptado s

//variables para almacenar los textos
//var numerica entera para el vontador for

// almacena el valor del editl
//lo hace las veces del ancho del texto

//convierte de char a niUmero y le suma el del spin
//muestra el resultado

En este caso llamamos a la propiedad lines para para completar las lineas del memo mediante un for. Hasta finalizar todas

las lineas (linescount):
for i:=0 to memol.Lines.Count do
begin
memo2.lines.add(memol.lines[i]);
end;
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Ventanas de Mensajes y cuadros de dialogo directos.
Ventanas de mensaje:
Modo Delphi: Showmessage('Mensaje’);
MessageD1g(‘Mensaje', mtinformation, [mbOk], 0)
Modo Windows: Application.MessageBox(‘Mensaje’, 'Textoventana', MB_OK);
Ventana de pregunta:
Application.MessageBox('Pregunta’, 'Textoventana', MB_YESNO)
MessageDlg(Mensaje', mtConfirmation, [mbYes, mbNo], 0) = Devuelve: mrYes o mrNo
InputBox('Nombre_ventana', 'Texto_Dato', 'Respuesta_predeterminada'); > Devuelve Var String
InputQuery('ldentificate!', 'Pon tu nombre, por favor...", Nombre); = Devuelve Var Bolean
Otros mensajes:
ShowMessageFmt(const Msg: string; Params: array of const);
CreateMessageDialog(const Msg: string; DIgType: TMsgDIgType; Buttons: TMsgDlgButtons)

En la plataforma FMX Firemonkey multidevice & mobile:
Véase MessageDialogSync y ShowMessageSync de la libreria IFMXDialogServiceSync.MessageDialogSync

Ejercicio de mensajes:
- Enuna nueva aplicacién VCL, afiade 5 botones como en la imagen:
- Con la paleta de alineacién, puedes situarlos todos verticalmente alineados.
- Asigna a cada uno de ellos el siguiente cédigo:

procedure TForm1.Button1Click(Sender: TObject);
var
Dato: string;
begin
Dato:= InputBox('Nombre ventana', 'Nombre:', 'Antonio');
showmessage('Hola, '+ Dato);
end;

procedure TForml.Button2Click(Sender: TObject);
var
Nombre:string;
PulsoOk:boolean;
begin
PulsoOk:= InputQuery('Identificate!', 'Pon tu nombre, por favor...', Nombre);
if PulsoOk=true then ShowMessage('Envantado de conocerte, '+Nombre)
else ShowMessage('Has de pulsar Ok...');
end;

procedure TForm1.Button3Click(Sender: TObject);

begin

if (Application.MessageBox('¢Eres tonto?', 'Tonteria', MB_YESNO) = IDYES) then showmessage('Lo sabia')
else showMessage('Respuesta incorrecta')

end;

procedure TForm1.Button4Click(Sender: TObject);

begin

Application.MessageBox( 'Este es un mensaje con botdén Aceptar', 'Informacidén', MB_OK);
end;

procedure TForm1.Button5Click(Sender: TObject);
var
Nombre:string;
PulsoOk:boolean;
pregunta:pchar;
begin
PulsoOk:=false;
while PulsoOk=false do

begin

PulsoOk:= InputQuery('Identificate!', 'Pon tu nombre, por favor...', Nombre);
if PulsoOK=false then ShowMessage( 'Has de pulsar Ok...');

end;

Pregunta:=Pchar('Hoye + Nombre + ' , ¢eres tonto?');
while Application.MessageBox(Pregunta, 'Tonteria', MB_YESNO) = IDNO do
begin
MessageD1lg( 'Respuesta incorrecta', mtError, [mbOk], ©);
end;
MessageD1lg( 'Respuesta correcta', mtInformation, [mbOk], 0);
end;



Ejercicio de controles.

Resumen de controles usuales. (Valido para Visual basic & Delphi VCL)

SHEESI SESEEE SR e
Label1. |Editt S BarraCodigo En una nueva aplicacién (File — New — VCL Application — Delphi )
GroupBoxColor GroupBoxTamario | GrouppoxMAX: 255 Afiade desde la paleta los controles que se muestran en la figura
Label4 H H indi
= - . Align: alclient y cambalallas propiedades como se indica, para que quede como
Alignment: center en la 22 figura:
Labels Label 1: Nombre: Caracter
< > A Label2: Nombre: ASCII
Lshelz Layout: center Label 8: Nombre: VerAscii - Backcolor: Blanco - Center
= > Font.Size: 30 Label5: Nombre: Rojo Caption: Rojo
»\ Label6: Nombre: Verde Caption: Verde
m?rizgss Max: 80 Label7: Nombre: Azul Caption: Azul
: Min: 6 Button1 o Command1: Caption: &Salir
RSt ietot ok oyt ef e gttt ASCH 32295 e _ _ o _
VeSO [ Il 4| DE Las Barras de desplazamiento, en Visual basic tiene la propiedad
e “e Value mientras que en Delphi tienen la propiedad Position.
Dol ik El rango de caracteres ASCll y de combinacién de colores RGB
: Fioio T son de 256
| ET M
: Verda ---:EJ-- > ) ]
©oall o || o o e Chr(Valor): Convierte un numero en un caracter ASCII
i Al o e RGB(valorl, valor2, valor3) -> Convierte tres nimeros en un
T color
= Salr S =
Cddigo para Delphi (Vcl) Cédigo para Microsoft Visual Basic:
procedure TForm4.BarraCodigoChange.. Private Sub Form Load()
begin VerAscii.FontName = "Times New Roman" //tipo de letra
VerAscii.Caption :=Chr(Barracodigo.Position); End Sub
end;
Private Sub TamCaracter Change()
VerAscii.FontSize = TamCaracter.Value 'tamafo
procedure TForm4.BarraRojoChange.. Label4.Caption = "Tamafio-" + Str(TamCaracter.Value)
begin End Sub
VerAscii.Color:= RGB(BarraRojo.Position,
BarraVerde.Position, BarraAzul.Position); Private Sub (Procedure) Colorrojo Change()
Rojo.Caption = "Rojo:" + VerAscii.ForeColor = RGB(Colorrojo.Value,
inttostr(BarraRojo.Position); Colorverde.Value, ColorAzul.Value)
end; Rojo.Caption = "Rojo -" + Str(Colorrojo.Value)
End Sub
procedure TForm4.BarraTamanoChange..
begin Private Sub (Procedure)Barracodigo Change()
VerAscii.Font.Size:= BarraTamano.Position; ASCII.Text = Chr(Barracodigo.Value)
end; VerAscii.Caption = Chr(Barracodigo.Value)

Label3.Caption = "Valor Ascii-" + Str(Barracodigo.Value)
End Sub (end;)

Private Sub (Procedure) ASCII Change()
VerAscii.Caption = Chr(Barracodigo.Value)
If ASCII.Text <> "" Then Barracodigo.Value =
Asc(ASCII.Text)
End Sub
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Ejercicio 5. Practicas con controles de listay eleccion.
"m'llﬁ:'i'i'_—l—l- =N

Control: Combobox
Name: Producto

Yer calorias

Frambueza
Freza

—Estraz——————
[~ Mueces

[T Almexdras
[~ Pazasz

" Mediano

= Pequefio

0 Pts

Wer precio

1.- Crear el formulario Helados.frm con
los nombres y controles que se indican en
la figura.

Control: ListBox
Name: Sabor

2.- Crear la variable publica:
precio: integer;

3.- Crear un segundo formulario llamado
Envio:

(File — New — Form) Name: Envio

Al hacer clic en el botén enviar:
envio.showmodal;

Guarda el proyecto con el nombre:
Helados1.pas y Helados.dpr

Al hacer clic en el botén calorias:
procedure THelados.ButtonlClick
var calorias, caloriasl:integer;
begin

if sabor.itemindex=-1 then

Control: RadioGroup
Name: Tamano

Controles: Chexbox

begin

ShowMessage('elige un sabor');
calorias:=0;

end

Textbox
Name: Nombre

else
begin
Button2Click(Sender);

BitBtnl

=9 Enviar Pedido

Al enviar el pedido:
procedure Tenvio.BitBtn1Click(Sender: TObject);
begin
if nombre.text = '' then
ShowMessage('Haga el favor de rellenar sus datos,

gracias"')

else

begin

ShowMessage('Sefior ' + nombre.text + ', su pedido ha
sido enviado a ' + poblacion.text + ', en breves

minutos recibira el producto. Gracias');

end
end;
Al cancelar el pedido:
procedure Tenvio.BitBtn2Click(Sender: TObject);
begin

ShowMessage('Su pedido ha sido cancelado');

close;
end;

Llamada extena al enviar el pedido: ShellExecute

(afadir libreria shellapi)

ShellExecute(GetDesktopWindow(), nil, pChar('mailto:'+
direc), nil, nil, SW_SHOWNORMAL);

//'mailto:' + direc + '?Subject="+asunto+ '&Body="+ cuerpo

calorias:=precio*10;

case sabor.itemindex of

:caloriasl:=10;

:caloriasl:=50;

:caloriasl:=100;

:caloriasl:=150;

:caloriasl:=200;
5:caloriasl:=250;

end;
calorias:=calorias+caloriasi;
panell.caption:=inttostr(calorias)+'
Calorias’;

end;

end;

PWNRFRO

Al hacer clic en el boton Ver Precio:

procedure THelados.Button2Click(Sender: TObject);
begin
precio:=0;
if producto.text="'Helado' then precio:=200;
if producto.text='Batido' then precio:=150;
if producto.text="'Refresco' then precio:=100;
if nueces.State=cbChecked then precio:=precio+50;
if almendras.State=cbChecked then
precio:=precio+50;
if pasas.State=cbChecked then precio:=precio+590;
case tamano.itemindex of
0:precio:=precio+100;
1l:precio:=precio+59;
2:precio:=precio;
end;
panell.caption:=inttostr(precio)+"' Pts';
end;




Ejercicio 4. Visor de imagenes.
Valido sdlo para el tipo de aplicacion formulario VCL Form para Windows.
Vamos a crear una aplicacion visor de imagenes del tipo *.pcx;*.cur;*.gif;*.ani;*.jpg; *.jpeg; * .bmp;*.ico;*.emf;*.wmf.

Pasol. Poner los componentes y establecer las propiedades.
Crear Nuevo proyecto/aplicacion del tipo formulario VCL Delphi. Afiade 2 paneles y un split para distribucion vertical.
Busca en la tool palette Win31 los componentes de la figura y modifica las siguientes propiedades:

Componente: TDirectoryListBox Componente: TFileListBox
(en la paleta System) (en la paleta System)

Componente: TDrivecombobox / Name: lista_carpetas Name: lista_archivos

B 3 ok oK * 7
Name:lista archivos Filelist: lista_archivos Mask: *.bmp;*.ico;*.wmf.*.jpg

Dirlist: lista_carpetas A
pd

Vi
e b bAct-A S 2 e
;|IEI/|::: [eduardo] ;"5::

HE e :
| & deton

demos

\

Compo: TPanel
Name: Panell

Compo: TLabel
Name: Labell

Compo: TImagel
Name: Imagel

Compo: TBevel
Name: Bevell
Style: bsLowered

Componente: TCheckBox

Name: ImageForm Componente: TButton Name: ajustar
Caption: Visor Name: Salir Checked: False
Caption: Salir Caption: Ajustar

Paso 2. Escribir los codigos de los eventos

Al hacer clic en una unidad de disco (Drive combobox) se cambiaran la lista DirectoryListbox (lista_carpetas) porque le
hemos dicho que Dirlist: lista_carpetas, lo mismo ocurre al cambiar de directorio, se cambia la lista de archivos
(Componente: FileListBox) y en la lista de archivos sélo aparecerdn los archivos del tipo que se pongan en la mascara
(Mask: *.bmp;*.ico;*.wmf.*.jpg). Para ver el tipo de imagen jpg es necesario ainadir la liebreria jpeg a la lista se USES.
La parte mas dificil de cddigo esta al hacer clic en un archivo de la lista lista_archivos:

procedure TForm1. lista_archivosClick(Sender: TObject);
var
Extension: string[4]; {creamos la variable Extensidn que sera de tres 4 caracteres: letras mas el punto}
begin
Extension := UpperCase(ExtractFileExt(lista_archivos.Filename)); {detecta la extensidn del archivo en mayusc}
if (Extension = '.BMP') or (Extension = ".JPG') or (Extension = '.GIF) or (Extension = ""WMF) then
begin {empezar}
Imagel.Picture.LoadFromFile(lista_archivos.Filename); {Carga el archivo en la imagen}
Labell.Caption := ExtractFilename(lista_archivos.Filename); {Cambia el texto de la etiqueta}
end; {terminar}
end;
Cddigo al pulsar el botdn de Salir: (SalirClick): close;

Cddigo al pulsar en ajustar imagen (StretchCheck):  Imagel.Stretch := Ajustar.Checked;

Paso 3. Ejecutar y comprobar.
® Pulsa en el botén Run P o en el menu Run (Ejecutar). Comprueba y ya esta.
= Guarda el proyecto en tu carpeta con el nombre Visor.dproj

Mejoras al visor de imagenes - Uso de las librerias Jedi - JVCL

Si tienes instaladas las librerias gratuitas JEDI-VCL (http://jvcl.sourceforge.net), sustituye los componentes
anteriores por los de la ficha: JVList, combos, trees: TjvFileListBox, TjvDriveList, TjvDirectoryListBox, mas
potentes.

En JVFilelistbox: Activa Filetype: ftHidden (para ver imagenes ocultas) y Showgliphs a true (Ver iconos).
Imagen mejorada:

Sustituye Imagel por JvSpeciallmagel (Paleta: JVimages, animators) y afiade junto a la casilla de ajustar la
de Reflejo (Flip) y un deslizador para el brillo (Brightess) y otros controles de la imagen como en la figura
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Ejercicio 6 . Reproductor multimedia

= Componente: TOpendialog
I,,“; Reproductor multimedia - il:li Xi Paleta: Dialogs
Archivo Name: Abrirdialogo
Filter:AVI | *.avi| WAV | *.wav|MIDI | *.mid
= {00 |
LN :

: Componente: Mainmenu
Componente: TMediaplayer Paleta: Standard

Name: Player ~ Carpeta: System Name: MainMenul
Display: VideoPanel
AuotoOpen: False

<—__|Componente: Panel
Name: Videopanel Formulario

Name: Form1

Caption: Reproductor multimedia

rr—rrwitimediaDemo.MainMenul  _ O] X/

__:::::!Evento: Abrirlclick Archivo

Procedure Form1.AbrirlClick(Sender: T(fbject);
begin
with Abrirdialogo do
if Execute and (FileName <> ") then

begin
PIayer.C.Iose; . Libreria afiadida en la main: Mplayer
Player.Filename := FileName; USEs
Player.Open; SysUtils, WinTypes, WinProcs, Messages, Classes, Graphics,
end, Controls, Forms, Dialogs, ExtCtrls, Menus, Mplayer;
end,;

Ejercicio propuesto 1: Afiade al proyecto Visor de imdgenes, del ejercicio anterior, la posibilidad de ver archivos de
video y musica ademas de imagenes; afadiendo el componente mediaplayer. ﬂﬁ

Ejercicio propuesto 2: Si tienes instaladas las librerias gratuitas JVCL. Puedes crear un capturador de video facilmente
con el componente: JvAVICapturel (Paleta: JVimages, animators).

Ejercicico 7 Dibujar: Controles de los botones del mouse. Uso de una variable “flag”
L Dibuia i A ES

En un Nuevo proyecto/aplicacion VCL Delphi Creamos
una variable tipo légica (booleana) y publica llamada:
Pinta

(para uso como flag o permiso)
ColorDialogl public

var
Forml: TForml;
Pinta: Boolean;

Buttonl | Button2 | procedure TForm1.FormMouseDown
e : begin
Pinta := True; //Permiso para pintar al pulsar

= = Canvas.MoveTo(X, Y); //Fijael origen
Color | Arrastra el Mouse para dibujar Salir l ‘ end;

procedure TForm1.FormMouseUp

begin
Pinta := False; //Quita permiso para pintar al liberar el botdn del mouse
end;
procedure TForm1.FormMouseMove(Sender: TObject; Shift: TShiftState; X, Y: Integer);
begin

If Pinta=True then Canvas.LineTo(X, Y); //Silavariable Pinta es True entonces traza linea desde el CP al puntoXY
end;

procedure TForm1.Button1Click
begin

If Colordialogl.execute then Forml.Canvas.Pen.Color := colordialogl.color; //Abre ventana color y asigna
End

e Comprueba P y guarda el Proyecto con el nombre Pintar.dproj




Ejercicio Arrastrar y soltar. Propiedades de los formularios y del mouse.
12. En un Nuevo proyecto/aplicacion VCL Delphi: CARAS. Afadir al formulario los ingredientes que se muestran:

4@Form1 _=lgﬂjﬂ_

F' ! magel
I Picture: caral.bmp

| image2
| Picture: Bocal.bmp

:|Image3
:|Picture: Ojos1.bmpj:

Image4d
Picture: Nariz1l.bmp

Calor | M clOlive

TranzparentColor True

TransparentColoralue |l cl0live
BorderStyle bsHone 4
FarmStyle kSlayDnTnp':

Poner el formulario transparente:

1. En las propiedades del formulario, poner un color que no vayas a usar, como por ejemplo, el oliva.

2. Cambiar las propiedades del formulario: TransparenteColor=True y TransparentColorValue=el oliva.
Ademas, quitar el borde de la ventana (BorderStyle=bsNone) y poner siempre encima: (StayOnTop).

3. Afadir otra imagen o botdn para salir cuyo cddigo sea: Close;

4. Compilay corre el programa (F9) observards que sélo se muestras las imagenes sobre el escritorio.

Para arrastrar las imagenes sobre la cara:

= En los eventos del mouse al apretar y soltar, los pardmetros X'y Y nos informan de la posicién del cursor.

= Al mover el mouse, deberemos detectar si el botdn izquierdo el mouse esta apretado o no. Para ello crearemos
una variable de permiso (flag) del tipo booleriana, llamada: Apretado
1. Creamos las variables publicas:

var
Forml: TForml;
Xini,Yini :integer; // Guardara la posicion inicial del ratdn al apretar
Apretado: boolean; // Variable de permiso (flag) para arrastrar o mover la imagen

2. Seleccionamos la imagen 2 y en sus eventos, escribiremos el codigo al apretar, al soltar y al mover el mouse:

Procedure TForml.Image2MouseDown(Sender: TObject; Button: TMouseButton; Shift: TShiftState; X, Y:
begin
if Button = mbLeft then

begin
Xini := X; //guarda posicién X del raton
Yini :=Y; //guarda posicién Y del raton
Apretado:= true; //da permiso para arrastrar
end
end;

procedure TForml.Image2MouseUp(Sender: TObject; Button: TMouseButton; Shift: TShiftState; X, Y:
begin
Apretado:= false; //quita el permiso para arrastrar
Screen.Cursor := crdefault;
end;
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procedure TForml.Image2MouseMove(Sender: TObject; Shift: TShiftState; X, Y: Integer);
begin
Screen.Cursor := CrHandPoint;
if Apretado = true then
begin
if sender=imagel then
begin
imagel.Top := imagel.Top + Y - Yini; //mueve pos esquina imagen menos pos del ratdn
imagel.Left := imagel.Left + X - Xini
end
else if sender=image2 then
begin
image2.Top := image2.Top + Y - Yini; //mueve pos esquina imagen menos pos del ratén
image2.Left := image2.Left + X - Xini
end

end;
end;
Asigna a cada imagen los mismos 3 eventos o podemos aprovechar los mismos procedures, para las otras
imagenes, aprovechando el parametro: Sender

Delphi 7: Juego Antiestress: Cargar archivo de recursos (res). Formulario semi-transparente

Busca en la carpeta delphi7\Demos\Swat de el archivo de recursos: extrares.res. Abrelo con el editor de imagenes de
delphi: Tools ™ Image Editor. Observa los iconos e imagenes cargadas. (puedes cambiar la imagen Live por una rotura de
cristal)

Crea un Proyecto nuevo en una carpeta nueva, llamado Stress.dpr.
En el formulario, Unicamente pondremos una imagen o botdn
para salir. Pero utilizaremos la propiedad AlphaBlend a 100 para
variar la transparencia del formulario.

:ﬁEFurnnl _=J£;]£:J

var
Forml: TForml;
Live : TBitmap;

Object Inspector x|
I Farml TFarm1 ;I

Froperties | Ewicrilie |

implementation
{$R *.DFM} Action =
{$R extrares.res} // <- aqui se incluye el recurso ActiveCantrol
Align alMone
procedure TForm1.FormCreate(Sender: TObject); AlphaBlend True
begin AlphaBlendyalue | 100
Screen.Cursors[5] := LoadCursor(HInstance, 'Malet'); Jicarga er cursor n° 5 der recurso vialet
Screen.Cursors[6] := LoadCursor(HInstance, 'MaletDown'); /lcarga el cursor n° 6 del recurso MaletDown
Screen.Cursor := TCursor(5); /I Al pulsar el mouse aparece el cursor 5 (martillo)
Live := TBitmap.Create; /I Crea una imagen imagen Bitmap: Live
Live.LoadFromResourceName(HInstance, 'Live'); /I Carga la imagen Bitmap Live del recurso: Live
Live.Transparent:=true;
end;

procedure TForml.FormMouseDown(Sender: TObject; Button: TMouseButton; Shift: TShiftState; X, Y: Integer);
begin
Screen.Cursor := 6; // Al pulsar el mouse aparece el cursor 6 (martillo bajado)
Canvas.Draw(x-50, y-35, Live); //Al pulsar el mouse Dibuja la imagen Live en los pixels de canvas
end;
procedure TForm1.FormMouseMove(Sender: TObject; Shift: TShiftState; X, Y: Integer);
begin
Screen.Cursor := 5;
end




Ejercicio Else If y variables. Mover un objeto y controlar su posicién.

Objetivo: Se trata de la estructura base para el movimiento de un objeto en un juego evaluando con un IF el
estado de la variable subir que como es légica (booleriana) puede ser verdadera (true) o falsa (false).

Labelaltura Labelchoques  LabelTogues
Mpara: 0. ::; Choques:: 0. ;- Joques:
Labell: - oo Label2: oo 1abei3: (B
T [ = o B
Ioiiiiiii SR i
SESEEESEEERSS 7 REESEEEESEE
............. -.~_.":_‘-"--'_|
DIIIIIIIIIIID e \Z\’.‘lrﬁn'ggmﬁﬁﬁﬁﬁ

e Coccion:

Pulsar doble clic sobre el fondo de la ventana
formulario y escribir dentro del procedure el
texto en negrita del recuadro derecho -

Esto sirve para inicianlizar las variables y
ponerlas a cero al crearse la ventana.

Estas variables anteriores deben estar
declaradas al principio como publicas, porque
se utilizaran en varios procedimientos. Subir
a la seccién Var del cédigo y afiadir el texto

gque se muestra en negrita cursiva del cuadro
->

Volver al formulario pulsando F12 y luego
pulsar doble clic sobre la imagel y escribir
dentro lo que se muestra en el recuadro
derecho »

Cada vez que se da un clic en la imagen, la
pone en movimiento, cuenta un toque y
cambia el sentido de subida.

Pulsar doble clic sobre el Timerl y escribir
dentro del procedure lo que se muestra en
cursiva a la derecha de cuadro derecho —»

Segun el estado de la variable subir, sumara
o restara la posicion vertical de la imagen y
esto ocurrira cada décima de segundo.

Si toca arriba 0 abajo, se parara el timer y
contara un choque

. Ingredientes:
» 7 Labels de la paleta Estandar

» 1 Image de la paleta Adicional
» 1 Timer (temporizador) de la paleta System

o Preparacion:
En sus propiedades (Properties), los objetos tendran el

nombre (Name) que se indica en la imagen de la izquierda.
Cambia las propiedades (Properties) de los elementos:
Label 1: Cambiar propiedad Caption: Altura

Label 2: Cambiar propiedad Caption: Choques

Label 3: Cambiar propiedad Caption: Toques

Timerl: Poner su estado Enabled: False y su Interval: 1
Labelaltura, Labeltoques y Labelchoques: poner caption a
cero.

Imagel: Picture: Cargar el dibujo de una pelota. Strech: True

procedure TForm1.FormCreate(Sender: TObject);

begin
subir:=false; //ponemos en falso la variable subir.
choques:=0; //ponemos a cero los contadores
Toques:=0;

end;

var
Form1: TForm1;
subir:Boolean; //variable para controlar el sentido
choques:Integer; //variable para contar los choques
Toques:Integer; //variable parat contar los toques

implementation
procedure TForm1l.imagelClick(Sender: TObject);
begin
Timerl.Enabled:=True; //activamos el timer
if subir=true then subir:=false else subir:=True;
toques:=toques+1; //sumamos un toque
LabelToques.caption:=inttostr(toques);
end;

Procedure TForml.TimerlTimer(Sender: TObject);
begin
if subir = True then imagel.Top:=imagel.top-1
else imagel.Top:=imagel.top+1;
labelaltura.caption:=inttostr(Forml.clientHeight-
imagel.top);
if (imagel.top<=0)
or (imagel.top>=Forml.clientHeight-imagel.height)
then
begin
choques:=choques+1;
Labelchoques.caption:=inttostr(choques);
Timerl.Enabled:=False;
end;
end;

Comprueba pulsando F9 o el botén Run P> su funcionamiento. Si se bloquea escoge del menu: Program —

Reset.

Escoge del menu: File — Save all para guardar el proyecto y su unidad. Escoge tu carpeta de trabajo.
Guarda la unidad con el nombre: toquesl.pas y luego guarda el proyecto con el nombre: Toques.pdr
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Animacion. Protector de pantalla (Uso del estamento CASE)
Ingredientes:
- Shape ‘E (Paleta Additional): Name: Bola; Shape: stCircle
- Timer (paleta system): Timerl — Interval: 20
- Botones: 2 (Empezar y parar)
Formulario: Si lo deseas, puedes asignar color transparente.
Variables:
Mover: integer;

Acciones:
En el Buttonl: Empezar: Timerl.enabled=true;
En el Button2: Parar: Timerl.enabled=false;

procedure TForm1.FormCreate(Sender: TObject); //Al crearse el formulario

begin
mover:=1; //->importante: La variable: Mover, debe tener cualquier valor

end;

procedure TForm1.Timer1Timer(Sender: TObject); //En el timerl Case:
begin Bifurca las acciones dependiendo
case Mover of de diversos resultados de un
1: // Mueve la bola a la izquierda y hacia arriba parametro del tipo ordinal

begin

Bola.left:=Bola.Left - 20;
Bola.Top:=Bola.Top - 20;
// Si el grafico alcanza el borde izquierdo del formulario, se mueve a la derecha y hacia arriba.
If Bola.Left <= © Then Mover := 2
// Si el grafico alcanza el borde superior del formulario, se mueve a la izquierda y hacia abajo.
Else If Bola.Top <= @ Then Mover := 4;
End;
2: // Mueve la bola la derecha y hacia arriba
begin
Bola.left:=Bola.Left + 20;
Bola.Top:=Bola.Top - 20;
{Si el grafico alcanza borde derecho del formulario, se mueve a la izquierda y hacia arriba.
Se determina el borde derecho del formulario restando el ancho del grafico del ancho del formulario.}
If Bola.Left >= (Forml.Width - Bola.Width) Then Mover := 1
// Si el grafico alcanza el borde superior del formulario, se mueve a la derecha y hacia abajo.
Else If Bola.Top <= @ Then Mover := 3;

N

end;
3: // Mueve la bola a la derecha y hacia abajo
begin

Bola.left:=Bola.Left + 20;

Bola.Top:=Bola.Top + 20;

// Si el grafico alcanza el borde derecho del formulario, se mueve a la izquierda y hacia abajo.

If Bola.Left >= (Forml.Width - Bola.Width) Then Mover := 4

// Si el grafico alcanza el borde inferior del formulario, se mueve a la derecha y hacia arriba. Se
determina el borde inferior del formulario restando la altura del grafico de la altura del formulario menos 680
twips debido a la altura de la barra de titulo la barra de menus.

Else If Bola.Top >= (Forml.Height - Bola.Height) Then Mover := 2;

End;

4: // Mueve la bola a la izquierda y hacia abajo

begin
Bola.left:=Bola.Left - 20;
Bola.Top:=Bola.Top + 20;
// Si el grafico alcanza el borde izquierdo del formulario, se mueve a la derecha y hacia abajo.
If Bola.Left <= @ Then Mover := 3
// Si el grafico alcanza el borde inferior del formulario, se mueve a la izquierda y hacia arriba.
Else If Bola.Top >= (Forml.Height - Bola.Height) Then Mover := 1;

End;

Variantes y mejoras:
Este protector de pantalla puede convertirse en un juego de habilidad (mezclado con el anterior) si al pulsar doble clic
sobre el objeto (que puede ser una imagen) cuenta los golpes y a su vez se acelera el objeto.




Animacion. (Juego Ping) Avanzado Firemonkey

var
Forml: TForml;
plx, ply, p2x, p2y, p3x, p3y: real;
recuadros
b: byte;
modowin:boolean;
mx,my:integer;

//posic. de los

//posic. del mouse

procedure TForml.ButtonPausaClick(Sender: TObject);

begin
Timerl.Enabled := False ;
Timer2.Enabled := False ;

Timer3.Enabled := False ;
Timer4.Enabled := False ;

. ]
buttonSalir.Visible := True ;
buttonIniciar.Visible := True ;
end;
procedure TForml.ButtonIniciarClick(Sender: TObject);
begin
Timerl.Enabled := True ;
Timer2.Enabled := True ;
Timer3.Enabled := True ;
Timer4.Enabled := True ;

El
buttonSalir.Visible := False ;
buttonIniciar.Visible := False ;

{$IFDEF MSWINDOWS}

modowin:=true; //si es windows
{$ELSE}
modowin:=false;
{$ENDIF}

end;

//si no es windows

procedure TForml.FormCreate(Sender: TObject);
begin
Timerl.Enabled:=False;
Timer2.Enabled:=False;
Timer3.Enabled:=False;
Timer4.Enabled:=False;
plx := forml.Width / 2; //situa al centro inferior
ply := forml.Height-20;
end;

procedure TForml.FormMouseMove
begin

mx:=round(x) ;

my :=round(y);

end;

procedure TForml.TimerlTimer(Sender: TObject);
begin

rectanglel.Position.X := plx; //mueve los objetos
rectanglel.Position.Y := plY;
rectangle2.Position.X := p2X;
rectangle2.Position.Y := P2Y;
rectangle3.Position.X := p3X;
rectangle3.Position.Y := P3Y;

Application.ProcessMessages;
acabe la tarea anterior
end;

//procesa pero espera a que se

procedure TForml.Timer2Timer(Sender: TObject);

var
a: integer;
begin
if ply < @ then
begin
b := @; //modo bajar
ply := ply + 15;
end;

if ((trunc(ply) < trunc(p3y) - rectanglel.Height)) and
((trunc(ply) > trunc(p3y) - rectanglel.Height - 5))and (plx >
p3x - rectanglel.Width / 1.3) and (plx < p3x +
(rectangle3.Width - rectanglel.wWidth) + rectanglel.wWidth /
1.3) then
begin
if b = @ then
bajando....puntua
begin
label4.Text := inttostr(strtoint(label4.text) + 1); end;
b :=1;
end;

//si hay colisién con primera pala

if ((trunc(ply) < trunc(p2y) - rectanglel.Height)) and
((trunc(ply) > trunc(p2y) - rectanglel.Height - 5))and (plx >
p2x - rectanglel.Width / 1.3) and (plx < p2x +
(rectangle2.Width - rectanglel.Width) + rectanglel.width /
1.3) then

begin

if b = @ then
bajando....puntua
begin

//si hay colisién con segunda pala

label4.Text := inttostr(strtoint(labeld.text) + 1);

end;
b :=1;
end;

if ply > forml.Height then

begin
b :=1; //pone en modo subir
ply := forml.Height - 63;
plx := forml.Width / 2;

//toca fondo pierde

if strtoint(label4.Text) > strtoint(label2.Text) then

label2.Text := label4.Text; //fija la maxima puntuacién y pone

puntos a cero.
label4d.Text :=
end;

0

if b = 1 then
begin
ply := ply - 5; //resta posicidén vertical
if modowin=false then //si esta jugando en
controla con el sensor
begin
if (rectanglel.Position.X + 20 *

//si esta en modo subir

android

motionsensorl.Sensor.AccelerationY < forml.Width) and

(rectanglel.Position.X + 20 *
motionsensorl.Sensor.AccelerationY > @) then
plx := rectanglel.Position.X + 20 *
motionsensorl.Sensor.AccelerationY;
end
else
begin
if (mx - plx) > Rectanglel.Width then plx
rectanglel.Position.X + 5 //mouse a la derecha
else if (mx - plx) < 5 then plx :=
rectanglel.Position.X - 5; ////mouse a la izda
end;
end;

//si esta jugando en windows

if b = @ then //si esta en modo bajar

begin
ply := ply + 5; //suma posicién vertical
if modowin=false then
begin

if (rectanglel.Position.X + 20 *

motionsensoril.Sensor.AccelerationY < forml.Width) and

(rectanglel.Position.X + 20 *
motionsensorl.Sensor.AccelerationY > 0) then
plx := rectanglel.Position.X + 20 *
motionsensorl.Sensor.AccelerationY;
end
else
begin

//si esta jugando en windows

if (mx - plx) > Rectanglel.Width then pilx :

rectanglel.Position.X + 5 //mouse a la derecha
else if (mx - plx) < 5 then plx :=
rectanglel.Position.X - 5; ////mouse a la izda
end;
end;
end;

procedure TForml.Timer3Timer(Sender: TObject);
pala 1 aleatoriamente
begin
p2y := forml.Height / 1.3;
p2x := rectangle2.Position.X - 10;
if rectangle2.Position.X < -150 then
begin
p2x := forml.Width;
timer3.Interval := Random(150)+10;
end;
end;

procedure TForml.Timer4Timer(Sender: TObject);
pala 2 aleatoriamente
begin

p3y := forml.Height / 1.3;

p3x := rectangle3.Position.X + 10;

//mueve la

//mueve la

if rectangle3.Position.X > forml.Width + 150 then

begin
p3x := - 150;
timer4.Interval := Random(150) + 10;
end;
end;
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Delphi. Ejercicio 5 . Movimientos y contadores. Juego

En la figura se muestran los componentes y sus propiedades principales.

PMainForm I = E

Comp: Panel

!IName: Panell
{|color: Azul :
‘lonclick:flecha1Click \

Comp: Label
Name: Labell
Cantion: Fnciende la luz

Comp: Image
Name: Flechal

/ Picture:Arrowlr.bmp

Onclick: flechalClick

Comp: Image

Comp: Timer Name: Bombilla

Name: Timerl

I Picture: \
Inte.rva ) 10_ . Images\buttons\bulboff.omp
OnTimer: TimerlTimer

'Lﬂ

BitBtn1l

Sali <—1:

sertos:\0 omp: Image
ﬁf N \ Name: Bombillal
\ Picturelmages\buttons\bulboff.omn
Comp:
Name: Ti Comp: Image

Interval: 10 Name: Bombilla2
OnTimer: i .
Comp: Label TimeraTimer Picture: \Images\buttons\
Name: Label2 N
Caption: 0 Comp: Panel3 Cqmp. Panel2
taRightJustify Align: alLeft Align: alBottom
Bevelouter: bvLowered
Caption: Aciertos
Preparacion: Alignment: taLeftJustify
var
MainForm: TMainForm;
subir:integer; /I => Variable publica para controlar el sentido subir sera numérica entera
Acciones:

El timerl se encarga de desplazar la flecha hacia la derechay comprueba si su posicién esta cerca de

la bombilla:
procedure TMainForm.TimerlTimer(Sender: Tobject); {solo funciona si el timerl estd activado}
begin
if (flechal.left=460{bombilla.left})and (flechal.top<bombilla.top+10) and (flechal.top>bombilla.top-10)
then

begin
bombilla.picture:=bombilla2.picture; {si flecha toca bombilla cambia picture a bombilla2}
puntos.caption:=inttostr(strtoint(puntos.caption)+1); {suma un punto y convierte en cadena}
end;
if flechal.left<500 then
flechal.left:=flechal.left+5 {avanza de izquierda a derecha 5 pixels a cada pulso del timer}
else
begin
timerl.enabled:=false; {descativa el temporizador timerl}
flechal.left:=10; {si la flecha pasa de largo empieza de nuevo en posic.

izquierda a 10}
end
end;



El timer2 se encarga de desplazar arriba y abajo la bombilla, (segun si la variable subir esté a 0 0 1):

procedure TMainForm.Timer2Timer(Sender: TObject);

begin
if subir=0 then {si no estad activado subir..}
begin
if bombilla.top<200 then {si no pasa de 200 de profundidad que siga bajando}
begin
bombilla.top:=bombilla.top+1;
bombilla.picture:=bombillal.picture; {por si estd encendida, que se apage}
end
else {si pasa de 200 de fondo...}
subir:=1 {que se active subir}
end
else {si esta activada subir..}
begin
if bombilla.top>@ then {y si aun no esta arriba...}
bombilla.top:=bombilla.top-1 {que siga subiendo}
else {si ya ha llegado arriba...}
subir:=0 {que se descative subir}
end
end;

Al empezar el programa, la variable subir debe de valer algo (cero por ejemplo)
procedure TMainForm.FormCreate(Sender: TObject);
begin
subir:=0; {empieza con subir desactivado}
end;

Al hacer clic sobre la flecha se activa el timer (0 también se puede hacer sobre un botén)
procedure TMainForm.flechalClick(Sender: TObject);
begin
timerl.enabled:=true; {al hacer clic con el ratdén que se active el timerl}
end;

Variantes y mejoras:

Conexién a Internet.
1.- Crea un botén que nos conecte con la pagina web de soporte del programa:
Afiade la siguiente linea de cédigo:

ShellExecute(GetDesktopWindow(),nil, pChar(‘www.ofimega.es/oficalc/index.htm®), nil, nil, SW_SHOWNORMAL);

2.- Crea un boton que nos abra un archivo web de ayuda:
o Crea el archivo web: 'instrucciones.htm' (con Microsoft Word o Dreamweaver), explicando el funcionamiento del
programa. Este archivo debe guardarse en el mismo directorio o carpeta que el ejecutable (.exe).

* Aflade el componente webbrowser '& de la paleta Internet.
o Asignar propiedad visible= false
* Afiade las siguientes lineas de codigo:

var
dire:string;
begin
dire:=ExtractFilePath(ParamStr(0)); //Detecta la ruta del programa
WebBrowserl.visible:=true;
WebBrowserl.Navigate('file://'+dire+'instrucciones.htm’)
end;

Cdmo ejecutar un programa externo:
var
dire:string;
begin
dire:=ExtractFilePath(ParamStr(0));
ShellExecute(Forml.Handle,nil,PChar(dire+'programa.exe'),"'","",SW_SHOWNORMAL )
end;
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Ejercicio 7. Control de direccién y velocidad de un objeto
Completa este programa esqueleto para disefiar un juego de aterrizaje lunar de una nave espacial:
ﬂl M ainF orm M=] E3
AEmpezar | Parar I Inicio_, I o alir | [c] Ofimega - S alou
Name: Empezar |3/ A :
T Name:lnicio
Cobambiarshape
Pamel2. Bottom Z|Interval=50 -l g
Panel3.Bottom :
""""" e Tscrollbar
:]JComponente: {vertical
i /|Tbiagauge {Name: Barrav
o IName: Nivelh [ nnn g e Max: 10

progressbar
Name: Nivelv y nivelh
Max-Min: +10 -10

Min: -10

progressbar
Name: Energia
0-100

Tscrollbar
Horizontal
Name: Barrah

Acopla la nave amarilla 5i chocar con los asteriodes

Procedures:

Procedures de los botones:
EmpezarClick
timerl.enabled:=True;
PararClick
timerl.enabled:=False;
InicioClick
shapel.top:=124;
shapel.left:=184;
SalirClick
Close;

Procedure de las barras de
desplazamiento:

barravChange
nivelv.value:=barrav.position;

1
barrahChange
nivelh.value:=barrah.position;

energia.progress:=energia.progress-

Variantes:

e Elfondo de la ventana sera de color negro y se afiadiran shapes de estrellas blancas

e El objeto ser& el dibujo de una nave en un picture box. Do Lo
(En el programa esqueleto el objeto es un shape de forma circular.) « R

e Se afadiran asteroides que resten puntos y/o desvien la nave de su ruta.

e Finalizara el juego al coincidir el objeto con las coordenadas de la base lunar.

e Puedes sustituir las barras de direccion por botones Updown de la paleta Win32 o sustituirlos por
ArcDial y TrackBar el en Firemonkey

Procedure del timer

TimerlTimer
Shapel.Left := Shapel.Left + barrah.position;
Shapel.Top := Shapel.top + barrav.position;

If Shapel.Left<0

Variante para que no se salga la nave de los limites de la ventana a incluir en el procedimiento del timer:
then Shapel.Left:=299;

If Shapel.Left>300 then Shapel.Left:=1; ->ldem para control arriba y abajo con la propiedad top

Estilos para XE Rad Studio: 4 Application [ ] Amakrits
Si usas XE: Escoge del menu: Project — Options: Application — Appearance ! L.l Appearance L] Amethyst Kamri
y activa un estilo como: M Aqua Graphite ‘... Version Info Aqua Graphite

[ ] Aqua Light Slate

Guarda el proyecto con el nombre: Aterriza.dpr y la unidad Aterrizal.pas en

la carpeta: Aterriza



Variante Multidevice FireMonkey: Simulador Dron

¢ Crea nuevo proyecto. File » New » Multidevice application - Delphi

e Poner los componentes de la imagen:

MultiR esBitmap
Mame

(TFixedMultiResBitmap
Image1

e Cambia la propiedad dtlel formulario Form1. |Stylebook: por StyleBookl. Resource: Transparent

=
Enabled
Interval
MNarme

Misitin 1:

Timer:

Emmm————
Pot: umn [ Pos 0 ] [ Ignitioni

MName
StaysPressed

Fuel:

procedure TForm4.ScrollVChange(Sender: TObject);
begin
if sender= ScrollV then
TrackV.Value:=ScrollV.Value
else
TrackH.Value:=ScrollH.Value;
ProgressF.Value:=ProgressF.Value-1;
end;

Ignition
True

procedure TForm4.DialVChange(Sender: TObject);
begin
if sender=TrackV then
ScrollV.Value:=TrackV.Value
else
ScrollH.Value:=TrackH.Value;
ProgressF.Value:=ProgressF.Value-1;
end;

procedure TForm4.TimerlTimer(Sender: TObject);
begin
Navel.Position.X:=Navel.Position.X+ScrollH.Value;
Navel.Position.Y:=Navel.Position.Y+ScrollV.Value;
ProgressT.value:=ProgressT.value-1; //--> consumo
de tiempo
Navel.rotationangle:=ScrollH.Value*3; //-->
inclinacién de nave
ComprobarBordes(); //comprueba si se sale
//ComprobarAterrizaje(); //comprueba si aterriza
bien
end;

procedure TForm4.IgnitionClick(Sender: TObject);
begin

Timerl.Enabled:=Ignition.IsPressed;
ScrollV.Value:=-1;

end;

Notas:

procedure TForm4.ComprobarBordes();
begin

if Navel.Position.X>PlotGridl.width then
Navel.Position.X:=0;

if Navel.Position.X<@ then
Navel.Position.X:=PlotGridl.width;
end;

e Hemos creado un procedimiento independiente para comprobar si se sale del borde, por lo tanto hay que declararlo
en la lista de declaracion de procedures: procedure ComprobarBordes();

e Laaccidn para el evento ScrollHChange es la misma que para ScrollVChange

e Laaccién para el evento DialHChange es la misma que para DialVChange

Guarda el proyecto con el nombre: Dron.dpr y la unidad Dronl.pas en la carpeta: Dron



Salir
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Bloc de notas. Editor de textos.
Uso de los cuadros de didlogo Abrir - Guardar — imprimir...
. il Block de notas [sin titulo] _[O] =] |
IDpenDiaIDg'I: TOpenDialog T Achivo  Awuda
Properties | Eventsl ;I
CH3D True Savedialogl
D efaultE «t * bt :
FilzM ame @ Form1.MainMenul 1
Filker Archivos de texbo [F Rt fuchiva  Ayuda |
Filter ndex 0 Nusvo
HelpCortext |0 =
InitialDir Abrir... g
M ame OperDialagl = Guardar
+0ptions [ofHideReadOnly] Guardar Como...
Tag n

| Fitter Editor

Filter Mame

Archivos de testo [*.kat]
Todosz loz archivas [%.7]

procedure TForm1.NuevolClick(Sender: TObject);
begin

Memo1l.Clear;

OpenDialogl.Filename := "

Caption := 'Text Demo - [Untitled]'’;
end;

procedure TForm1.AbrirlClick(Sender: TObject);
begin
with OpenDialogl do
if Execute then
begin
Memol.Lines.LoadFromFile(FileName);
Caption := 'Text Demo - ' + ExtractFilename(FileName);
end;
end;

procedure TForm1.GuardarlClick(Sender: TObject);
begin
if OpenDialogl.Filename <> " then
begin
Memol.Lines.SaveToFile(OpenDialogl.Filename);
end
else Guardarcomo1Click(Sender);
end;

procedure TForm1.Guardarcomo1Click(Sender: TObject);
begin
with SaveDialogl do
if Execute then
begin
Memol.Lines.SaveToFile(Filename);
Caption := 'Text Demo - ' + ExtractFilename(FileName);
OpenDialogl.Filename := Filename;
end;
end;

Filker -
* LAt

B3

procedure TForm1.SalirlClick(Sender: TObject);
begin

Close;
end;

procedure TForm1.FormCloseQuery(Sender: TObject; var
CanClose: Boolean);

var
MsgResult: Word;
begin
if Memo1.Modified then
MsgResult := MessageDlg(Format('Archivo %s
modificado. ¢Guardar?’,
[OpenDialogl.Filename]), mtWarning, mbYesNoCancel,
0);
case MsgResult of
mrYes:
begin
Guardarcomo1Click(Sender);
CanClose :=True;
end;
mrNo: CanClose := True;
mrCancel: CanClose := False;
end;



USO DE COMPONENTES DE TEXTO. RICHEDIT y ActionList

Vamos a generar un pequefio procesador de textos utilizando la plantilla SDI y el componente Richedit.

1.
2.

Elije del menu principal: File » New » Other...
Escoge de Delphi Projects: SDI Application. Indicar la carpeta para el
proyecto: Crear una nueva carpeta llamada Editor. El asistente nos generara

3 SDI Application [ = | & |l

File Edit Hel

un formulario con los componentes basicos. Un mend, una barra de _D ﬁ; = :'|*:_; B

herramientas y una barra de estado. Afiade al formulario un objeto Richedit RichEdit] .

(Paleta Win32) alineado al cliente.

Cambia su propiedad Align: alCliente y su borra el texto de la propiedad i @

Lines = =
La plantilla nos ha generado un formulario con una barra de herramientas y un e =
menu que contienen llamadas a las mismas acciones, por ejemplo, la accién de
Abrir puede ser llamada desde el botdn de abrir o desde el menu: Archivo - OpenDialog ~ SaveDialog
Abrir. Cada objeto de ambas, hace referencia a una accién que esta centralizada
en la lista de acciones: ActionListl y es llamado desde el evento Action.
Para completar el evento FileOpen1 TAction
Abrir, pulsamos doble click Properties | Events AR | @ v
sobre Accionlist1 'y AutoCheck [ |False Categories: Actions (VCL):
seleccionamos la accion: Caption &Abrir (No Category) || [ Filemew1
FileOpen1. Category File Edit (& FileOpen1
En sus propiedades: cambia E::E:‘EE; _';rafee Help FileSave 1
sus propiedades Caption y HelpType hikeyword (all Actions) FileSavets1
Hint como en la figura. Hint Abrir | Abre un archivo existent EileE it

?@ Ohject Inspector ke

En el evento OnExecute, cambia el cédigo: OpenDialog->Execute(); por:
if OpenDialog.Execute() Then
RichEditl.Lines.LoadFromFile(OpenDialog.FileName);

Del mismo modo selecciona la Accion FileSavel y cambia el cédigo por:

if SaveDialog.Execute() Then
RichEditl.Lines.SaveToFile(SaveDialog.FileName);

En ambos objetos, cambiar la propiedad filter, para poder especificar e tipo de
documento al abrir o guardar, como en la figura y las propiedades: Filterindex: 3
DefaultExt: *.rtf

Otras acciones:

|FileQpenl TAction

Properties |Events

OnExecute

OnHint
2 0l Indat=

Filter Name

Todos (*.%)

Archivos de texto TXT
Texto erigueddo .RTF

Filter
Fixt
=rtf

= Acciones Cortar, copiar y pegar: Estas acciones funcionan sin cédigo escrito porque estds asociadas a una combinacion

del teclado que se designa en la propiedad: ShortCut: Ctrl+X, Ctrl+Cy Ctrl+V.
= Accidn Nuevo: FileNew1 - FileNew1Execute: afiade el cddigo:

RichEditl.Lines.Clear();

= Acccidn Salir: FileExitl - FileExit1Execute. Comprueba el cdédigo: Close () ; 6 Application.Terminate () ;

AboutBox->ShowModal();

Problemas y mejoras:
Nombre de archivo al guardar:

Acccion Acrecade (Créditos): HelpAboutl - HelpAbout1Execute. Comprueba el codigo:

Al escoger Guardar la aplicacién no nos deberia solicitar el nombre si ya se ha guardado o recuperado antes:

Creamos una variable publica que guardara el nombre del archivo:

Cambiamos el cédigo del procedimiento FileSavelExecute:
if Sender=FileSavel then
begin

if nombrearchivo!="

' then RichEditl.Lines.SaveToFile(nombrearchivo);

RichEditl.Modified := False;
end
else
if SaveDialog.Execute() then
begin

RichEditl.Lines.SaveToFile(SaveDialog.FileName);
Nombrearchivo:=SaveDialog.FileName;
end;

Anadimos el cédigo al Abrir:  nombrearchivo:=OpenDialog.FileName;

nombrearchivo:

String ;
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Preguntar al cerrar o nuevo:
Tanto si creamos un archivo nuevo o salimos del programa, la aplicacidn nos deberia peguntar si deseamos conservar o

guardar el documento editado. Para ello utilizamos la propiedad Modified del componente Richedit.
FileNew1Execute...
begin
if RichEdit1.Modified=True then
if MessageDlg("éGuardar documento anterior?",
mtInformation, TMsgDIgButtons() << mbYes << mbNo << mbCancel, 0)= mrYes) then
FileSavelExecute(Sender);
end
RichEditl.Lines.Clear();
RichEdit1.Modified:=False;
end

Al cerrar el formulario ocurre antes el evento FormCloseQuery donde se consulta antes de cerrar la variable CanClose:
FormCloseQuery...(Sender, CanClose)

{
if (RichEditl.Modified=True) then

if (MessageDIg("éGuardar documento?”, mtIinformation, TMsgDIgButtons() << mbYes << mbNo << mbCancel, 0)= mrYes)
then FileSavelExecute(Sender);

CanClose:=True;

end Print TAction
Imprimir' Properties | Events
~ ’ . . . . AutoCheck False
= Aflade un objeto PrintDialog1 de la paleta Dialogs. ) - o
" ., ) . . ) L Caption Imprimir...
Afade una nueva accion a la lista ActionList1 para imprimir, con las ' _
] . o o ., Hint Imprime el documento
propiedades de la imagen al que le afiadiremos la siguiente accion en el ImageIndex 14
evento OnExecute: Name Print|

if PrintDialogl.Execute() then RichEditl.Print(nombrearchivo);
= Afiade un elemento en la seccidn file del MainMenu y un nuevo botdn en la ToolBarl de modo que su accion Action se
vincule a: Print.
= Para generar la accidon Configurar Impresora, puedes crear una Standard Action del tipo: FilePrintSetup. Luego puedes
afiadir el elemento en el menu para abrir el cuadro de didlogo: Configurar impresora:

Ejecuta y prueba (Run I). Si todo es correcto, Guarda todo (File » Save All): Unit: Editorl - Proyecto: Editor

Procesar textos en Multidevice (Firemonkey)

Utilizamos el componente Memo1 en modo mévil/Firemonkey para editar e imprimir texto:
Para Imprimir en modo Firemonkey afadir la libreria

FMX.Printer y utilizar las funciones begindos y Abrir Guardar Irmprimiir 2~ |
enddoc Categories: Actions (FMX):
Ejercicio para imprimir: (Mo Categor| | Abrir1

i O O]
v Guardarl
procedure TForm2.ImprilExecute(Sender: TObject); |:::> Cimprd
PrintDialog]  PageSetupDialogl  ActionList!
var
MyRect: TRectF; //recuadro area de impresidn
i:integer;

begin

if PrintDialogl.Execute then OpenDialogl  SaveDialogl Imagelistl
with Printer do ' Memo1
try //Intenta si puede
BeginDoc; {iniciamos documento a imprimir
Printer.ActivePrinter.SelectDPI(1200, 1200);

MyRect := TRectF.Create(©, ©, Pagesetupdialogl.PageWidth, Pagesetupdialogl.PageHeight); //area de impresion
Printer.Canvas.Font.Size := 12; //tamafo del texto
//Printer.Canvas.textout() para usar con las VCL o Lazarus

for i:=1 to memol.Lines.Count-1 do

// fills and draws the text in the specified rectangle area of the canvas:

Printer.Canvas.FillText(MyRect, Memol.Lines[i], false, 1,[], TTextAlign.Center, TTextAlign.Center);

finally

EndDoc; //Como ya tenemos el lienzo dibujado con nuestro texto, con EndDoc lo enviamos a imprimir
end;

end;



Ejercicio de aplicacion Delphi. Procesador de textos. Ventanas madre e hija

Una ventana Madre (MDI) contendra varias ventanas hijas (Child). Para ello debmos cambiar la propiedad FormStyle a:
fsMDlform para la ventana madre y fsMDIChild para la ventana hija. Luego, en Project — Options, poner la ventana Hja en la
lista de available. Esta es la ventana Madre:

:'I_I]Winedil_ Editor de textos maltiple =] [E3

Achivo Wentana Apuda |

........................... Grouplndex: 0

EEEEEEEEEE\EEEEEEEE v OpenFileDialog

| r| FrameForm. Hamh‘lenu‘l

\_, Name: Madre

FormStyle:fsMDIForm

Ventana:
(GroupIndex: 9)
Cascada: Cascade;
Mosaico: Tile;
Organizar iconos:

\ Arrangelcons;

Salir: (Grouplindex: 9)

Archivo — nuevo: Archivo — salir (madre) Procedures ventana:
procedure TMadre.Nuevo procedure TMadre.Salirl Cascadaclick: Cascade;

THija.Create(Self); Close: Mosaigoclicl.c Tile:

end; Organizarclick: ArrangeIcons;

end;
Archivo — abrir: Archivo — salir (hija) {groupindex:0}
procedure TMadre.Abriril; procedure THija.Salirl

if OpenFileDialog.Execute then MadreSaliri(Sender);

with THija.Create(Self) do end;

Open(OpenFileDialog.FileName);

Aqui aparece la ventana Hija:

L2

: - 1 Nuevo archivo, todavia no tiene nombie [Sin titulo]
Elle Edt Eaarch Emw Erﬂﬁd Srchiva Editar Testo Buscar

Megess o|xXpm 0 2] 4

bl
1 1T

5 4 B8gam
lewl: 'F-I‘v'lenultem - an.llamﬂwmﬂ S ] %] |

“roperties |Events] Archi e T 1 y -

Break T SO tar Tewto Buscar |, Archivo: (Grouplndex: 0) Mismo que madre
BN m MHuevo ChilsM Editar: (GroupIndex: 1)
Checked Fake Abrie Chiledy Texto: (Grouplindex: 1)

Defauk  [Fae (| Ceemas — R
E nabled e s - - - I_“M__
Groupindex |0 [ Guardar Cul+G e

HeloContext |0 ! Guardar Como...

Hirt Nuewvo docurento
M ame Mewl

I P Yo Cutdl )
ShartCut Clel+M Impresora...

Tag 1]

Visble  Twe Sak CuleF4
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Aqui estan los procedures de la ventana Hija:

procedure THija.SetFont
begin
FontDialogl.Font := Memol.Font;
if FontDialogl.Execute then
Memol.Font := FontDialogl.Font;
SetEditRect;
end;

procedure THija.Open(const AFilename:

string);

begin
Filename := AFilename;
Memol.Lines.LoadFromFile(FileName);
Memol.SelStart := 0;

Caption := ExtractFileName(FileName);
Position := poScreenCenter;
Memol.Modified := False;

end;

procedure THija.AbririClick
begin

madre.Abril(Sender);
end;

procedure Hija.SalirlClick;
begin

madre.SalirlClick(Sender);
end;

procedure THija.AlinearClick
begin
Leftl.Checked := False;
Rightl.Checked := False;
Centerl.Checked := False;
with Sender as TMenuItem do Checked :=
True;
with Memol do
if Leftl.Checked then
Alignment := talLeftJustify
else if Rightl.Checked then
Alignment := taRightJustify
else if Centerl.Checked then
Alignment := taCenter;
end;

procedure THija.ImprimirlClick;
var
if PrintDialog.Execute then
memol.Print(FileName);
end;

procedure THija.ImpresoralClick(Sender: TObject);
begin

PrinterSetupDialogl.Execute;
end;

Procedure Guardar

if (Filename = '') or IsReadOnly(Filename) then
GuardarcomoClick(Sender)

else

begin

Memol.Lines.SaveToFile(Filename);
Memol.Modified := False;

procedure THija.GuardarcomolCLlick(Sender:

TObject);
begin
SaveFileDialog.Filename := Filename;
if SaveFileDialog.Execute then
begin
Filename := SaveFileDialog.Filename;
Caption := ExtractFileName(Filename);
Modifica.Caption:=' '";{retira mensaje}
SavelClick(Sender);
end;
end;
procedure THija.SavelClick(Sender: TObject);
begin

if PathName = DefaultFileName then
GuardarcomolClick(Sender)

else

begin
Editor.Lines.SaveToFile(PathName);
Editor.Modified := False;

end;

end;

procedure THija.FormClose(al cerrar la ventana hija)
begin

Action := caFree; (para que pueda ser cerrada por
la madre)
end;

procedure THija.FormCloseQuery(accidén antes de
cerrar)
var
DialogValue: Integer;
FName: string;
begin
if Memol.Modified then
begin
Confirma.showmodal; ->Muestra ventana confirma
FName := Caption;
Confirma.Label2.Caption:="'iGrabar '+Fname;
case Confirma.Modalresult of
mrOK: SavelClick(Self);
mrCancel: CanClose := False;
end;
end;
end;

procedure THija.NuevoiClick

begin

Modifica.Caption:="Otro documento nuevo';
madre.Nuevo(Sender);

end;

procedure THija.CerrariClick
begin

Close;
end;

procedure THija.NegritaClick(Sender: TObject);
begin

if Negrita.Down then MEMOl.Font.Style :=
MEMO1.Font.Style + [fsBold]

else MEMO1.Font.Style := MEMOl.Font.Style -
[fsBold];

end;




ActionlList y ActionManager: Procesador de textos utilizando el componente ActionList

Escoge: Archivo — Nuevo proyecto VCL (o VCL Forms application)

Cambia la propiedad: Form1.caption = Editor de textos

Anadir componentes al formulario:

- Ahadiremos un componente RichEdit de la paleta win32.

Una vez sobre el formulario cambiar la propiedad align a client.

- Pulsa doble clic en el componete StatusBar de la paleta win32 y este

se afiadird abajo del formulario como barra de estado.
Para crear un panel en la barra de estado:
En la propiedad SimpleText -> escribir: Sin titulo.txt.
En la propiedad Panels abrir el cuadro de Panels
Clic en el botén New para afiadir un panel a la barra de estado
statusbarl. Cierra el cuadro.
- Afladir menu y barra de herramientas:
De la paleta estandar escoge el componente: Mainmenul
De la paleta Win32 escoge el componente: ToolBar
Agrupar acciones mediante Action list:

[® Editor de textos

REE

File Edit Help
] =
Muewvo | Guardar
RichEdit1

ActionLiztl Imagelist] Mainkdenul

Para agrupar las acciones del menu y de la barra de herramientas Delphi proporciona un “action manager” para

centralizar ambos cédigos e imagenes.

En la paleta adicional, haga doble clic en el componente: ActionManager o en la paleta estandar: action list. Para afadirlo
al formulario. Como es un componente no visual, se puede poner en cualquier sitio.
Para ver los captions de componetes no visuales escoga: Tools - Environment Options, clic en Designer page, y

seleccionar: Show component captions, OK..

Menu Comando Herramientas? Descripcién

Archivo Nuevo Si Creates a new file.

Archivo Abrir Si Opens an existing file for editing.

Archivo Guardar Si Saves the current file to disk.

Archivo Guardar No Saves a file using a new name (also lets you save a new

como... file using a specified name).

Archivo Salir Si Quits the editor program.

Edicion Cortar Si Deletes text and stores it in the clipboard.

Edicion Copiar Si Copies text and stores it in the clipboard.

Edicion Pegar Si Inserts text from the clipboard.

Ayuda Contenido No Displays the Help contents screen from which you can
access Help topics.

Ayuda Indice No Displays the Help index screen.

Ayuda Acerca.. No Displays information about the application in a box.

Doble-clic en Action list para abrirlo

En Editing Form1.ActionManager1 pulsar el boton: New Action. En sus

propiedades escribir:

» Caption = &New

»  Category = Archivo

»  Hint = Crea un archivo nuevo

» Imagelndex = 6 (imagen 6 de Imagelist)

» Name = FileNew

Pulsar el botdn: New Action. En sus propiedades escribir:
»  Caption = &Guardar

»  Category = Archivo

»  Hint = Guarda el archivo

» Imagelndex = 8 (imagen 8 de Imagelist)

»  Name = FileSave

Pulsar el botén: New Action. En sus propiedades escribir:
»  Caption = &Indice

»  Category = Ayuda

»  Hint = Indice ayuda

»  Name = HelpIindex

Pulsar el botdn: New Action. En sus propiedades escribir:
»  Caption = &Acerca...

» Category = Ayuda

»  Hint = Acerca de... Name = HelpAbout

[ Editing Form1.ActionList1
-8

Cateqores:

o

Actions:

Variante: ActionManager

Similar a Actionlist, tenemos el componente:
ActionManager en la paleta Adicional. Va en
combinacidn con Actionmainmenu y Actiontoolbar.
Permite la apariencia Office XP y permite
personalizar las barras de herramientas y el menu
en tiempo real, con el componete: CustomizeDlg.
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Anadir acciones estandar al acion list (open, save as, exit, cut, copy, paste, help)

Pulsar el botén derecho del mouse a escoger del menu contextual:

afiadir New estandar Action: Afadir las acciones: TEditCut, TEditCopy, y Ib Editing Form1.ActionList1

TEditPaste. Se creard la categoria Edit -3 + 8
, . . o . . Categories: Actions:
En la categoria archivo o File aflade: TFileOpen, TFileSaveAs, and
. . (Ho Categary]
TFileExit. Archiva EdCutl | {3 New Action

Apuda ;
) EdPaste?)  ow Editpaste
En la categoria Help afade THelpContents. (Al Actions] News Standard Action...

Guarda el proyecto: File - Save All

Afiadir imagenes al image list

Truco: Abre el arcivo (Archivo abrir) : C:\Archivos de programa\Borland\DelphiX\Source\Vcl\ActnRes.pas.
Aparece un ejemplo con las imagenes estandar ya listas.

También puedes Pulsar Add y buscar las imagenes en: C:\Archivos de programa\Archivos comunes\Borland
Shared\Images\Buttons

Form1.lmagelList1 ImageList
et g Ot Edit|Cut 0
plions
|:l—_'.'-' [hene . 51| % Edit| Copy 1
e Edit| Paste 2
! = 1° File|New 6
Images File|Open 7
2 O If File|Save 8
m 1 2 3 File|SaveAs 30
l | I File | Exit 43
add. | Demte | Oew | Ewor. | Help | Contents 20

5 o =

ActionLiztl ImageLiztl Maintenul

Anadir un menu:
De la paleta estandar escoge el componente: Mainmenul y pulsa
doble clic, para afadirlo al formulario.

. . . Insert Template
Pulsa luego doble clic sobre el componente del formulario mainmenul

para editarlo. gpen... Edi Menu
Save File: Meru
- File tenu [for TestEdit Exampls]

Save As... Help Menu
Help tenu (Expanded)
DI Frame tenu

En la propiedad: imagelist escoge: imagelist1l

. . ~_ s Prink... i
Puedes usar el botén derecho del mouse sobre el menu para afiadir = Window Menu
. . ST Prink Setup...
elementos al menu desde la plantilla: Insert from template. O afiadir - P
los elementos manualmente usando el botdn derecho del mouse
Exit

sobre el menu y escoger Insert.

Afadir una barra de herramientas:
- De la paleta Win32 escoge el componente: ToolBar y pulsa doble clic, para afiadirlo al formulario.
- Enla propiedad imagelist, escoge: imagelistl
- Pulsa el boton derecho del mouse para afiadir botones a la barra de herramientas
- Enla propiedad de cada botén de Action: Busca la actionlist que corresponda.

0y =
IHUE‘\.“:' Guardar_| Save A Mew Buttan
RichEdit] Mew Separator




Codigos de ejemplo tipicos de eventos en Procesadores de texto

Trabajar con ventanas

Salir. Cerrar ventana.
begin

Close;
end;
Pregunta para cerrar.
procedure TForml.FormClose(Sender: TObject; var
Action: TCloseAction);
begin

if MessageDlg('Salir del programa ?',
mtConfirmation,

[mbYes, mbNo], ©) = mrYes then

Action := caFree
else
Action := caNone;
end;

Evento al cerrar hija (on close)
procedure THija.FormClose(Sender: TObject; var
Action: TCloseAction);

begin

Action := caFree; //Close Action Permitido
end;
Abrir ventana Acerca de... AboutClick
begin

AboutBox.ShowModal;
end;
Poner nombre del archivo a una ventana.
Ventana.Caption := ExtractFileName(FileName);

Ventana mosaico.
procedure TFrameForm.TilelClick(Sender: TObject);
begin
Tile;
end;
Ventana cascada.
procedure TFrameForm.CascadelClick(Sender:
TObject);
begin
Cascade;
end;
Ventana organizar.
procedure TFrameForm.ArrangeIconslClick(Sender:
TObject);
begin
ArrangeIcons;
end;
Nueva ventana hija. (desde la madre)
procedure TPrincipal.NuevolClick(Sender: TObject);
var
Hija: THija;

begin
Hija:= THija.Create(Application);
Hija.Show;

end;

Nueva ventana hija. (desde la hija)
procedure THijaNewlClick(Sender: TObject);
begin
Ventana.Caption:="nuevo';{retira mensaje}
PrincipalForm. NuevolClick(Sender);
end;
Abrir ventana hija.
procedure TFrameForm.OpenChild(Sender: TObject);
var
EditForm: TEditForm;
begin
if OpenFileDialog.Execute then
begin
EditForm := TEditForm.Create(Self);
EditForm.Open(OpenFileDialog.Filename);
EditForm.Show;
end;
end;

‘Trabajar con textos

Abrir texto en un componente memo.
procedure TForml.FileOpenClick(Sender: TObject);
begin
with OpenDialogl do
if Execute then

begin
Memol.Lines.LoadFromFile(FileName);
Caption := 'Text Demo - ' +
ExtractFilename(FileName);
end;
end;

Guardar_texto memo.
procedure TForml.SavelClick(Sender: TObject);

begin
if OpenDialogl.Filename <> '' then
begin
Memol.Lines.SaveToFile(OpenDialogl.Filename);
end
else SaveAslClick(Sender);
end;

Guardar _como... texto memo.
procedure TForml.SaveAslClick(Sender: TObject);
begin
with SaveDialogl do
if Execute then

begin
Memol.Lines.SaveToFile(Filename);
Caption := 'Text Demo - ' +
ExtractFilename(FileName);
OpenDialogl.Filename := Filename;
end;
end;

Didlogo Buscar texto.
procedure TForml.Find(Sender: TObject);
begin
with Sender as TFindDialog do
if not SearchMemo(Memol, FindText, Options)
then

ShowMessage('Cannot find "' + FindText +

s
end;
Didlogo Reemplazar texto.
var

Found: Boolean;
begin

with ReplaceDialogl do

begin

if AnsiCompareText(Memol.SelText, FindText) =
0 then
Memol.SelText := ReplaceText;

Found := SearchMemo(Memol, FindText, Options);
while Found and (frReplaceAll in Options) do
begin ...
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Trabajar con archivos (vcl)

Detectar directorio.
procedure TFMForm.DirectoryChange(Sender..);

begin
FileList.Directory := Directory.Directory;
DirectoryPanel.Caption := Directory.Directory;
end;

Detectar lista de archivos.
procedure TFMForm.FileListChange(Sender: TObject);
var

TheFileName: string;

begin
with Filelist do
begin
if ItemIndex >= @ then
begin
TheFileName := FileName;

FilePanel.Caption := Format('%s, %d bytes',
[TheFileName, GetFileSize(TheFileName)]);
end
else FilePanel.Caption := '';
end;
end;
Ejecutar archivo.
procedure TFMForm.OpeniClLick(Sender: TObject);
begin
with FilelList do
ExecuteFile(FileName, '', Directory, SW_SHOW);
end;

Copiar, renombrar, mover archivos.
procedure TFMForm.FileChange(Sender: TObject);
begin

with ChangeForm do

begin
if Sender = Movel then Caption := 'Move'’
else if Sender = Copyl then Caption := 'Copy'
else if Sender = Renamel then Caption := 'Rename’
else Exit;
CurrentDir.Caption := FilelList.Directory;

FromFileName.Text
ToFileName.Text := ;
if (ShowModal <> idCancel) and (ToFileName.Text <>
"") then
ConfirmChange(Caption, FromFileName.Text,
ToFileName.Text);
end;
end;

:= FileList.FileName;

Borrar _archivos.
procedure TFMForm.DeletelClick(Sender: TObject);
begin
with FilelList do
if MessageDlg('Delete '

mtConfirmation,

[mbYes, mbNo], ©) = idYes then

if DeleteFile(FileName) then Update;

+ FileName + '?°',

end;

Llamadas a procedimientos

En el menu: Archivo - Mover y Copiar llaman al mismo
evento Filechange

procedure TFMForm.FileChange(Sender: TObject);

begin
with ChangeDlg do
begin
if Sender = Movel then Caption := 'Mover'
else if (Sender = Copyl) or (Sender = copiara) or
(Sender = Copiaral) then Caption := 'Copiar’
else if Sender = Renamel then Caption := 'Renombrar’
else Exit;
CurrentDir.Caption := Statusbar.panels[2].text;
FromFileName.Text := FilelList.FileName;
ToFileName.Text := '';

if (ShowModal <> mrCancel) and (ToFileName.Text <>
'") then ConfirmChange(Caption, FromFileName.Text,
ToFileName.Text);
{Llama al procedimiento confirmchange pasandole tres
variables de texto}
end;
end;

Procedure TFMForm.ConfirmChange(const ACaption,
FromFile, ToFile: string);
begin
if MessageDlg(Format('%s %s to %s?', [ACaption,
FromFile, ToFile]),
mtConfirmation, [mbYes, mbNo], @) = mrYes then
begin
if ACaption = 'Mover' then
MoveFile(FromFile, ToFile)
else if ACaption = 'Copiar' then
CopyFile(FromFile, ToFile)
else if ACaption = 'Renombrar' then
RenameFile(FromFile, ToFile);
FileList.Update;
end;
end;



Usar archivos INI para configuracion

Para grabar y leer datos de configuracién de una aplicacion, utiliza la clase Tinifiles para generar archivos del tipo INI que
almacenan informacion de texto con la INIcializacion de la aplicacién.

Es necesario afnadir la libreria INIFILES en la seccion USES de la unidad.

Utiliza el proyecto anterior para afiadir los siguientes procedimientos:

Grabacion del archivo INI:

procedure onclose

var

datosini:TIniFile;

begin
datosini:= TIniFile.Create('DATOS.INI'); //-->crea el archivo datos.ini
datosini.Writelnteger('Formato', 'Posicionizquierda’,form1.left);
datosini.WriteString('Formato’', 'nombre',form1.caption); //guarda dato del tipo texto string
DATOSINI.FREE; --> cierra el archivo datos.ini

end;

Lectura del archivo INI:

Procedure on create
var
datosini: TIniFile;
begin
datosini:= TIniFile.Create('DATOS.INI');
form1.left :=datosini.readinteger('Formato', 'Posicionizquierda',100);

Ejemplo valido para multiplataforma

Como grabar y leer todos los caption del formulario segin el idioma escogido:

= Buscaremos todos los componentes de nuestro formulario usando la clase: TCOMPONENT que me devuelve
el nombre del componente segln el nimero de 6rden de creacion en el formulario. Por lo tanto:

= Components[3] es una variable array o matriz (conjunto de variables ordenadas) que me devuelve el nombre
del componente nimero 3

= Componentis TLABEL: Evalua si el componente es de la clase o tipo Tlabel

{Al cargar el formulario lee el archivo de idioma.Ing que le ha dicho en el archivo datosiniy que antes lo ha guardado el
usuario al cambiar la configuracion de idioma en el archivo Datos.ini}
var

Ini: TIniFile;

component:tcomponent;

i:integer;

dire:string;
begin
Dire:= Application.GetNamePath; //dire es la ruta por defecto
Ini := TIniFile.Create(dire+'\langs\'+idioma+'.1lng"'); //crea el archivo ini idioma.lng

//-> Ruta para ios: TIniFile.Create(GetHomePath + PathDelim + 'Documents' + PathDelim+ 'ex.ini');
for 1 := © to ComponentCount - 1 do //->Agrupa por componente seccion [CAPTIONS]
begin
Component := Components[ i ];
if (Component is TLABEL) and ((Component as TLABEL).Caption <>'') then
(component as TLABEL).Caption:=Ini.ReadString( 'CAPTIONS', (component as
TLABEL) .name, (component as TLABEL).Caption)
end;
end;
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Creacion de objetos (Extracto canal It Tools Ltda)

» En una apliacién nueva VCL, abrimos en Code al inicio de la unidad.
» En la definicdn de tipos, crearemos la clase estudiante y el array MisNotas.

Luego crearemos el objeto estudiante del tipo Testudiante.
type //definicién de tipos
MisNotas= Array [1..4] of double;
TForml = class(TForm)
private
public
end;
Testudiante = class //defino los datos de la clase estudiante
Nombre: string;
Apellido: string;
Asignatura: string;
Suma: double;
end;
var
Forml: TForml;
estudiante: Testudiante; //creo estudiante del tipo Testudiante

» En el formulario, afiadidos los objetos de la imagen.
» Declaramos y afiadimos los procedimientos y la funcion:

procedure TForml.ButtonlClick(Sender: TObject);

var
prom: MisNotas;

begin
ConsultarNombre;
CalcularPromedio(prom);

end;

procedure Tforml.ConsultarNombre;

begin
estudiante:=Testudiante.create;
estudiante.Nombre:=Editl.Text;
estudiante.Apellido:=Edit2.Text;
estudiante.Asignatura:=Edit3.Text;

Showmessage( 'Estudiante: '+ Estudiante.nombre + ' ' + Estudiante.Apellido);

estudiante.Destroy; // para liberar memoria
end;

function TForml.CalcularPromedio(Notes: MisNotas):double;

var f:string;

begin
Notes[1]:=StrToFloat(EditN1l.text);
Notes[2]:=StrToFloat(EditN2.text);
Notes[3]:=StrToFloat(EditN3.text);
Notes[4]:=StrToFloat(EditN4.text);
Result:=(Notes[1]+Notes[2]+Notes[3]+Notes[4])/4;
f:=FloattoStr(Result);
Showmessage( 'Promedio = '+f);

end;

Estudiante

Nombre |Edit1 |

Apelidos ~[Edit2 |

Calificaciones

Asignatura |Edit3
Mota 1:

|EditN:l

Nota3: |EGitN3

Notad: |EGitN4

|
|
Nota 2 |Edithi2 |
|
|

Mostrar




Ejercicio base de animacion. Flappy.

A cada impulso del timer la imagen se intercambia con las otras dos y avanza. Las otras dos imagenes deben estar ocultas
y el timer activado (enabled). Ajustamos la propiedad interval del timerl a 100 o 200.
El truco reside en utilizar una variable a modo de permiso o bandera flag que puede ser del tipo integer o mejor boolean

(2 estados).
9.9 g

Imagen?Imagen2

o 4

Visual Basic: Private Sub Timerl_Timer()
Static Flag As Integer
Imagen.Move Imagenl.Left + 20, Imagen.Top - 5
If Flag = 1 Then

Imagen.Picture = Imagenl.Picture

Flag = @ Imagen
Else
Imagen.Picture = Imagen2.Picture
Flag = 1
End If
End Sub

C++ Builder:

Pascal - Delphi:
void __ fastcall Forml::TimerlTimer

procedure TForml.TimerlTimer(Sender: TObject);

{ var
boolean Flag = True; //variable flag

Flag: boolean; //variable flag
Imagen->Left=Imagen->Left+10;

begin
if (Flag == true) Imagen.Left:=Imagen.Left+10; //mueve a la derecha
{ If Flag = true Then
Imagen->Picture= Imagenl->Picture; begin

Imagen->Top=Imagen->Top+10;

Imagen.Picture:= Imagenl.Picture;
Flag= false;

Imagen.Top:=Imagen.top+10;

} Flag:= false;
else end
{ else

Imagen->Picture= Imagen2->Picture;

begin
Imagen->Top=Imagen->Top-10;

Imagen.Picture:= Imagen2.Picture;

Flag= true; Imagen.Top:=Imagen.top-18;
1} Flag:= true;
H end;

end;

Firemonkey - Delphi
PajaroFlag: Boolean;
RectangleMouseDown:
begin
if Timerl.Enabled=true then
begin
if pajaro.Position.Y<75 then pajaro.Position.Y:=0
else pajaro.Position.Y:= pajaro.Position.Y-75;
end;
pajaro.RotationAngle:=0;
TimerlTimer:
if PajaroFlag=False then
begin
Pajaro.Bitmap.Assign(PajaroB.Bitmap);
PajaroFlag := True;
end
else
begin
Pajaro.Bitmap.Assign(PajaroA.Bitmap);
PajaroFlag := False;
end;

Guarda el proyecto con el nombre: Flappy1l
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Bases de Datos con Delphi - Teoria

Delphi y C++ Builder tienen métodos de acceso a bases de datos que se basan en TDataSet. que, como su
nombre lo indica, es un "set de datos". El set de datos abstracto no especifica el origen de la base de datos .
Esto lo hace flexible e independiente.

Los componentes Table y Query son los componentes mas cominmente usados para acceso basico a
bases de datos (pero no los Unicos). Estos componentes representan una tabla y una consulta SQL,
respectivamente.

Conectores:

= BDE: Librerias para acceder a tablas de dBase con el motor DataBaseEngine (obsoleto)

= ODBC: Controlador creado por Microsoft para accesar a datos, integrado en Windows.

= LiveBindings. (Versiones Xe). Acceso desde controles de FireMonkey y dispositivos moviles.

Driver o librerias de acceso a datos:

= DbExpress: Sustituto del BDE que ha quedado obsoleto.

= ADO: ActiveX Data Objects. Permite acceder a datos, sin necesidad de conocer la base de datos.
= XML Client Dataset: Acceso a tablas de datos XML Necesita MIDAS.dII

= FireDac. (Versiones Xe) Acceso directo a bases de datos

Componentes No Visuales de Acceso a Datos:
Conexién: Configura el driver y el modo de cacceso a la base de datos.

Database: Es la representacion de todo el conjunto de datos, conjunto de tablas de datos o lugar donde se
guardan.

Table (Tabla): Representa una tabla entera. TTable contiene informacion acerca del tipo de tabla, del indice,
asi como filtros. TTable tiene entre sus métodos, First, Next, Last, etc.

Query (Consulta): Se comporta como una tabla, pero al mismo tiempo es un comando de SQL.

¢Porqué SQL?: La respuesta es sencilla: COMPATIBILIDAD. La especificacion SQL-92 es soportada por
todos los lenguajes generales.

DataSource: Es el "origen de los datos". Un componente intermedio que permite tener varias
representaciones de los mismos datos

UpdateSQL: Permite editar un query SQL. Todos los queries tienen un Edit, Insert y Delete. TStoredProc:
Permite ejecutar un comando SQL sin esperar ninguna respuesta, como un procedimiento.

Componentes Visuales de Acceso a Datos

Los componentes de este tipo son llamados "Data-aware", y tienen el prefijo "DB". De este modo, un
componente de edicién "Edit" en su version "Data Aware" es llamado "DBEdit". ComboBox se convierte en
"DBComboBox".

DBgrid es una tabla de datos y DBControlGrid equivale a formularios continuos.

Ademas, existe un componente llamado "DBNavigator”, que es una serie de botones "mapeados” a los
comandos Next, Prior, Last, Edit, Delete, etc., de cualquier DataSource.



Ejercicio 8. Bases de datos. Agenda de teléfonos.

e Tablade datos DBF - Modo DBE: (obsoleto)

En un gestor de base de datos, crear el archivo que contendra los
datos Data Base File.

Crear la estructura de la derecha y guardar como Agenda.dbf

En el formulario principal de Delphi, afiadir los componentes:
Tablel (Paleta BDE) y Datasourcel( Paleta Data Access)

En la Tablel: La propiedad TableName es el nombre del archivo de
datos: Agenda.dbf ; Name es el nombre de la Tabla: Tablely
Databasename es la ruta donde se encuentra el archivo de datos

Tabla de datos Access FireDAC

En Access y crea una base de datos con una tabla que contenga
los campos de la imagen y guradar como Agenda.adb En el
formulario principal de Delphi, afiadir los componentes: un
TFDTable y un TEDConection (Paleta FireDAC) un Datasourcel(
Paleta Data Access)

En TFDConcetion, DriverName MsAccess y Database: la ruta de
archivo de base de datos de Access.

En la TFDTablel: La propiedad TableName poner el nombre de la
de Access ; Name es el nombre de la Tabla: Tablel y Conection es
el TFDConection creado.

e Tablade datos XML - Modo ClientDataset

Create dBASE for Windows Table: { Untitled )
Field roster:

Field Mame Type| Size
1| AFPELLIDOS C al
2{NOMERE C al
3| TELEFOMND C 20
4{EMAIL C al
A(DIRECCION C aa
B(NOTAS C aa
- | T - on
Create dBASE for Windows Table: { Untitled )
Field roster:
Field Mame Type| Size
1| APELLIDOS C al
2| MOMERE C al
3 TELEFOMNOD C 20
4{EMAIL C ad
S(DIRECCION C aa
B(NOTAS C aa
7 C aa

Mew Field

- En el formulario principal de Delphi, afiadir los

componentes ClientDataset y un Datasource Field properties

(Paleta Data Access). Name:  Telefono Component:  ClientDataSet 1Telefono
- Pulsar el botén derecho sobre el componente

ClientDataset y escoger de Fields editor... New Type:  String ~ Size: 20

field. ;
- Crear los campos de la imagen derecha: Nombre R e e 5

— Apellidos — Telefono — Email — etc...del tipo @ Data Look. Aggregal

String y ancho de unos 50 a 100 caracteres. Calculated Interr |AEellid-:-s ‘

Una vez finalizado, cierra la lista de campos y

pulsa el boton derecho sobre el ClientDataset y escoge: Create Dataset y luego: Save to MyBasexml table.

Guarda la tabla con el nombre: Agenda.xml
Llamale al clientdataset con el nombre: Tablal

Datasourcel Asegurate que la Tablal esta en Active=True.
Ya puedes probar la aplicacion (Run P> 6 F9)

A la Datasourcel le pones en su propiedad Dataset: el nombre Tablal.
Afadir al formulario los componentes DbNavigator y un DBGrid de la paleta de Datacontrols y asignales la

Comprueba que que permite afiadir y borra datos en la tabla, pero estos se pierden al volver a ejecutar la

aplicacion.

Cierra prueba y uelve al disefio y selecciona la tablal asigna la propiedad a la Tablal: filename: Agenda.xml

(también pedes asignarla en tiempo de ejecucion)

Afiade los otros componetes de la imagen: Un mena y un cuadro para buscar dentro de un panel alineado al Top.

El mend consta de los items: Archivo -> Salir y Ver -> Siempre visib

le y transparente

Guarda el proyecto: Save Project as...Crea una carpeta llamada Agenda y guarda la unidad como: Agendal.pasy

el proyecto como Agenda.dpr

,.nl Agenda |Labell " =
Archivo  Wer Editl Panell DBNavigatorl
B E:// Evento OnChange: Datasource:Datasourcel
Busc& por Apelidos: | — Editlchange 'q | < ,
¥ =
APELLIDOS |NOMBRE |[TELEFONO =

3
Dbgrid1 |7
Dat. : Dat 1 - £ —
TovonTe e ¢|\. : =7 Tablel o Clientdataset

Datasourcel \TabIeName: Agenda.dbf

Dataset: Tablel o /1 \7 O Filename: Agenda.xml
4 | || Clientdataset Mainmenu Active: True

StatusBar:

Banaestado &—  |Name: Barraestado o Agendaform.

Archivo Ver
Siempre Visible
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- Vuelve a ejecutar el proyecto y comprueba que ahora si se quedan guardados los datos en el archivo
Agenda.XML.

- Para buscar el nombre:
Es necesario indexar la tabla por el campo a buscar: Para ello escoge de la tablal: IndexDef y crea un nuevo
indice para el campo nombre y otro para el campo apellidos. Luego asigna el indexname: Apellidos a la tabla.
Pulsa doble clic en el cuadro Editl para abrir el evento EditlChange:
Escribe el cadigo:

EditlChange
Tablal.setRangeStart;
Tablal.FieldByName('Apellidos').AsString:=Edit1.Text;
Tablal.Applyrange;

Procedures: - .
. . . ., visibleClick:
CreateForm (asigna la table en tiempo de ejecucion) £ visible.Checked then F LF Stvle =
Tablel.tablename:= ‘Agenda.dbf’ //—para DBF fSI vng _;_a' ecke enrorml.rormotyle :=
o Tablal.filename:="Agenda.xml’ // = para XML sstayOnTop
else Form1.FormStyle := fsNormal;
end;

Application.OnHint :=muestrahints; .
Tranparenteclick:

if tranparente.Checked then

Edit1Change
Form1l.alphablend:=true;

Tablal.SetrangeStart;
Tablal.FieldByName('Apellidos').AsString:=Edit1.Text;
Tablal.Applyrange;
//=>Mostrar infomacidn en barra de estado:
SalirlClick Procedure muestrahints
Close; Barraestado.Caption := Application.Hint;

Variantes al ejercicio:
Ordenar la tabla:
= Sitienes instalados los componentes JVCL puedes cambiar el dbgrid por un JVultimdbgrid que te permite ordernar
la tabla al pulsar en el encabezado del campo.
Crear acceso con password.
e Afade una ventana tipo Pasword que pida la clave antes de entrar:
File — New — Other —(Delphi files o Dialogs) — Password dialog
e En (Project - Options - Autocreate forms): Cambiar el orden para que se muestre PasswordDlg 5
primero la ventana de Password antes que la principal (main). Form1
Si la respuesta es correcta, habilitar el botén OK que mostrard la ventana principal Form1.
Opcionl: Anadir la unitl de la ventana principal a la lista de uses del password y llamarla con form1.show
Opcién2:

Auto-create forms:

PasswordChange:
If Password.text= ’ofimega’ then Okbtn.enabled:=true;
Okbtnclick:
// ->Opcién 1
Application.CreateForm(Tforml, forml);

//-> Opcidén 2:
forml.Show; // -> muestra la ventana forml
hide; // -> oculta la ventana atual



Acceso login usuario Acceso a tablas Access con Firedac

Nombre del campo Tipo de datos

Crear la Tabla: Entra en Access y crea una base de datos con una tabla

llamada Acceso que contenga los campos de la imagen: Id Autonumeracion
Usuario Texto
Clave Texto
Componentes: Crea en Delphi un nuevo proyecto y afiade los Permiso Numere
componentes de la imagen. O Form1

. . - . E {
En EDConeccionl pulsa doble clic y especifica el driver: MsAcces y noan

la ruta donde has guardado la base de datos que debe ser la misma
del ejecutable. Luego cambia Conected: True

EHWEFID:|M5AEE
Database |31J_|I:Ii|:|'|PrDjects \Accesolacceso.mdb E-|

El DataSourcel asignar su dataset a: Tablel
El Tablel: Asigna su Tablename = acceso y Active=True

Complementos: Para realizar las pruebas y comparaciones puedes afiadir al formulario un DBNavigator y un DBGRid
ambos conectados con el Datasourcel

Método de busqueda de usuario por el indice:
procedure TForml.BitBtnlClick(Sender: TObject);
var
encontrado:string;
begin
Tablel.IndexFieldNames := 'Usuario';
Tablel.SetKey;
Tablel.FieldByName( 'Usuario').AsString := EUsuario.Text;
if Tablel.GotoKey then
begin
ShowMessage( 'Encontrado a '+TUsuario.Value);
if TClave.value=Eclave.Text then ShowMessage('Clave

Método de busgueda secuencial:
procedure TForml.BitBtnlClick (Sender: TObject);
var
encontrado: Boolean;
opciones:TLocateOptions;
begin
opciones:= [LOCaseInsensitive];
encontrado:= FDTable2.Locate('Usuario', EUsuario.Text,
opciones);
if encontrado=false then
showmessage('Usuario incorrecto o inexistente')
else

correcta') begin
else ShowMessage('Clave Incorrecta'); showmessage('Muy bien! has encontrado a '+
end FDTable2Usuario.value + 'y su clave es la '
else + FDTable2Clave.value);
ShowMessage( 'Usuario no encontrado'); end;
end; end;

Método para crear nuevo usuario:

procedure TForml.BNuevoUsuClick(Sender: TObject);
var
encontrado: Boolean;

opciones:TLocateOptions; else
begin begin
opciones:= [LOCaseInsensitive]; TableAcceso.Append;
if NUsuario.Text='" then showmessage('No puede estar vacio') else TableAccesoUsuario.value:=NUsuario.text;
begin TableAccesoClave.value:=NClavel.Text;
if NClavel.Text=NClave2.Text then end;
begin end
encontrado:= TableAcceso.Locate('Usuario', NUsuario.Text, else
opciones); begin

if encontrado=true then showmessage('No coinciden las claves');
showmessage('Ya existe un uauario con el mismo nombre') end;

end;

end;

Ejercicio nivel de acceso.

Seleccionar el tipo de acceso segln el nivel de permiso:

Una vez encontrado el usuario y contrasefa leera el permiso y si es nivel 0 muestre un label en la ventana con la
infomacién: “Modo Usuario + nombre’ pero si es el nivel de permiso 1 muestre: “Has entrado como adminitrador” +
nombre.
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Aplicacién tetst de preguntas y respuestas TestWin - Acceso a tablas Access con Firedac
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Utiliza el apartado anterior para iniciar sesién en la

aplicacién en modo usuario o administrador. Imagel . l
En el formulario pondremos una imagen alineada a/ g
top como encabezado de ventana y un pagecontrol, " ggsn oo N """"""" —_—
alineado alClient, al que le afiadiremos tres pestanas [%
o tabsSheets con los nombres: sesién, frontal y Next Page

Pagecontrol

trasera Previous Page

Delete Page

— ~

Acceso a datos.

Desde Access creamos la base de datos Testwin con 3 tablas: Acceso, Todos los... ® « || 5 Acceso | I Preguntas |
Preguntas y Temas y los siguientes campos: Buscar.. e Nombre del campo | Tipo de da
= Acceso: Usuario — Clave — Permiso abes 2 ||_ITEMA Texto
=  Temas:ID-Tema BR Acceso DIFICULTAD MNumero
= Preguntas: Tema, Dificultatd, T1, R1, R2, R3 $4, Sol, Comen, Imagen = 1 Memo
Preguntas R1 Texto
Pdgina Sesion B Temas R2 Texto
. a4 . R3 Texto
En el formularlf), afiadimos los objetos 7 I:: Eﬁ' E+;- Ra Texto
de datos de la Imagen. FDGUIxWaitCursor1 DataTema DataPreguntas DatafAcceso S0L Texto
COMEMN Texto
Cada datasource enlaza con su gl IMAGEN Objeto OLE
respectiva TFDtable y en ellas, cada FDConnectionl TableTema TablePreguntas TableAccese  Tablename con las tablas de la
base de datos. Params

TableMName TableMame TableName
;]Dﬂtﬂbﬂse Temas Preguntas Acceso

WinXEvtestwinmdb
Pestafia de acceso:
Afadimos dos gropubox

Destinado a iniciar sesién de usuario o crear Bienvenido a la aplicacién TestWin 2.0

nuevo usuario. @ Iniciar sesidn @ Muevo usuario
En cada uno de ellos insertamos dos cuadros Nombre:
de texto (edits) y dos botones (buttons) como Usuario:
en la flgura' . Contrasefa:
El segundo groupbox, se establece visible = NCBvel
false. . Contrasefia: .
Al pulsar el boton BNuevo del primer Repita la contrasefia:
groupboxl1 se mostrara el segundo y ocultard NClave?2
el primero: . Acceder Nuevo usuario

procedure TForm1.BNuevoClick(...);

begin BAcceso: TButton Aceptar Cancelar

.. Origin: 45, 176; Size: 84 x 25
GroupBox2.Visible:=True; ° Tab Stop: True: Order: 2 °
GroupBox1.Visible:=False; - -
end: Id  Usuario Clave Permiso
' ¥ DBGridAcceso: TDBGrid 123

. o . i . Origin: 64, 304; Size: 337 x 104
Opcional: Puedes afiadir al formulario un DBGrid y un DBNavigator no Tab Stop: True; Order: 2
visules y vinculados a la tabla de Acceso para crear y comprobar a los 3 e _;_‘ - - :
usuarios. @ @ 2

Afadimos un nuevo GroupBox3 que contendra un LookupComboBox

llamado Filtrotema, para la -
seleccién del tema y un PR S v—
LabelUsuario que informara Escoge tema
del nombre del usuario. =

Hola usario, escoge el tema :

FiltraTema ~
FiItrUTelma: TDBLookupComboBox

Inidiar Cancelar

Al pulsar el botén para acceder Bacceso, compueba con la funcién
Locate si el usuario existe en la tabla. En caso afirmativo, muestra el
GroupBox3 para escoger el tema. Una vez escogido el tema, al pulsar el

procedure TForm1.BAccesoClick(Sender: TObject);
var

encontrado: Boolean;

opciones:TLocateOptions;
begin

opciones:= [LOCaselnsensitive];

encontrado:= TableAcceso.Locate('Usuario’,
EUsuario.Text, opciones);

if encontrado=false then

showmessage('Usuario incorrecto o inexistente')
else
begin

GroupBox1.Visible:=False;

GroupBox2.Visible:=False;

GroupBox3.Visible:=True;

LabelUsuario.caption:= TableAccesoUsuario.value;
end;

botdn de Iniciar, activaremos la segunda pagina del pagecontrol:




procedure TForm1.BInicioTemaClick = Pagecontrol.ActivePagelndex:=1;

Pdgina trasera

Es la pagina de administracidn de preguntas y se accede a ella con privilegios de admninistrador. En ella podemos crear y
modificar preguntas. Afiadimos los controles con los nombres que se muestran en la imagen:

Pregunta n*: Recno 1< < =

T DBTextPregunta

Enunciado:

Bl 1 = v "
DB Navigator2

ComboT*l:F\:rd-nElEiLDDI-cUpCDmbaElax ~ |

iComo se llama la barra que contiene el boton de inicio? -
Imagen: | Pegar {brir / /_/_;, T
BPegarimiagen BAbririmaden (Eftasource DataPreguntas
DbMemol
DbImal|—— E = 28|
OpenPictureDialogl TablePreguntas
DBlmage
Respuestas: Modificar Temas
EditR1 Mﬂnnadiosm TEMAS 2
Escoge tema...
EditR2 Barra de tareas Tods
\\O&Earra de inicio Windows
EditR3
“TUCBarra del pan word
. Excel  DbGrid2
EditR4 _——-D—Barra de estado
Teclado
= Dificultatd: ComboDif | DENavigatorl ™

DBComent Comentario:  [Eninglés: Task Bar

Al pulsar el el botdn pegar: DBImal.PasteFromClipboard;
Al pulsar en el botén Abrir: if OpenPictureDialogl.Execute() then
dblmal.Picture.LoadFromFile(OpenPictureDialogl.FileName);

Pdgina frontal

< * || =
Para cargar la imagen: Afadir antes un elemento de didlogo: OpenPictureDialog
Para Modificar Temas: Al pulsar el Boton Modificar Temas: GroupboxTemas.visible:=true;
En la pestaia frontal, afadir los controles con los nombres que se muestran en la imagen:
Tema: Histonia - Pregunta n®: Recno
;C6mo se llama la barra que contiene el botén de inicio? DBImagel

Respuestas: Haz clic sobre el circulo de la res

esta correcta....
—_——— — —
puEelsiguiente ImagenBien

RadioRespuestas | |
O/A Barra de tareas R1 | |
OB |Barra de inicio R2 | |
(O C |Barra del pan R3 | |
OD |Barra de estado R4 | |
S
jCorrectol Incorrecto. la solucidn era la:— Labellncorrecto
o Sigu\iirlhe- Comentario: |En inglés: Task Bar |
BSiguiente Progreso
I =—-Progreso2
Respuestas: 0 Aciertos: 0 Mota media: 0 MNum preguntas deltema: 0 |Empezar de nuevo
Labelpreguntas |abE|aCiE§OS Labelmedia LabelTotal Blﬂiﬂij

Creamos las variables publicas:
aciertos, preguntas: integer; //-> numéricas enteras
media: single; //-> decimales de precisién sencilla

Anadimos los eventos siguientes:
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Al pulsar (On Click) en el botén Bsiguiente:

R1.font.color:=clblack;
R2.font.color:=clblack;
R3.font.color:=clblack;
R4.font.color:=clblack;
labelcorrecto.visible:=false;
labelincorrecto.visible:=false;
DBTextcomen.visible:=false;
Labelpregunta.caption:='Pregunta nimero ' +
inttostr(preguntas+1) +' de ' +
inttostr(TablePreguntas.RecordCount);
labelsiguiente.caption:= 'Haz clic sobre el circulo de la respuesta
correcta...';
labelelige.visible:=true;
RadioRespuestas.itemindex:=-1;
Bsiguiente.enabled:=false;
//StatusBarl.Panels[0].Text:='N2 de pregunta: '
+inttostr(TablePreguntas.recno);
RadioRespuestas.Enabled:=True;
RadioRespuestas.Hint:='Elige’;
TablePreguntas.Next;
StatusBarl.Panels[0].Text:='N2 de pregunta: '
+inttostr(TablePreguntas.recno);
imagenBien.picture.loadfromfile('DRAC.BMP');
StatusBarl.Panels[0].Text:='N2 de pregunta: '
+inttostr(TablePreguntas.recno);

Al pulsar (On Click) en RadioRespuestas:

var
letra:string;

begin

Binicio.Enabled:=true;

if Bsiguiente.enabled=false then

begin
case RadioRespuestas.itemindex of
0: letra:="A";
1: letra:="'B';
2: letra:="'C';
3: letra:="D";
end;

RadioRespuestas.Enabled:=false;
RadioRespuestas.Hint:=";
if letra=TablePreguntasSOL.value then
begin
labelcorrecto.caption:='ICorrecto!, es la
'+TablePreguntasSOL.value;
labelcorrecto.visible:=true;
labelincorrecto.visible:=false;
aciertos:=aciertos+1;
labelaciertos.caption:=inttostr(aciertos);
imagenBien.picture.loadfromfile('DRACBIEN.BMP');
//<---cambio colores--->
If letra='A' THEN R1.font.color:=clblue
else if letra='B' THEN R2.font.color:=clblue
else if letra='C' THEN R3.font.color:=clblue
else if letra='D' THEN R4.font.color:=clblue;
end
else
begin
labelincorrecto.caption:='Incorrecto, la solucién no era la '+
letra+' sino la '+TablePreguntasSOL.value;
labelcorrecto.visible:=false;
labelincorrecto.visible:=true;
imagenBien.picture.loadfromfile('DRACMAL.BMP');
letra:=TablePreguntasSOL.value;

//<---cambio colores--->
If letra='A' THEN R1.font.color:=clred
else if letra='B' THEN R2.font.color:=clred
else if letra='C' THEN R3.font.color:=clred
else if letra='D' THEN R4.font.color:=clred;
end;
DBTextcomen.visible:=true;
labelsiguiente.Caption:='Pulsa siguiente pregunta';
labelsiguiente.visible:=true;
labelelige.visible:=false;
Bsiguiente.enabled:=true;
preguntas:=preguntas+1;
labelpreguntas.caption:=inttostr(preguntas);
media:=round(aciertos*10/preguntas);
labelmedia.caption:=floattostr(media);
progreso.progress:=preguntas;
progreso2.progress:=aciertos;
If letra="A' THEN R1.color:=clwhite
else if letra='B' THEN R2.color:=clwhite
else if letra='C' THEN R3.color:=clwhite
else if letra='D' THEN R4.color:=clwhite;
if (preguntas=TablePreguntas.RecordCount) then //fin de
preguntas
begin
if aciertos=preguntas then Labelsiguiente.Caption:='iiEnhora
buena, has obtenido la maxima puntuacion!! '+
Labelmedia.caption else
Labelsiguiente.Caption:='Fin de preguntas del tema. Has obtenido
un '+ Labelmedia.caption;
MessageDlg(Labelsiguiente.Caption, mtinformation, [mbOk], 0);
Bsiguiente.enabled:=false;
Blnicio.Enabled:=true;
end;
Labeltotal.caption:=inttostr(TablePreguntas.RecordCount);
end;

Al pulsar (On Click) en el botén Blnicio:

TablePreguntas.First;
RadioRespuestas.Enabled:=true;
Bsiguiente.Enabled:=false;

progreso.progress:=0;

progreso2.progress:=0;
progreso.MaxValue:=TablePreguntas.RecordCount;
progreso2.MaxValue:=TablePreguntas.RecordCount;
aciertos:=0;

preguntas:=0;

Labelmedia.Caption:='0";
labelaciertos.Caption:='0";
Labelpreguntas.Caption:='0";
Labelsiguiente.visible:=true;
Labelsiguiente.Caption:='Inicio del tema '+ filtro.text +'. Clic sobre
el circulo de la respuesta correcta...';
RadioRespuestas.itemindex:=-1;
StatusBarl.Panels[0].Text:='N2 de pregunta: '
+inttostr(Tablel.recno);

R1.font.color:=clblack;

R2.font.color:=clblack;

R3.font.color:=clblack;

R4.font.color:=clblack;
DBTextcomen.Visible:=false;
Labelincorrecto.Visible:=false;
Labelcorrecto.Visible:=false;
imagenBien.picture.loadfromfile('DRAC.BMP');
Labelpregunta.caption:='Pregunta:';



Grafico de datos (probado en versiones Delphi 7 a XE7)

Ingredientes:
Crear una tabla:

a. DBF (obsoleto): Delphi 7: Escoge del mend: Tools » Data base desktop con los campos: HOMERE
Nombre (de caracter o texto) y Valor (numérico entero) guardar la tabla de datos con el

Form1.Table2 Hl
I | - | - | * |

YaLOR

nombre: Datos.dbf Luego Afiadir los componentes Table y datasource al formulario y asignar a la table el tablename:

Datos.dbf y al Datasource el dataset: tablel

b. XML: En el formulario principal de Delphi, afiadir los componentes: Maombre o |dentiﬁcacién| Valor [x] |
ClientDataset y un Datasource (Paleta Data Access). Pulsar el botén derecho p|Juan 5
sobre el componente ClientDataset y escoger de Fields editor... New field. con | Andiés _ 5
los campos: Nombre (de caracter o texto) y Valor (numérico entero). Boton oee 3 : 4
derecho sobre el componente ClientDataset y escoger Create dataset - Saveto | P -

my base xml table...datos.xml

Formulario: En la paleta DataControls, afiadir al formulario un Dbgrid, y en su propiedad datasource: poner datasourcel.

Anadir el grafico:

e Delphi 7: De la paleta Datacontrols, afiadir un componente: DBChart.

e Delphi XE7: De la paleta: TeeChartLit, afiadir un TDBChart

Pulsar doble clic y en la solapa series poner como en la figura.
En la solapa Chart, Aiadir la seriel (Add) tipo Bar como en figura.
En la pestafia Datasource: Seleccionar Dataset y elegir el Dataset de nuestra tabla de datos.

Chart | Series |
Series |General| Az | Titles | Legendl Panel | Pagmgl Wfalle | 30

JJ;I Series Titls
nG o

Add.

TeeChart Gallery
Standard | Functions |

Line Bar Horiz. Bar )

e N3

Afadir un botén para calcular

Editing DBChart1

Chart  Series ;
iSeries‘I _:j i‘IL‘ Bar 5
Formati General! Marks Data Source i
!Dataset Li
Diatazet: !Table‘l L!
Labels: [NOMBRE |
H i| Li
Bar [VALOR =]

Anadir un botdn al formulario para calcular la suma de valores. Al pulsar se genera el evento:

Coccion:

procedure TForml.calculalClick(Sender: TObject);
var
suma, xmax,xmin,media:single;
antes:single;
begin
suma:=0;
dessuma:=0;
varsuma:=0;
tablel.First;
antes:=tablelvalor.value;
while not tablel.eof do
begin
xmax:=max(tablelvalor.value,antes);
suma:=suma+table2valor.value;
tablel.Next;
antes:=tablelvalor.value;
end;

if Tablel.RecordCount<l then showmessage('Introduzca
valores en la tabla para calcular') else
begin
media:=suma/Tablel.RecordCount;
tablel.refresh;
tablel.Edit;
tablel.First;
tablel.DisableControls; // -> ojo
while not tablel.eof do
begin
table2.edit;
table2porciento.Value:=roundto((table2valor.value/sum
a)*100,-2);
table2.Next;
end;

e Ejercicio propuestol: Afadir un campo calculado a la tabla Decil y cuartil . En el evento: OnCalcFields de la tabla

escribir: TablelDecil.value:=tablelporciento.Value/10;

e TablelCuartil.value:=tablelporciento.Value/25;

e Ejercicio propuesto2: 2: Afiadir un componente WebBrowser: En el Form1.0Oncreate:
dire:=ExtractFilePath(ParamStr(0)); WebBrowserl.Navigate('file://'+dire+'estadistica.htm’');
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PROGRAMA DE RECETAS DE COCINA PARA DELPHI. (Uso de Datos y los TabsSheets)

Prepara una carpeta llamada Recetas.

e Para DBF-MDB: Crear un archivo DBF (Data Base File) o MDB (Access) con la estructura de la imagen, con un indice
indexado por el campo Titulo y guarda la tabla con el nombre: RECETAS en la carpeta Recetas.

e Para XML:
Afade el componente
ClientDataset y con el boton

derecho agrega los campos de
la imagen.

Crea el Dataset y gurarda la
Database con el nombre:
RECETAS.XML en la carpeta
Recetas

Crea los indices el la propiedad:

Indexdef

Recetas.DEF T able properties:
Field Narme Type| Size | Dec |Indexes |
1 M 3 o Define... | |
2 C 15
3| TITULD C a0 TITULD
4| DIFICULTAD C 14
5|TIEMPO_COC M 3 ]
EB|ITIEMPO _PRE M 3 ]
7| INGREDIEMT I
8| PREFPARAL I

e Afadir un nuevo formulario sélo para datos (Mddulo de datos) del menu: New — Form — Datamodule. Llamado DM
e Afiadir al datamodule DM, los componetes: Tablel (o ClientDataset con el nombre Tablel) y el

componete Datasourcel cambiando su propiedad |Dataset: Tablel
e Asignar a la tablel la propiedad (TableName o FileName) nombre del

archivo Recetasdbf o recetas.xml segun la base de datos.
e En modo DBF: afadir a la Tablel todos los campos (botdn derecho)
e En el formulario principal (File — Project manajer — Form1) asignar la

propiedad [Name: Recetal

e Modificar el formulario como en la figura inferior:

En él afiadir:

- Una Toolbar y una Statusbar (Win32)

- Un panel alineado a la derecha con un
Splitter (Additional) a su izquierda.

- Un Pagecontrol =1 (win32) ala
izquierda alineado al cliente.
Sobre el Pagecontroll, pulsar el botén
derecho del mouse y escoger: New
page y crear 9 solapas (TabSheets).
Asignar a la propiedad caption de cada
TabSheet los nombres que se
muestran:
Entrantes, Vegetales, Pastas, carnes,
etc...
En cada pestana, afladir los
componentes: 3 dbedits, 1
DBcombobox y 2 dbmemos como en la
figura izquierda.
En el panel derecho afiadir un
componente DBgrid Align al cliente.

dm.Table1 x|
e
MERD
%51 dm -0 ITiCo
DIFICULTAD
— TIEMPO_COC
TIEMPO_PRE
S~ INGREDIENT
. PREFARAL
ol TIFD
o] Ofi - Recetas =10l x|
[P | ] | = | -l e | 3 dh Muewa | = Barar ‘ Irnprimir |
Entrantes |Vegetalas| Pastasl Eamesl Pescadosl Marlscosl Vanosl Postrasl Ligtado comp\etol . _.—JLiSladU
Titulo: DBEdit19 Tiempa dz preparacion (min. ) |DEEdit21
Dificultad: [DBComboBoeT v | Tiempo d= coccin (mink - |DBEi20
Ingredientes g" /
DBMemo13 =
Paleta Datacontrols:
- DBmemo
- DBGrid
- DBEdit
DBCombobox
x L
] _'lJ |.
Elaboracidn:
DBMemol4 =

L«

(c) Ofimega Made by Edu

Asignar las propiedades para cada componente DB, el Datasource: Datasourcel y el Datafiled el campo que le

corresponda.

En la barra de herramientas toolbar con el botén derecho crear 3 nuevos botones y afiadir un DBNavigator.

‘ L]

| [ hueva | [= Borar |

{Eniiantes | vegetalos | Pastas | Cames | Pescados | Maisoos | arios | Fosties | Listada completa |

Tiempo de preparacion (mink [ 10
| 10

Tituo:  [Berenjenas rebozadas

Dificultact ‘Fém\ j Tiempo de coccisn [min |

Ingredientes

= Ofi - Recetas Q@E‘ I Ofi - Recetas g@gl
| \ [ huevs | [= Bonar | | Impimi

L]

Listado
Berenienas isbozadas A

Buscar.

Coneio sl sloi

Entiartes | Vegeteles | Pastas | Cames | Pescados | Maiiscos | Varios | Postres

Listado
M[Bererienas rebozadss A
Coneio al i

&

Ensalada catalna Titulo [Tipa

| Dificuitad

Tiowpo Coo. [T || el cataans

Lenguado ala Meunigre rebozardas

Vegstales Faci

Bershjenas
Huevos

Elaboracidn

Macarmones a la Carbonar. Corejo al alioli Cames Facil

Meillones al vapor Ensalada catalana
Lenguada a s Meurniére

Macarrones ala Cabonaria

Entrantes Facil
Difeil

Pastas Facil

Pollo con almendras Pescados
Profiterales

Sopa de pusros

I O O Y Y .4

Msillones al vapor Mariscos Faci
Meda
Meda

Entrantes Facil

Pollo con almendras Carnes
Profiterales

Sopa de puenios

Postres

Batir los huevos

Cortar |a herenjenas en rodajas
Untar a5 rodajas de berenjena
Freir en sartén

<

5 Lenguado a la Meunizre
Macaranes  la Cabanar.
2 Meiilones 3 vapar

Pollo con simendias

7 Frofteroles

» Sopa de puenos

(c) Ofimega Made by Edu Recetas: 3

(c) OFimega Made by Edu Recetas: 9




CODIGO FUENTE del programa de recetas:

var

Receta: TReceta; //->nombre de la ventana o formulario

var filtro: string; //-> variable de texto

procedure TReceta.PageControlChange(Sender: TObject);

procedure TReceta.TabSheet9Enter(Sender..
begin

contar('recetas');
end;

begin

DM.tablel.filtered:=true;
Editl.text:="";
DM.Tablel.CancelRange;

if PageControll.activepage =tabsheetl
Filtro:='"'"Entrantes''';;
if PageControll.activepage =tabsheet2
Filtro:='"''Vegetales''';

if PageControll.activepage =tabsheet3
Filtro:='""Carnes''"';

if PageControll.activepage =tabsheet4
Filtro:='"''Pescados''';

if PageControll.activepage =tabsheet5
Filtro:='"'"'Mariscos''';

if PageControll.activepage =tabsheet6
if PageControll.activepage =tabsheet7
if PageControll.activepage =tabsheet8
if PageControll.activepage =tabsheet9
Begin

DM.tablel.filtered:=False;
Filtro:="'""'Completo''';

end;
DM.tablel.filter:="'Tipo="+Filtro;
Panellistado.caption:="Listado '+filtro;
contar('Recetas’');

end;

then
then
then
then
then
Filtro

Filtro
Filtro

then
then
then
then

begin
contar('Recetas');
end;

procedure TReceta.PageControllEnter(Sender..

procedure TReceta.contar(Sender:string);
begin
Receta.StatusBarl.panels[1].text:=sender+
' + inttostr(dm.Tablel.RecordCount);

end;

:=""'Varios''';
:="""Postres''"’;
:="""Pastas'"'"’;

procedure TReceta.EditlChange(Sender..

Var

Campobusca: string;
begin

Campobusca := 'TITULO';

DM.tablel.SetRangeStart;
DM.Tablel.FieldByName(Campobusca).AsString:=Editl.Text;
DM.Tablel.ApplyRange;

end;

procedure contar(Sender: TObject);
begin

Receta.StatusBarl.panels[1].text:=inttostr(dm.Tablel.RecordCount);

end;

procedure TReceta.SpeedButton1Click(Sender: TObject);
begin

if MessageDlg('Nueva receta?',mtConfirmation, [mbYes, mbNo], @)= id_Yes then

begin

DM.tablel.insert;

if PageControll.activepage
if PageControll.activepage
if PageControll.activepage
if PageControll.activepage
if PageControll.activepage
if PageControll.activepage
if PageControll.activepage
if PageControll.activepage
DM.TablelTITULO.value:="";
end;

end;

=tabsheetl
=tabsheet2
=tabsheet3
=tabsheet4
=tabsheet5
=tabsheet6
=tabsheet?7
=tabsheet8

then
then
then
then
then
then
then
then

DM.
DM.Tableltipo
DM.Tableltipo.
DM.Tableltipo.
DM.Tableltipo.
DM.Tableltipo.
DM.Tableltipo.
DM.Tableltipo.

procedure TReceta.SpeedButton2Click(Sender: TObject);
begin

TablelTIPO.value:
.value:
value:
value:
value:
value:
value:
value:

'Entrantes’;
'Vegetales';
'Carnes’;
'Pescados’;
'Mariscos’;
'Varios';
'Postres’;
'Pastas’;

if MessageDlg('Borrar receta?',mtConfirmation, [mbYes, mbNo], ©)= id_Yes then DM.tablel.delete;

end;

Impresién:

codigo:  if PrintDialogl.execute then print;

Guarda el proyecto con el nombre: Recetas (también la ventana/unidad recetasl y la ventana/datamodule dm)

Imprimir el formulario (ventana) : Afladir componente: Printdialog de la paleta Dialogs y en el botén imprimir escribir el

Imprimir informe de datos: Utilizar el disefiador de informes Rave report o Qreport explicados en el siguiente tema.
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INFORMES de impresién de datos (reports)

a) Crear un informe con RaveReports FivD ataS etConnection]
== Properties  Ewents |
HDataSet | dm.Tablel

e Afladir al programa de rectas, los componetes:
RVDataSetConnection y RvProject

Con las propiedades de la figura...-> RwFroject! ThvProject [
e En el botén para imprimir, afiadir: Froperties | Eventsl
DM.TABLEl.FefI’ESh,‘ DLLFile
RvProjectl.execute; B Engine
e Pulsa doble clic sobre el objeto RvProject para abrir el [rAvE] LoadDesigner |Falze
programa generador de informes: Rave Report. Hame RvProject!
FrojectFile Iphid\edud\Recetas\Project]_rav |

Pulsa el botdn: New data Object, escoge: Direct data View D -
N ) . ata Connections E

Puedes afiadir las regiones, bandas y componentes Datatext de la figura, y que se Data Object Type

encuentran en la paleta: Report.

Recuerda especificar la propiedad Datafield a cada DataText.

Data Lookup Security Contraller
@ Database Connection

- . . . I Direct Data Wiew
Guarda al finalizar el informe con el nombre: Projectl.rav en la misma carpeta donde

tienes tu proyecto de Delphi. {0 Oriver Data View
Sinple Security Contraller

b) Crear un Informe con FastReport .
Incorporado en la version XE7. Tan sencillo como soltar en el formulario el componente fxreport1 y un DataReport.
Pulsar doble clic encima del Fxreport1 para diseiar el informe. Elegir del menu: Report — Data para escoger el dataset de

datos.

DataText2 Datalext component Drawing I Bar Code | Standard ~ Report I Zoorm I Colars I Litess I Fills: I Fonts I Alignment FaveProject
Anchor [Top £ Lett] <85 Feport Librar

W = | e P i
Color I $FFEFFFFS % ‘ E Sk EEE 7] % 5". %* 4% Global Page Catalog
DataField TITULD ) L

- - ;l -4 D ata View Dictionary
Data¥iew [ ataview] ;" g M D ataiew]
- araview

DevLacked Tame | ¥ Dataliew Region: Data'iew TitleBand (BERDrok 1PC) | . [ DataViewINU
DisplayOn doParent I - \ @ ata! few
Font Arial, 12 ! R t d . | B Dataiew1TIT
Fantlustify piLeft : ecela de CcocCina | i - B8 Dataiew1DIF]
Forthdirrar 5 | - Dataviewl TIE
i 5 | ¥ OitqviewiRegion DataviewiBand ___—(BCr0iah 1PC) 188 Dataiew! TIE
LockupDaiaVien NUMERS, TITULO DIFICULF&T TIEMPO COC LT g Ea‘aifewlg*ﬁi
LookupD isplay [ @ Daterviewtgesion: Data'view! DataBand (Master 170} | ;B Dataiew
LockupField | {NUMERD gTITULD B [DIFICUCTAD | [JEMPO_COG ' - {38 Dataliew! TIP
Lookuplalid
birrar
M armne Datal extd

Truco: Cambiar el formulario de vista previa a espafiol: Busca en la carpeta: Rave5\Lib los
formularios: E&J
RPFormPreview.FRM y RPFormSetup.FRM y abrelos desde Delphi. ¥
Opcional: Puedes afiadir también un componente: RVSystem al formulario de recetas y que enlazara con la
propiedad Engine del objeto RaveReport. Este componente te permitira especificar los parametros de impresion
y vista previa deseados.

c) Crear un Informe con QReport.

El paquete Qreport (quickreport). Se incorporé en la version Delphi 7: DCLQRT70.BPL

En otras versiones: Descargar de http.//www.quickreport.co.uk/

Crea un formulario nuevo (New form) y sueltas en el el componente de la paleta Qreport: QuickRep
Dentro de este, pon dos QRBand y cambia el tipo de banda a: Page header y Detail respectivamente.
Suelta en estas bandas los objetos: QRLabel y QrDBText.

Para ejcutarlo escribe el cddigo:

if(Application.MessageBox('é Imprimir esta receta?’, 'Imprimir registro - Print', MB_YESNO) = IDYES)
then Informe.QuickReport1.Print; //-> 6 Informe.QuickReportl.Preview //-> para vista previa

Truco: Para cambiar la ventana a espafiol, abre el formulario: QRPrev.DFM en la carpeta: DELPHI\LIB



LENGUAJE SQL EN DELPHI
Manipulacion de Datos mediante lenguaje SQL: SELECT, INSERT, UPDATE, DELETE

SELECT: Extrae datos de una o mas tablas indicando los campos (o columnas) separados por comas.
El asterisco (*) sustituye a todos los campos

Ejemplo:
SELECT * FROM CLIENTES
WHERE CIUDAD = "MEXICO" AND ESTADO =

Sintaxis (férmula):
SELECT {Campol AS NombreCampol,
Campo2, ...CampoN }

FROM {Tabla/Vista}

[ WHERE {Condicidn} ]

[ LEFT JOIN OtraTabla ]

"DE"

SELECT
FACTURAS.FACNO,
FACTURAS .NOMBRECLIENTE,
FACTURAS . CIUDAD
ARTI.NUMARTI,
ARTI.DESCRIPCION,
ARTI.PRECIO,
FROM FACTURAS LEFT JOIN ARTI ON FACTURAS.FACNO =
ARTI.FACNO
WHERE FACTURA.FACNO =

FROM: Especifica la tabla o tablas (separadas por comas)
de la cual se extraen los datos.
JOIN: Junta varias tablas a través del campo indice, que

existe en las dos tablas.
1

WHERE: Filtra los registros que cumplan el criterio de
condicion. Estos pueden utilizar los operdadores de comparacién ( =, <, >...) o predicados adicionales IN, ANY, ALL, EXISTS.

SELECT * FROM PARTS WHERE PART_NO > 543

ORDER BY: La clausula Order by especifica el érden de exctraccion.

SELECT * FROM PARTS

ORDER BY PART_NAME ASC

GROUP BY: Especifica cdmo se agrupan las filas o registros.

UNION: Combina el resultado de dos o mas SELECTS para convertirla en una sola tabla. (JOIN)

INSERT: Afiade un registro a la tabla APPEND Inserta el registro al final de la tabla:

Insert permite afadir datos al mismo tiempo mediante
dos métodos:

1.- Aiade una fila (registro) a la tabla asignando
valores a dos columnas:

INSERT INTO FACTURAS
( FACNO, NOMBRECLIENTE, CIUDAD, ESTADO )
VALUES ( 99, 'Winston Churchill', 'Londres',
Mera Capital' )

'La

2.- Especifica valores a insertar mediante el estado SELECT:
este INSERT se combina con otro SELECT para copiar los

renglones de la factura nimero dos y ponerlos en la factura

numero 99.

INSERT INTO FACTURARENGLON

(FACNO, NOMBRECLIENTE, CIUDAD, ESTADO)

SELECT 99, ITEMNO, DESCRIPTION, PRECIO_USD FROM
FACTURARENGLON WHERE FACNO = 2

UPDATE: Modifica datos de la tabla. Ej: UPDATE GOODS SET CITY = 'SANTA CRUZ' WHERE GOODS.CITY ='SCOTTS VALLEY'
DELETE: Borra datos de la tabla. Ej: DELETE FROM GOODS WHERE PART_NO = 'AA0093'

Funciones agregadas a SQL

» SUM(), Total

» AVG(), Promedio de valores no nulos

»  MIN(), minimo valor

»  MAX(), maximo valor

»  COUNT(), cuenta el n2 de valores segun un criterio.

SUM( Field * 10 )
SUM( Field ) * 10
SUM( Fieldl + Field2 )

» De fecha: Pemite extraer de una fecha: YEAR, MONTH, DAY, HOUR, MINUTE y SECOND

Substitucion de variables:

En Delphi, cuando se afiade una palabra precedida por un signo de dos puntos (:), la palabra es automaticamente
convertida en un pardmetro, el cual es agregado a la propiedad: Params

SELECT * FROM "CLIENTS.DBF" CLIENTES WHERE Last_Name LIKE :Apellido
LIKE: devuelve todos los registros que se parezcan a la cadena. La linea que asigna el parametro afiade un signo de

porcentaje (%) al final:

gryClientes.ParamByName('Apellido').AsString := digConsulta.edtApellido.Text+'%';
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Ejercicio de consulta de datos con SOL

Crea una aplicacidn nueva en Delphi. File » New » Aplication.
De la pestaiia Data Access y DBE, inserta los componentes: Query y DataSource que representan las partes "no
visuales" del acceso a base de datos.
Ahora, vaya al TQuery y cambie la propiedad "Databasename" a Dbdemos, que es un alias local que apunta al
directorio de Demos de Delphi.
Selecciona el Datasource. En la propiedad Dataset, selecciona: Query1l
Selecciona el Queryl, haz doble-click en su propiedad: SQL Escribe lo siguiente:

SELECT * from animals where upper(NAME) like order by NAME
Obseva que :nombre es un pardmetro. En la propiedad Params pulsa doble clic y pon su Datatype a string
A continuacidn, vaya a la propiedad "RequestLive" de su Query y pdngala en "True". Esto es importante porque SQL
siempre devuelve resultados "Read-Only", o "muertos" (dead) a menos que especifiquemos que nuestro query debe
ser "vivo" (live)
Haz doble-click en el queryl. A continuacidn veras una ventana vacia. Haz click con el boton derecho del mouse y
selecciona: "Add Fields". Nos aparece la lista de las "columnas" (campos) disponibles. Asi que simplemente presiona
{Enter} para aceptar el afiadir todos los campos.

e “Arrastra" desde la lista de campos del queryl, hasta el formulario. Cuando "sueltes" cada campo, Delphi creara un

Completamos el formulario con los objetos que se muestran en la begin
figura. queryl.active:=false;
En la propiedad Params del Query 1 le afiadimos el valor: % para Queryl.Params[@].Value :=
UpperCase(editl.Text)+'%";
que por defecto aparezcan todos. queryl.active:=true;
. : ;
e En el botdn Filtrar, afiadimos el cddigo: end;

m x| . En el botdn Todos, escribimos:

componente TLabel y un DbEdit, listos para recibir los datos adecuados. Conecta todos los DBedits con la propiedad
Datasource al Datasourcel. A asignar su datafield al campo correspondiente.

Filkro Modo:
% Par nombre f* Consulta
= Por area TDdDSl ™ Edicidn
Angel Fish
Filtrarl g
I =+ T% Afadir Brarrar |
. EZ

MARME
Angel Fizh

|

IEumputer Aquariirms

Para ver los datos vamos a abrir el query1 (active = true).

queryl.active:=false;

@ @| * ¥ Queryl.Params[@].Value := '%"';

queryl.active:=true;

0 - nombre

- Notas:
Object Inspector =l ] i
P Upper en el SQL y Uppercase en el procedure, convierten ambos a mayusculas para

IQuer_l,l'l.F'arams[D] TParam ;I

que no haya distincidn entre mayusculas y mintsculas.

Froperties | Events | D El botén de radio: Edicidn, cambia la propiedad del queryl: RequestLive a true.
DataType ftString » Los botones afiadir y borrar afiadir el cédigo: Queryl.Append; y Queryl.Delete;
M ame nombre respectivamente.

MumericScale |0 Para consultar por area, afiadir otro query2 con este campo como parametro en el
ParamType | ptUnknown SQL. Con el mismo datasource, cambiar de uno a otro, segiin se active uno u otro
Precision 0 botén de radio.
Size 1]

SE %

Type |5lrim_:|




Programa facturacion Pasos basicos.

1. Crear las tablas:

2. Crear un nuevo form (New PForm) Datamodulel, con el nombre: DM.
3. Insertar el el DM las tablas para Facturas y articulos: Table_facturas y table_articulos, asignarles los indexnames creados
y afnadir dos datasources: Datasource_facturas y Datasource_articulos.

4. Aiadir: All fileds al la table facturas y articulos.

}dm

5. Seleccionar todos los

=101 Fyun_pact

campos de tablefacturas y
soltar sobre el form
principal llamado:
Facturacion

i+
T

6. Crear un DBgrid con Align Tahle facturas
al bottom y asignarle la B
datasource de articulos.

Luego afiadir todos los

i+
T

DataSource_facturD ataSource_articulos

§|DBEdit3

Table_articulos

- [DBEdi
' NUM_CLIENT
: |DEEdit2

SSUFMD

‘FECH#,_FACT
: |DEEdits

campos al dBGrid de

_| Field Link Designer

i | Table_articuloz TTable
articulos. _
PTDDETtIES | Ewents I .-'f-.gailable Ihdexes INUM_F.":".ET j
7. Para relacionar Filtered False
facturas con articulos FiterOptiars  |[] Dietail Fields Master Fields
debemos volver al IndexDefsz [TIndexDefz] MUR_CLIENT
DMy elegir en IndiesFieldham : Add FECHA FaCT
mastersource de IndexFiles [TIndexFilez) [, b
articulos el IndexM anme BASE IMPO ;l
Datasource de b asterFields =]
facturas. Luego, en tazterSource |DataSource_| Joined Fields
el MasterFields, M arne Table_articulos MUM_FALCT -» MUM_FACT Delete
relacionar los campos Objectyiew  |False —
NUM_Fact de cada Readlnly False Clear
tabla. Activar ambas SessionM ame —
tablas (active=true) StoreDefs [False
para ver el TableMame  [Articulos. DBF Qg Cancel Help
funcionamiento. TableType tCr efavlt

8. Anadir en el form principal un DBNavigator para las facturas.

9. Crear el campos calculados:

Asignar a un campo existente un calculado: Para el importe: En la table_articulos poner en el evento: onCalcfileds:
Table_articulosimporte.Value:=Table_articuloscant.Value*Table_articulosprecio.Value;
Luego poner en el campo Importe su propiedad: FieldKind: fkCalculated

Cab_ARTI

— Mew Field X
Crear un campo calculado nuevo: COD_FABRIC =
llamado PVP (como referencia): EEEI%HPE'D Field propertie
En la table_articulos anadir un New PRECIO Harme: PP Camponent: |Tab|E_arlicu|nsWP
field... del tipo: Flota y calculado. IMPORTE

HUM_FACT | Tupe: Floaf x| Size 1]

| =l s |
Afadir al evento: On CalcFileds: '

—Field type
" Data {* Calculated {7 Lookup

Table_articulosPVP.Value:=Table_articulosprecio.Value*(1+Table_facturasiva.Value/100);

10. Crear un botdn: Calcular para calcular la base imponible.
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Procedure TForm1.CalcularlClick(Sender: TObject);
var
baseimpo:double; //-> variable temporal de baseimponible
num_rec:pointer; //-> puntero de registro
begin
with dm do
begin
table_articulos.disablecontrols; //-> evita cambiar registro el usuario
num_rec:=table_articulos.GetBookmark; //-> coge num de registro
table_articulos.first; //->sitda el puntero de registros al principio de la tabla
while not table_articulos.eof do {mientras no llege al End Of File...(final de la tabla) haz el bucle}

begin

baseimpo := baseimpo + table_articulosimporte.AsFloat; {suma la cantidad anterior }
table_articulos.next; {salta al siguiente campo}

end; {repite el bucle}

table_articulos.enablecontrols;
table_facturas.Edit;
Table_facturasBASE_IMPO.Value:=baseimpo;

Table_facturasIMP_IVA.Value:=baseimpo*table_facturasiva.value/100; //->importe del IVA
Table_facturasTOTAL.Value:=baseimpo*(1l+table_facturasiva.value/100); //->Total factura
table_facturas.post;

table_articulos.GotoBookmark(num_rec); //-> vuelve al registro que estaba

end;

end;

Calculo automatico: Por ultimo, para calcular automatico, afiadir al evento del la table_articulos: AfterPost:
Table_articulosAfterPost: Form1. CalcularlClick(nil); //-> llama al procedure sin sender

Mejoras:
¢ Anadir el componente DBCombobox al % de IVA con los items: 0,7,12,16. En el campo IVA del DataModule
cambiar su DefaultExpression = 16.
e Para autoincrementar el nimero de factura: Como no existe del tipo Autonumerico en Dbase, no vale con cambiar
el Autogeneratevalue a Autolnc sino escribir el cédigo:
Var publica en el Data module: Numero:single:

Table_facturasBeforelnsert: Table_facturas.last;
Numero:=Table_facturasNUM_FACT .value;
Table_facturasAfterinsert: Table_facturasNUM_FACT.value:=numero+1,;

Control de registros de una base de datos.Navegator manual.

Afadir al formulario los botones: Adelante , atras primero Ultimo, afiadir y borrar. @E E @JE_

procedure TForml.primeroClick(Sender: TObject);

begin

with tablel do

begin

if sender=primero then first

else if sender=anterior then prior
else if sender=siguiente then next
else if sender=ultimo then last
else if sender=nueva then
begin
if(Application.MessageBox('¢Crear nuevo registro?', 'Agregar registro', MB_YESNO) = IDYES) then
begin
tablel.append; //-> Inserta
tablel.Post; //-> Guarda
end;
end
else if sender=borrar then
begin
if(Application.MessageBox('¢Confirma que desea eliminar este registro?', 'Confirmar eliminacién de registro',
MB_YESNO) = IDYES) then delete;
end;
Tablel.Refresh;
StatusBarl.panels[1].text:="'Total registros: '+ inttostr(Tablel.RecordCount);
end; Table_facturasFECHA_FACT.value:=date;



Nivel Avanzado. Control de Base de datos. Relacionar dos tablas (facturacién)

Como crear una consulta (Query) SOL para relacionar dos tablas por un campo en comun:

Pasos previos para el ejercicio:

Véase lenguaje SQL
en este manual

e  Crear un directorio C:\FACTU ( o similar)
e  Utilizar la herramienta Data Base Desktop para crear previamente las tablas de bases de datos: FACTURA.DBF y
ARTI.DBF cuyo campos minimos sean:
- - ARTI."REFER",
FACTURA. "NUM_FACT", ARTI."DESCRIPCIO",
FACTURA. "FECHA_FAC", ARTI."CANT"
FACTURA. "COD_CLIENT", ARTL. "DESC":
FACTURA."IVA", ARTI."PRECIO",
ARTI."NUM_FACT",
Esta accidn es automatica con File - New - DataBase Form.
e Es conveniente usar un data module para las Datasources y las querys.
e  Relacionamos las facturas con sus articulos por el campo num_fact comun a los dos.

Recordar que: QuerylINUM_FACT: TFloatField;

Ejercicio. Facturacion Queryl | fquery2
I.ﬂi?"- Form2 Name:Tablel [_ 0]
R |
B HE T e =l
DI I D A e e e e e e e |
NUM_FACT FECHA_FAC COD_CUENT a \
1 123/11/94 | 15 | »|DataSource2
! ! ! DataSourcel DataSet: Query2
DataSet: Tablel
|REFER  |DESCRIPCID [cant  Joesc  |PRECID  [IMPOR" ]
b 1000 0 1000
FROG-FAC FORMACION DE PROG. FACTURACIOMVEMNTAS 100 1] 100
FORMATOS DE IMPRESION (3 HORAS) 1 0 18000 i
DFGTHDFG OFFIGHFODIFHORIFG 10 16 1000 £
AMPLIACION PROGRAMA CAMEID MONEDA 0 1] 1] -
4| I 3
. Basze Imponible - Importe VA 0 Total Factwia - - - - - o o o i,
| 10 15 ———JCampos [t
Cliiiiiiiiiiiiiiiiiiiiiiiiiiiicis|Caleulados fseeses s

es necesario crear un botdn para afiadir articulo, que utiliza la table 2.

true. Por eso trabajaremos directamente sobre las tablas en pagina siguiente.

Nota: En esta aplicacion es posible afadir y modificar datos en factura, pero no en articulos. Para ello

Las consultas SQL no permiten modificaciones en la tabla relacionada si no tenemos RequestLive a

On Form create:
Queryl.0pen;
Query2.0pen;

Lineas SOL para Ia Ouerv1. . Lineas SOL para |a Ouervz:

Select Select
FACTURA."NUM_FACT", ARTI."REFER",
FACTURA. "NUM_PRES", ARTI."DESCRIPCIO",
FACTURA."FECHA_FAC", ARTI."CANT",
FACTURA."COD_CLIENT", ARTI."DESC",
FACTURA. "BASE_IMPON", ARTI."PRECIO",
FACTURA."IVA", ARTI."IMPORTE",
FACTURA. "TOT_FACT" ARTI."PVP"
From "C:\FACTU\FACTURA.DBF" From "C:\FACTU\ARTI.DBF"
As FACTURA Where "C:\PRG\FACTU\ARTI.DBF"."NUM_FACT"

As ARTI

=:"NUM_FACT"
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Método 2: En esta otra ventana se utilizan directamente tres tablas: Facturas — Articulos y Clientes.

Botones de nuevo y borrar articulos:
procedure TFormfactu.nuevoClick -> table2.insert;
procedure TFormfactu.borraartClick -> table2.delete;

Tablel: Facturas
Table2: Articulos
Table3:Clientes
Table4:Empresa

Ix]

Win Factu Afadir factura
Datos  Consultas Heramientas / Ayuda

FaCthaSlEnnsultas]thilides] = I ng T T T

| | (3 | (3] | | 7| & Imprimi. | [ Muevoatt.| N3 Bora art Ealcylar... E 'ﬁ'@ E.Iientes E
T L
Mir. factura  Cédigo cliente Nombre: |EI'3' \ el
| 1o .
Fecha factura 2 WA Eura Llzeisi \ ]
B G 0 Cod Posta: 143340 popyocigy [SALOY
| ITroodenma j
| Cadigo | D ezcripcidn | Cant. | Precio | IApDrte | PP | My |
k1 descrip 1-1 3 100 _
1 deszcrip 1-2 4 100
1 dezcnp 1-3 10 1000 p
< | LH
Baze Imponible: & A, Irnparte WA Tatal Factura: Tatal Euros
Lahelhaseginn?pu W Labelimpiva Laheltotal Labeleuros
Win Factu. [c] Ofimega. Salou Botdn calcular

Para realizar la unién necesitamos un campo indice comudn

Gieldinklieznne (NUM_FACT) para las dos tablas, y en la tabla de articulos, la
Ayalable Indexes  [NUM_FACT ~] propie_dad master fields (campo indice maestro) se realiza la unién
de la figura.
Detail Fields

MU _FACT

Pulsar el botén Add y en Joined Fields (campos de unién)
aparecera:

FECHA_FAC
COD_CLIENT

NUM_FACT->NUM_FACT
BASE_IMPOM B B

) ) Procedure para afiadir una nueva factura:
Juined Fields Antes De estos procedures crear la

Variable numero:DOUBLE (del tipo flotante)
12 saber cudl es la ultima factura

procedure TFormfactu.TablelBeforelInsert

begin

(]9 | Cancel | Help | tablel.last;
numero:=tablelnum_fact.value;
end;

Cémo borrar la ultima factura
procedure TFormfactu.EliminarClick
begin
tablel.last;
numero:=tablelnum_fact.value;
if MessageDlg('¢Eliminar la factura ' + floattostr(numero)+
'?', mtInformation, [mbYes, mbNo], @) = mrYes
then tablel.delete;

22 sumar 1 al ndmero de la ultima factura y
ponérselo a la nueva, también preparar la fecha
de la factura con el dia de hoy:

procedure TFormfactu.TablelAfterInsert
begin

tablelnum_fact.value:=numero+1;
tablelfecha_fac.value:=date;

end;
tableliva.value:=16;
estado.caption:="Ahadida la factura num. ' +
floattostr(numero);
procedure TFormfactu.TablelAfterDelete; end;
begin

ShowMessage('Eliminada la factura num. +
floattostr(numero));

end;




Ejercicio Facturaciéon. Cémo crear un campo calculado para el IMPORTE:

Supongamos que tenemos una tabla cuya Table Name sea Articulos.dbf y que posee entre otro el campo CANT (cantidad) y
el campo PRECIO:

»

»

-

Pulsa doble clic encima de la tabla para activar el Fields Editor.

Pulsa el botdn derecho encima y elige afadir campos (coge todos). De esta manera se declaran en la unidad PAS todos los
campos y sus tipos.

A continuacion elige New Field. Nuevo campo cuyo nombre sera IMPORT, del tipo FLOAT y CALCULATED. Termina con OK.
Pulsa doble clic en el evento ONCALCFIELDS de la tabla. Debemos introducir una férmula para el campo.

Presta atencién al nombre que tiene los campos en el apartado TYPE de la unidad PAS y escribe el valor:
Table2IMPORT.VALUE:=Table2CANT.VALUE*Table2PRECIO.VALUE;

Para probar su funcionamiento, puedes crear 3 componentes DBEDIT para la cantidad, precio e importe. Recuerda poner
en la propiedad Paswordchart #0 para obligar a que sea un dato numeérico.

También es posible crear campos calculados uniendo campos de texto. Ejemplo:
CustomersCityStateZip.Value := CustomersCity.Value + ', ' + CustomersState.Value +'' + CustomersZip.Value;

Campo calculado importe (En la tabla 2 On calcfields)

procedure TFormfactu.Table2CalcFields(DataSet: TDataSet);
begin
table2importe.value:=table2cant.value*table2precio.value;
table2pvp.value:= table2importe.value*(1+tableliva.value/100);
end;

Como calcular la base imponible: La base imponible no es un campo calculado, pues es el resultado de la suma de varios

campos de varios registros mientras un campo calculado se obtiene de operar con campos de un mismo registro.

Método 1. Base imponible (suma de varios registros) como consulta SOL

Para ello se debe crear una consulta SQL e incluir las siguientes lineas de comando Strings. (Este método no es
aconsejado en este ejercicio pues las consultas SQL no permiten modificaciones sin RequestLive a true)

SELECT BASE_IMPON FROM FACTURAS
SUM(IMPORTE) FROM ARTICULOS WHERE NUM_FACT=:NUMERO

Método 2: Base imponible con un bucle While que sume consecutivamente y uno a uno cada registro y lo almacene

en una variable numérica.

Como este método es mas lento (pero mas flexible) es aconsejable crear un botdn llamado "Calcular" cuyo
procedimiento al hacer clic sea el siguiente.

La visualizacion de la base imponible debe ser en un componente Label no Edit pues es mas facil y ademas no debe ser

modificable.

procedure TFormfactu.CalcularClick(Sender: TObject);

var

baseimpo: Real; {crea la variable numérica real donde se almacenard el resultado de la suma}
impiva: Real;

begin

baseimpo:=0.0;

impiva:=0.0;

table2.disablecontrols;

table2.first; {situa el puntero de registros al principio de la tabla}

table2.enablecontrols;
impiva:=baseimpo*tableliva.value;
labelbaseimpo.Caption :=Floattostr(baseimpo);
end;

while not table2.eof do {mientras no llege al End Of File...(final de la tabla) haz el bucle}
begin
baseimpo := baseimpo + table2importe.AsFloat; {suma la cantidad anterior mds la de este campo}
table2.next; {salta al siguiente campo}

end; {repite el bucle}
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Ficha Listado de facturas. Crear un filtro entre dos fechas.
[ ] [EH==7 |_|-l' |_|-I' E
Facturas Consultas | thiliclau:lesl | | + “| | + u| _"E
ChekBox: Filtrar
Fecha de inicia listada: I domingo 27 de diciembre de 1333 j /
_ — £ [~ &plicar filtro
Fecha final del fistado: | domingo 27 de E"E'Emt'"?/éﬂ1E|98 [
| Afadir 2 componentes del tipo /
DateTimePickers: procedure TFormfactu.FiltrarClick(Sender: TObject);
Names: Inicio y Fin begin
if filtrar.checked=true then
begin
tablel.active:=false;
consulfactu.active:=true;
consulfactu.IndexFieldNames := 'Fecha_fac';
Crear un componente tablay un with consulfactu do
datasource: begin
SetRangeStart; { inicio indice }
Propiedades de la tabla: FieldByName('Fecha_fac').AsString :=
] ’ datetostr(inicio.date);
Name: Consulfactu SetRangeEnd; { final indice }
Table name: Factura.dbf FieldByName('Fecha_fac').AsString :=
datetostr(fin.date);
. ApplyR H tabl 1 1 Dat t
Propiedades del Datasource: end?p yRange; { establece el rango al Dataset }
Dataset: Consulfactu end
else
begin
{no hay que poner filtrar.checked:=false;}
consulfactu.CancelRange;
consulfactu.active:=false;
tablel.active:=true;
end;
end;
Impresidn de la factura:
1. Crear una nueva ventana QuikReportl
2. Afadir los apartados: QrBand, QrSubdetaill y GroupFooterBand1
3. Afadir los componentes: QRLabel para etiquetas o titulos y QRDbtext para los campos
4. Aplicar un filtro para que sélo se imprima una factura
QrBand. Tipo: Qtdetaill
HOMBRE | Al pulsar el botén Imprimir:
PirECCION, g
o EGHBHE proceaure
Foo_PosTROBLACION, FirEre o] TFormfactu.SpeedButton2Click(Sender: TObject);
BROVINGIA] _ var
O0_FeET BoBuacion
Eon_post g‘:ﬂumcﬂd textofiltro:string;
i 9 . A
Bim.actur; HuUk_Fac] QrSubdetaill begin
Focrm imoun) FECH_FAZ Eaod. cliend  Fob W textofiltro:='num_fact="+floattostr(tablelnum_fa
ct.value);
| Eadigd Bescripcia] [ Frecig impard tablel.filter:=textofiltro;
o = tablel.filtered:=true;
Eonkeg PESCRIFC S Erec] L mpar quickreportl.preview;
Eara impanink) i Rl izcurg tablel.filtered:=false;
. i RR ERubnZ BRiabei end;
L
GroupFooterBandl

Por ultimo: Crear el programa de Instalacion:

Para ello utilizar el programa anexo InstallShield y seguir los pasos para crear el disco de instalacién del programa.
Recuerda que también debes afadir a los archivos de instalacidon el control de Base de datos DBE




Cadigo fuente base de ejemplo para programa de facturacion:

unit factul;

interface

uses Windows, SysUtils, Classes, Graphics, Forms, Controls, StdCtrls, Buttons, ComCtrls, ExtCtrls, Menus,

DBTables, DB, DBGrids, Mask, DBCtrls, dialogs, math, Grids;

var
Formfactu: TFormfactu;
numero:double;
baseimpo: Real;

uses empresal, CLIENTES, Imprimel, Acerca;

procedure TFormfactu.FormCreate(Sender: TObject);
begin

tablel.open;

table2.open;

table3.open;

table4d.open;

tablel.last;

procedure TFormfactu.TablelAfterInsert
begin

tablelnum_fact.value:=numero+1;
tablelfecha_fac.value:=date;
tableliva.value:=16;

estado.caption:="AfAadida la factura num. ' +
floattostr(numero);
end;

procedure TFormfactu.TablelBeforelInsert

begin

tablel.last;
numero:=tablelnum_fact.value;
end;

procedure TFormfactu.TablelAfterDelete

begin
estado.caption:="Eliminada la factura num. ' +
floattostr(numero);

ShowMessage('Eliminada la factura num. +
floattostr(numero));

end;

procedure TFormfactu.EliminarClick(Sender..
begin
tablel.last;
numero:=tablelnum_fact.value;
table2.disablecontrols;
tablel.disablecontrols;
if MessageDlg('¢Eliminar la factura n2 ' +
floattostr(numero)+ '?', mtInformation, [mbYes,
mbNo], ©) = mrYes
then
begin
tablel.delete;
table2.first;
while not table2.eof do
begin
table2.delete;
table2.next;
end;

table2.last;
table2.delete;
end;
tablel.enablecontrols;
table2.enablecontrols;
end;

procedure TFormfactu.nuevoClick(Sender: TObject);
begin

table2.insert;

end;

procedure TFormfactu.borraartClick(Sender: TObject);
begin

table2.delete;

end;

procedure TFormfactu.Table2CalcFields

begin
table2importe.value:=table2cant.value*table2precio.v
alue;

table2pvp.value:=
table2importe.value*(1+tableliva.value/100);

end;

procedure TFormfactu.calculalClick(Sender: TObject);
var
impiva: Real;
totfact:Real;
toteuros:Real;
begin
baseimpo:=0.0;
impiva:=0.0;
totfact:=0.0;
toteuros:=0.0;
table2.disablecontrols;
table2.open;
table2.first;

while not table2.eof do

begin

baseimpo := baseimpo + table2importe.AsFloat;
table2.next;

end;
{TFormfactu.TablelCalcFields;}
{tablelbase_impon.value:=baseimpo;}
table2.enablecontrols;
impiva:=baseimpo*tableliva.value/100;
labelbaseimpo.caption:=Floattostr(baseimpo);
labelimpiva.caption:=Floattostr(impiva);
totfact:=baseimpo+impiva;
{if totfact>@ then
toteuros:=totfact/tableleuro.value;}
labeltotal.caption:=Floattostr(totfact);
labeleuros.caption:=Floattostr(toteuros);
end;
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Filtros y busquedas en tablas

Busguedas blandas desde un edit o Dbcombo.

{el Edit se llama busca y la variable Campobusca: String;}
procedure TFichero.buscaChange(Sender: TObject);
begin
Campobusca :="'Apellidos’;
tablel.SetRangeStart;
Tablel.FieldByName(Campobusca).AsString:=busca.Text;
Tablel.ApplyRange;
end;

BuUsquedas duras

Tablel1.Open; // abrir la tabla

Tablel.SetKey; // Ponemos el DataSet en situacion dsSetKey
Tablel.FieldByName('Autor').AsString := 'Borges';// Damos valor al campo
Tablel.GotoNearest; // Nos posicionamos en ese valor o el mas cercano
showmessage(tablel.FieldbyName('Autor').AsString);

Tablel.close;

procedure TForm1.Button1Click(Sender: TObject);
var

temp:integer;

opcion:TLocateOptions;

begin

Tablel.Locate('NOMBRE',Edit1.Text,[]);

end;

Los parametros del método Locate(), son;

Locate("Columna de busqueda" ,"Dato a buscar" , [loCaselnsensitive, loPartialKey]);

cuando opcidn = loCaselnsensitive R ignora diferencia entre mayusculas y minusculas

cuando opcidn = loPartialKey B resultado parcial, ejemplo si se busca "ju" se posesiona en el primer renglén donde
ese campo empiece con "ju", ejemplo Juan, juvenal, etc.

Contar el numero de registros:
Se puede utilizar este ejemplo en el ejercicio anterior para calcular el nimero de facturas totales.
numero.caption:=IntToStr(tablel.recordcount)+' fichas’;

FILTROS EN TABLAS DELPHI

Existen dos maneras de poner filtros o condiciones para una tabla, ellas son:
1.- Interna, En el componente Table, modificar las propiedades: propiedad Filter = condicion y propiedad Filtered =
true
Ejemplos para la tabla de clientes:
ClaveCliente <3 , Ciudad <> “Tarragona” , ClaveCliente > 2 and Ciudad = ‘Tarragona’

2,- Externa, es el usuario quien construye el filtro o condicion, usando un componente Edit para el filtro y un botén
de ordenes (OK) para que se ejecute y despliegue la tabla filtrada, el cddigo en dicho botén es;
onclickbuttoni()

Tablel.Filter = Editl.Text;

Tablel.Filtered = true;

Ejmplo:
procedure TForml.botonfiltroClick(Sender: TObject);
begin
if botonfiltro.Down=true then
begin
CalcularClick(Sender);
tablel.Filter:="PROVINCIA ='+StaticTextaProv.Caption;
tablel.Filtered:=true;
end
else tablel.Filtered:=false;




Base datos tipo cliente - servidor Delphi: Interbase — Firebird - Mysql

En lugar de usar tablas locales tipo BD o mdb, utilizaremos una base de datos del tipo servidor como
Interbase (o su equivalente gratuita Firebird):

1. Instalar Interbase o Firebird en el PC: https://downloads.embarcadero.com/free/interbase

2. Crear la base de datos con IBconsole o con IBExpert

Herramientas visuales de Interbase: 1BConsole:

El primer paso para utilizar IBConsole es registrar el servidor Interbase y conectar a servidores locales y
remotos.
Para registrar un servidor: seleccionar del menu Server | Register ... o Create...lo que mostrard la ventana
para conectarse a un servidor local o remoto.
Indicar si el servidor es local o remoto. Por defecto es local. En el caso que sea remoto, indicar el nombre del
servidor y el protocolo de red a utilizar. Si es TCP/IP se puede indicar la direccidn IP en lugar del nombre.
Si se quiere registrar el servidor...
o Indicar un nombre de alias. En el caso de servidor local, el nombre es automatico.
o Indicar una descripcion para el servidor.
o Indicar que la informacion de alias debe ser almacenada.
Si se quiere conectar al servidor... :
o Indicar el nombre de usuario (SYSDBA) ‘Il Database Connect X

o Indicar la clave (masterkey) ,
. . . Databaze: Pepe
La primera vez que entras a Interbase, el sistema tiene
predefinido un usuario Ueer [ SYSDEA
llamado SYSDBA que tiene todos los derechos de acceso en
Passward: rnasherkey
Interbase. El
password de este usuario es inicialmente masterkey Save Password [
Bole:
Para crear una base de datos: Case sensitive ole name [
Indicar un nombre de archivo .GDB. Seleccionar del menu Client Dialect: 3 v
Database | Create Database...Escribe el nombre AGENDA
L —_— Character Set Hone W
(puedes ponerle extensién GDB o IB). Escoge el lugar donde
guardar. Pulsa OK. Use DBAliasname [ ]
Para conectar con la base de datos: Diefault Cancel

Pulsa el botén derecho sobre la tabla y escoge: Connect.
Te pedira user y contra. Rellenar como en la figura: =

Stored Procedures  Transackio

dit  Functions FKewwords eIl

Load Script l
Save Script

Para crear de una tabla
Vamos a crear una tabla desde Interactive SQL:
Escoge del menu de IBConsole: Tools PInteractive SQL.
Copia este cddigo en Interactive SQL y escoge del menu:
Query P Execute
create table telefonos IES
(nombre varchar(24) not null primary key, SIONE Prepare
direccion varchar(24) not null,
telefono varchar(24) not null)
Sintaxis create table: En primer lugar indicamos el nombre de la tabla y luego, entre paréntesis y
separados por comas, los campos que la componen. Para cada campo indicamos su nombre, tipo de
dato e imposiciones. Todos los campos tienen las mismas imposiciones salvo el campo nombre que,
ademas de la imposicidn not null, tiene la imposicion primary key.
Seleccionar los campos:
Escoge del menu de Interactive SQL: Query » Wizard afiade todos los campos y escribe un alias. Se
generara una consulta como esta:

select A."NOMBRE",A."DIRECCION",A."TELEFONQ" from "TELEFONOS" A

Escoge del menu: Query P Execute. Se mostrara la tabla.

Mek M

11 p
null

mll)
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Insertar datos en la tabla:

Insert into telefonos(nombre, direccion, telefono)
values ('Ofimega’, 'Calle Barcelona','977350471")

Recuerda que el campo nombre no se puede duplicar por ser primary key.
Modificar datos:
Cambiamos el telefono con el siguiente cddigo:

Update telefonos set telefono = ‘977351777’

IBExpert

Es una herramienta gratuita que se descarga desde la pagina de firebird y es un interfaz grafico para
manipular bases de datos y tablas de internase vy firebird.
1. Descargar version personal desde: http://ibexpert.net/ibe/index.php?n=Main.DownloadFree
2. Registrarte para que te envien el password y nombre de usuario.
Introducirlos al ejecutar el programa.
3. Crear la base de datos:
Escoge del menu: Database P Create database...
Introduce el nombre de usuario, password, version de la base de datos y
lugar donde se guarda. Ver figura = Database Alias
4. Conectar la base de datos. Pulsa sobre el nombre de la base de datos de la | C:\Documentos|telefonos.fdb
lista y escoge: Conect.
5. Crear la tabla: Pulsa el botdn dercho del mouse sobre el elemento Tables y
escoge: New table... Bassha
Escribe el nombre de los campos, su tipo y tamafio en la pestaia: Fields:

£ @E'\Dﬂcumentus\ngend Table ~ Il-'.'l 3«: = =, El.'l Get record count | Twpe: Persistent = ||TELEFOMOS -
(3 Domains Fields | Constraints  Indices Dependencies  Triggers Data  MasteriDetail View Description  DDL # Grankts  Logging

+-E Tables (1}

Server Server Yersion

Local * | InterBase 7.0

Database File

C:\Documentositelefonos.fdb

User Mame  3Y30EA

d sk

Wiewws
%Procedures # |PK |FE | UNG Field Name Field Type Size Domain Scale | Subkype | Array Mok Mul
T Triggers O Y =
B Generatars z DIRECCION WARCHAR 30 O
b 3 TELEFCMNO WARCHAR. 30 O

6. Escribe el nombre de la tabla TELEFONOS en el lugar indicado por la flecha de la imagen.
7. Rellenar datos: Selecciona la pestafia Data y escribe algunas filas.

Conexion Interbase con Delphi:

= En una aplicacion nueva, afiadimos al formulario un Datasource, un DBGrid y un = =_="|‘_|
DBNavigator Luego relacionamos el DBnavigatory el DBgrib con el Datasource. IE IE™J _
= De la paleta de componentes Internase, afiadir un IBDatabase y un IBtransaction. IBD atabslBTransaction]

= El componente IBdatabase se llamara IBdatabasel y en el componente IBtransaction cambia la propiedad
Defaultdatabase por IBDatabasel.

= En el componente IBDatabasel cambia la propiedad Database por: User Mame: SYSOBA
C:\...\AGENDA.GDB 6 AGENDA.IB. Si la base es de Firebird:AGENDA.FDB
= Cambia la propiedad Conected = true. Te solicitard en User name y el Password. Pazsword: masterkey

Poner el de la imagen derecha: =
Metodol. Modo DBE:

Anadir un componente IBTable y cambiar las propiedades como en la imagen Bl e IBDatabase1

d TableMame TELEFDMODS
erecha.~> . -

Metodo2. Sin tabla: Tranzaction IBTranzactionl

Afadir un componente IBdataset que provee un editor SQL. Cambia su propiedad Database por nuestra Databasel y su
propiedad SelectSQL por: |Se|ect * from telefonos|.

Es aconsejable crear un datamodule llamada DMconexion con los componentes: IBDatabase, IBtransaction y
IBdataset. Compila (F9) y guarda el proyecto con el nombre: Agenda.
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Conexion con Mysql

Vamos a hacer una sencilla aplicacién que permita la conexién y manipulacion de datos en una DB MySQL mediante

ODBC o mediante driver directo por ejemplo ZeosDBO.

Utilizando Xampp o Wampp , y desde phpMyAdmin, debes debes haber creado antes la base

de datos Mysql en tu pc usando: localhost como servidor de prueba.

e Método 1: Mediante ODBC:

Es un controlador del sistema operativo que permite la conexion a datos de cualquier L
aplicacién. MySQL posee un puente ODBC (MyODBC) que puede ser bajado del sitio en forma
gratuita y viene con un instalador de facil ejecucion. Gracias a este driver podremos acceder
desde un cliente Windows, con MS Access por ejemplo, a un servidor remoto MySQL

Instalar myodbc:

php

R3O0
Reciente Favoritas

— 4 Nueva
tienda

‘L_d Nueva

+_l# thlcategoria
+ls thiproducto

Descargamos de la pagina de MYSQL http://dev.mysql.com/downloads el conector ODBC para Windows.

Una vez instalado el conector ODBC debemos crear un nuevo origen de datos para la conexion:

Para crear un Origen de datos ODBC:

Desde el menu Inicio de Windows: Configuracidn P Panel de Control » Herramientas administrativas » Origenes de

datos (ODBC)

D5M de usuario | DSM de sistema

Pulsa en Agregar
Indica el driver de Mysqgl ODBC

Crigenes da datos de usuario:

D3N de archivo | Controladores

= Administrador de origenes de datos ODBC

Seguimiento | Connection Pooling | Acerca de

Mombre Controlador
dBASE Files Microsoft Access dBASE Driver (*.dbf, *ndx, *mdx)
.z . Excel Files Microsoft Excel Driver (" xds, “xdsx, “xdsm, “xdsh) Quitar
Usar como conexion local: MS Access Database Microsoft Access Driver ("mdb, *.accdb)
- Server: Localhost : “ Corfigurar..
. Crear nuevo origen de datos
- User: root

Sin contrasefia
Puedes escoger la base de datos

Seleccione un controlador para el que desee establecer un

origen de datos.

MNombre

Entra en Delphi y aflade un componente ADO table. y cambiamos su
propiedad conexion string.

En la propiedad del ADO table, Table Name, indica la el nombre de la
tabla: clientes.

Crear el formulario en Delphi para usar ODBC.

En un formulario vacio coloca los siguientes componentes:

Un panel con la alineacién (Align) en Top.

Dentro del panel un: DBNavigator

Un botdén: Name: Control, Caption: Abrir

Un botdn ThitBtn: Name:Cerrar, Kind: bkClose, Caption: Cerrar
Un DBGrid con alineacidn (Align) AllClient

De la pestaiia ADO o dbGo, selecciona un AdoTable y modifica las siguientes

propiedades

o Connectionstring: Generamos la conexién con el driver ODBC a la conexion
gue hemos creado antes: ConexionMysql y pulsamos Probra conexion.

Microsoft Paradex Driver (".db )
Microsoft Paradox-Treiber (*.db )
Microsoft Text Driver (“bd; *.cav)
Microsoft Text-Treiber (“bd: ~cav)

AoEm e e e

[ MySQL ODEC 5.2a Driver
AN
My
Connector/ODBC

Connection Parameters

Data Source Name: | ConexionMysg|

Description:

®) TCP/IP Server; | localhost

() Mamed Pipe:
User:
Password:

Proveedor | Conexidn | Avanzadas | Todas

1. Especffique el origen de datos:
(®) Usar el nombre del origen de datos
ConexionMysqgl

() Usarla cadena de conexidn

Debe ser exitosa.En el catalogo inicial escoge la base de datos. (Edu)

Pulsa aceptar. Se mostrara la cadena:

Provider=MSDASQL.1;Persist Security Info=False;User ID=root;Data

Source=telefonos
o TableName: telefonos

De la pestaia DataAccess seleccione el componente DataSource. Asocie el

DataSet con la Tabla

Actualice los DataSource del DBNavigator y DBGrid con el TDataSource.

al proveedor de datos
=2quipo actual por el usuario

Port: | 3306

Especifique lo siguierte para conectarse a datos ODBC:

v | | Actualizar

2. Escriba la informacidn para iniciar sesién en el servidor

Nombre de usuario:

Contrasefia:

[[] Contrasefia en blanco [ Permitir guardar contraseria

3. Escriba el catdlogo inicial:

|edu

Probar conexidn

Para comprobar que todo esta correcto, modifica la propiedad Active del TTable a True y veras en el DBGrid la

estructura de la agenda creada anteriormente.
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- Para que la misma sea funcional debes escribir
Albir N1 Ceira P
L= algo de codigo:
| 3 -
] Clica en el formulario el botén Abrir y en el editor
e de cédigo escribe lo siguiente:

procedure TForml.ControlClick(Sender: TObject); . .
begin procedure TForm1.CerrarClick(Sender: TObject);
If Control.Caption='Abrir' then begin
begin Tabla.Close;
Control.Caption := 'Cerrar'; Halt(0);
Tabla.Open;
end
Else
begin
Control.Caption := 'Abrir';
Tabla.Close;
end;
end;

end;

Compila el formulario y ejecuta la aplicacion.

e Método 2: Usar componentes Zeos

Es un conjunto de componentes de distribucidn gratuita y posibilitan la conectividad con distintas bases de datos:

MySQL, PostgresSQL, etc.

Instalacion de Zeos: Descarga el paquete desde el sitio de ZeosLib y descomprime el archivo .zip Copia dentro de la
carpeta Archivos de programas\Borland-Embarcadero...\Source\Zeos la carpeta de los pakages con la versién de
delphi que corresponda. Ejecuta ZComponentDesign.dpk

= Copia la DLL correspondiente a su version de MySQL que se encuentra en la carpeta Archivos de
programas\Borland\Source\Zeos\lib\mysql a la carpeta de WINDOWS\SYSTEM32

= Dentro de Delphi (en environement options) agrega el directorio Zeos\packages\delphi7\build a la opcién Library Path

= Desde Delphi, abre la carpeta: \...\Zeos\packages\delphi7 y compila el grupo ZEOSDBO.BPG o individualmente
ZCore.bpl, ZParseSql.bpl, ZPlain.bpl y ZDbc.bpl

= Instala el componente: ZComponentDesign.bpl Aparecera la s 05y | Jvwizard | Jv P Cortrals  Zeos Access ] |k

paleta de componentes: ZeossAccess —
SEROML AR

Como en el ejemplo anterior, inicie un nuevo proyecto en Delphi agregando al formulario todos los componentes del

Crear el formulario en Delphi para usar Zeos.

ejemplo ODBC menos la Ttable. (Panel, DBNavigator, botén Abriry Cerrar, DBGrid) Database o

DezignConnect Falze

BEBJ Kg Host ame localhost

LoginPrompt | Falze

Agregue un Zconnection modificando las siguientes propiedades:
= Database: agenda

= HostName: localhost o el nombre del equipo/direccion IP ‘ Hame ZCannection]
= User: root (en caso de poner otro nombre proveer la clave en la propiedad Password
Password) Part 0
* Protocol: Escoger MySQL . Fropetties | [T3kings]
Frotocol mszql
" L . ReadOnly Falze
Agregue un ZTable y modifique las siguientes propiedades: E SOLHowG lass | False
= Connection: ZConnectionl Tag 0
= TableName: myagenda Tranzact|zalatig N one
Para conectar directo a un PC servidor remoto: User root

Es necesario detectar la IP del servidor (mediante una web como http://www.hcidata.info) el nombre de la base de
datos y su password para agregarlo al controlador ODBC

e Método 3: Mediante acceso FireDAc
Para Delphi XE7 y superiores dipones acceso directo universal DAC:
Desde la paleta FireDAC insertar los componentes de la figura
En FDconection pulsa doble clic y especifica el driver: MySql



http://www.hcidata.info/

Conexion con SQLIte o Mysql a Partir de Delphi XE

Método 1: Usar DBExpress actualizado

LibraryMame dbxmys.dll
Las ultimas versiones de RAD studio incorporan el driver MYSQL en la LibraryNameOsx libsgimys. dylib
SQLConexion del DBExpress o de FireDAC. No obstante se debera incororar VendorLib LIBMYSGL.dl
las librerias libmysql.dll que ya lo lleva el Xampp en xampp\mysgl\lib y VendorLibWing4 r——
dbxmys.dll al path. VendorLibOsx librmysgldient. dylib
HostMame localhost
El acceso a las bases de datos MySQL o SQLite y las creacion de las tablas es ~ Database tienda
posible hacerlo muy facilmente desde la pestafia DataExplorer. User_Mame root
Crear una nueva conexién y con el botén derecho encima seleccionar: New table. * g :izgt

Afnadir los campos de texto: Nombre y teléfono de ancho 50 caracteres y guardar la tabla coi
= @Ej MySQLConnection

+ Tables
- By views

+- (@ Procedures

Arrastrar la tabla creada sobre el formulario. Apareceran los componentes:
Agendatable y mSqglConection
Activa las casillas: a

b || o [ B [l [ ol ||| || || 2 ||
Conected y active. ‘ @ Odbe
+- [ Orade
=} @ SQLITECONNECTION
gliteconnectionConnection AgendaTable - Tables
B
o . . . -+ & agenda
Afade unos componentes DBGrid, DBNavigator y Datasource al formulario 2 ind
+i- @= INdICES
ﬁ:}ﬂ nombre
f;_?ﬂ telefono

Model View | Data Explorer

Método2: Usar Zeos S

En el DBGrid y el DBNavigaor asignar el Datasourcel P (WideMema) (WideMema)

Probar (Run J»)

1. Descargar la libreria gratuita ZeosDBO Version 714. : e

2. Instalar el pakage para XE7 Connection1. . [ZTablel DataSourcel. | [ [ ...
3. Afadir los componentes de la imagen al formulario: s
4. En Zconection asignar la database y ectivar conected. | | bl = X |
5. En Ztable: Asignar a la Tablename: agenda y activar.

6. En Datasource: Poner el dataset: Ztablel nombre telefono

7.

8.

Método3: Usar FireDAC

Para Delphi XE7 y superiores dipones acceso directo universal DAC:
Desde la paleta FireDAC insertar los componentes de la figura
En FDconection pulsa doble clic y especifica el driver: MySql
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Multi-Device Aplicaciones multiplataforma / entorno FireMonkey desde XE5
Configurar un dispositivo ANDROID

Las aplicaciones Android se prueden probar en un emulador Android Android SDK Manager
en el PC o en un dipositivo fisico Android (teléfono o tablet). Packages [JISBE
Meétodo 1: SDK Path: Manage AVDs... \12.00Platforr
Packages Manage Add-on Sites...

Para probar la emulacidn de Android se debe instalar las android SDK

. s . Mar Options... | AP|
manager. Desde la versién XE ya se incorpora un SDK manager que se

. . . [l About...

puede actualizar desde: Tools — Options — Environement — SDK [ e —

Manager. Android SDK Platfo Android Virtt
. (] Android SDK Build | | [z
Afadir las rutas para las SDK path. Normalmente, SDK en: [ Android SDK Build)| | Android Virtual Devices |

. . [/ Android SDK Build{! | | it of exicting Android V
C:\Users\Public\Documents\RAD Studio\12.0\PlatformSDKs\adt- 1 Android SDK Build ist of existing Androi
bundle-windows-x86-20130522\sdk [].# Android SDK Build AVD Name T

[+ Android SDK Build- +" rsxe5_android A
Ylas NDK en: ]+ Android SDK Build

C:\Users\Public\Documents\RAD
Studio\12.0\PlatformSDKs\android-ndk-r8e

Desde el SDK manager, escoge del menu: Tools — Manage Avds....

Android Virtual Devices para crear diversos emuladores Android. (Estos emuladores son pesados).

Método 2: :— Adb Driver Installer for Windows <P Afista/7 /8 [<86 or =64]
Otro modo de probar las aplicaciones es compilar Current Oparating System: Windows 8 [+86]

directamente sobre el dispositivo android conectado. Si es

necesario, bajarse el ABD driver universal USB de la Defiesizd SHIDIRTID aules Ik

pagina: http://adbdriver.com/downloads/ e instalar en el
PC con el dispositivo conectado. Luego instalar el APK

M anufacturer Dezcription Device Status

(_j Sony Ericszon Sony 500101 ADE Interface Driver ok

instaler (instalador de paquetes APK para Android) en tu

dispositivo desde la Play Store de Google.

Feady.

El teléfono o dispositivo android debemos conectarlo al PC Help Apk Installer Esit

y activar las opciones del desarrollador (pulsando varias

veces en el numero de compilacidn) y activar en el modo desarrollador: Depuracion
USB M1.. Con esto nos aparecera el dispositivo en el target de Android SDK.

Al compilar la aplicacion en el dispositivo, en realidad, esta queda instalada.

Otra manera manual de instalarla y probarla en el dispoitivo seria coger el archivo APK
generado de la carpeta de nuestro proyecto: Android\Release\BIN y luego copiarlo al
dispositivo e instalarlo con el APK installer

En el modo de emulacidn (sin usar el dispositivo fisicamente) escoger en el manager

+- i Build Configurations (Release)
—}- £} Target Platforms (Win32)
£7 32-bit Windows
= Android - Android SDK 22,2
=}-[F7 Target

AVD virtual devide arrancar (Start) el AVD deseado.
Configurar para subir a al PlayStore:

1. Activar en el Project manager el modo de Build: Release (version final).

2. En project - Options: En pestafia Uses permisions: Activar o desactivar las funciones deseadas para el dipositivo
(Acceso a camaras o localizacién)

3. En project - Options: En pestafia Provisioning: Crear un certificado

4. En project — Deployment — pulsar el botdn de la barra: Deploy.

5. Crear una cuenta de desarrollador de Google previo Building Torget ;
abono de 25 $. dehic@p”e, Android 64-bit platform | ap

Para las nuevas versiones de Android 64 bits: Srzp::‘:gwmings O'Z';'d‘i’t‘i’:;':'l'sopmm  merlidhinconmeid

Google pide el el formato AAB (Android App Bundle) en lugar Linking Generate Android App Bundle file (arm *

del formato apk. Estas estdn disponibles a partir de las Ouitpk - (/G Generate XML documentation [Treree

versiones de Delphi Rio 10.3.3 o Sidney 10.4. Build Events

Resource Compiler Output unit dependency information D false

Require SIF to be terminated by SIFEND D false

En las opciones del proyecto se debe activar: ¥ Generar el Application XML documentation outout directorv
archivo App Bundle.


http://adbdriver.com/downloads/

Publicacidon en Google Play. Subir la APK o0 AAB (Android App Bundle)

Configurar y generar el APK o AppBundles final:

= Desinstala la versidn debug del dispositiv y activa, en el Project manager, el modo Release (version final).

=  En Project - Options: En pestafia Uses permisions: Activar o desactivar las funciones deseadas para el dipositivo (Acceso
a camaras o localizacién). Para la plataforma Android 64 bits Activa el M Generar el archivo App Bundle

=  En Project - Options: Version Info: Establece en nimero de versidn y la version de compilacidon Version Code que sera

la evaluada por Google.

= En Project - Options: En pestafia Provisioning: Crear un certificado.
En este certificado va la huella digital del producto para firmar el APK en Google Play (SHA1).
Ejemplo: SHA1L: B9:D6:FD:B4:0D:9F:EE:57:67:C6:7D:49:DA:D1:CA:44:F4:F2:E9:C3
Se recomienda conservar el archivo .keystore para incluirlo en nuevas versiones.
=  En Project — Deployment — pulsar el botdn de la barra: Deploy. Esto genera el archivo de instalacion APK para Android

Publicar y subir a Google Play:

=  Tras Crear la cuenta de desarrollador de Google (previo abono de 25 $ unos 20 €)

=  Accede a Google Play Developer Console.

=  Parasubiruna aplicacidén nueva: Selecciona Tus aplicaciones o Todas las aplicaciones. Pulsa en Crear una una aplicacion.
= Escribe el Idiomay el nombre de la aplicacion y pulsa en Crear.
=  Selecciona el archivo APK o AAB normalmente desde la subcarpeta de tu projecto: Android\Release\Aplicacidn\bin

Por ejemplo: Release\Android\Release\Oficalcm\bin

=  Sube tu archivo APK. Se recomienda publicar primero
en los canales de prueba alfa o beta y una vez testeado
publicar en el definitivo para produccion.

= Si ha sido aceptada la subida del archivo APK se

para agregar
= AR i B I AGREGAR APK DESDE LA BIBLIOTECA
R Versiones de la app A
(4]
1 archivo APK aqui arct
]

EXAMINAR ARCHIVOS

recomienda que guardes la configuracién del proyecto pulsando en Save... tipo *.opset.
=  Antes de publicar, deberas especificar si es de pago o gratuita y el tipo de clasificacién del contenido para obtener un

certificado de la IARC.

=  Esperar unos dias para su comprobacidn y que se muestre el estado: Publicado.

droid - Release)

Target: | Release configuration - Android platform v|

Apply...

Version code

E

Version code options

Do not change

Key Value

package ofimega.OficalcM
label S(ModuleMame)
versionCode 6

versionName 6.1

persistent False
restoreAnyVersion False
installLocation preferExternal
largeHeap False

theme TitleBar

hardwareAccelerated true

apikey

Para actualizar la version de tu APK o AppBundle
Selecciona en Project - Options: Release configuration —
Android platform

v

v

las configuraciones guardadas en *.opset.

» Genera el nuevo el APK o AAB, en modo Android Release, con

una version superior.
» Accede a Google Play Developer Console con tu cuenta.
Selecciona el APK o AAB anterior y Pulsa en Subir.

Nota: Debes tener Activada la Play App Signing. Para ello debes
descargar un script de Java que genera el archivo de claves para

exportar y subir a la Play Console y obtener el certificado.

Save...

.

En la pestafia Provisioning: recupera el certificado anterior y

* Iroid - Release) =

Save...

larget: | Release configuration - Android platforrn Apply...

Provisioning
Build Type:
Android - Application Store ~

KevStore File:
| Embarcadero\studio\ProjectsOficaldOficalcd 10 1\certificado_oficalem 1. keystore

KeyStore Password:

New Keystore... Change Password... Get Certificates

Alias in Keystore:

certificado_oficalem w

Alias password:

Certificate Info
Creation date:
Apr 9, 2015
Valid since:
Thu Apr 09 05:34:17 CEST 2015 until: Mon Apr 09 05:34:17 CEST 2040

.
- .

APK

A 9 (=

Publicacion estandar v

Oficalc Mobile

ofimega. OficalcM A

PUBLICADA
Cambiar a modo avanzado
PRODUCCION BETA TESTING ALPH

Version

5

A TESTING

NGV oI SToN Subir nuevo APK de produccion. |

APK ACTUAL  Fecha y hora de publicacién: 6/7/2015 19:05:38

Dispositivos compatibles Dispositivos excluidos

13967 0
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Aplicacion para Win 32 —=win 64 e IOS - Mac

Para probar la emulacién para I0S crearemos una aplicacién basica para FireMonkey;
= Escoge: New > FireMonkey Desctopt Application o File > New > Other > Delphi Projects > FireMonkey HD Application.
= Afiade, de la paleta Estandar, estos tres elementos al formulario:

- Tedit - Editl

- TButton que diga “Hola”.

- TLabel que diga: “Introduzca su
nombre”

Bienvenido...

= Pulsa doble clic sobre el botdn
Button1 para escibir en el procedure:

procedure TForm1.Button1Click(Sender:

TObject);

begin
ShowMessage('Hola,'+Edit1.Text);

end;

Probar la aplicacion:

Aceptar

Properties | Labell TlLabel

Label1

Introduzca su nombre:

Introduzca su nombre:

Properties | Edit1 TEdit

[Name |Edit1

Buttonl TButton

Pulsa el botén Run > o elige del ment: Run — run para comprobar su funcionamiento.

Guardar el proyecto: Crea una carpeta que se llame: HolaFM.

e Escoge: File » Save as... Para guardar el archivo de cddigo en la carpeta con el nombre: HolaFM1.pas
e Escoge: File » Save project as... Para guarda el proyecto en la carpeta con el nombre HolaFM.dpr

Activar la version para Windows 64-bit:

12 En el panel Project Manager, pulsa con el botén
Derecho del mouse sobre Target Platforms.

Add Platform...

Escoge 64 bits Windows.

22 Pulsa con el botdn derecho del mouse sobre la
plataforma 64 bits y escoge: Activate.

32 Compila de nuevo la aplicacion y comprueba que se
muestra en la carpeta Win64\Debug la aplicacién exe.

Nota: Si tu FM RAD Studio corre bajo x86 (Win32) podras compilar en 64 bits pero no

podras ejecutarlo.

Configurar para Mac OsX y ejecutar en un Mac:

12 En el panel Project Manager, pulsa con el botén Derecho del mouse sobre Target

Platforms. Add Platform...Escoge: OSX.

22 Pulsa con el botdn derecho del mouse sobre la plataforma OSX y escoge: Assign

Remote Profile.

32 Selecciona Add...
para abrir la ventana de conexién con un equipo mac por red.

49 Escribe el nombre de la conexidn: ConexionMac
Pon el nombre de tu equipo Mac en lared o su IP

Entonces, el IDE estara conectado con tu Mac.
Si pulsas F9 se ejecutara la aplicacién en tu Mac.

G| E-S| 8- O-

File
8 ProjectGroupl
E| Heola.exe
,@ Build Configurations (Debug)

E}& Target Platforr Add Platform...
- ' 32-hit Win

Ll
= (F) Hola.exe
@ Build Configurations (Debug)
E\\ 0 Target Platforms (Win32)

- [ 32-bit Windows

Select Platform

Assign Remote Profile..

Edit Profile...

Select a platform:
Q5 X

Remaove Profile
Make the selected platform active

Remove Platform...

= @1 Hola
\.@ Build Configurations (Debug)
El @ Target Platforragacusns
H - Add Platform...

£7 32-hit windows

Select a platform:
Q5%
Make the selected platform active

Profile information

This wizard will assist you in creating a remote profile. Remote profiles are reguired in order to
deploy and run a project on a remote machine. A remote profile may also be required in order to

esm—— apphEa‘mn_

Please spedify ¢

Host machine information

Flease specify the host machine name for this profile. You can also s
password to be used when connecting to the host,

Profile name:

ConexiénMac

Platform:

Host name:
PacEdy]
Bort number:

54211

‘b

-

05X
/] set as defal

Password:

Enter password

<< Back

<< Back Next >3 Finis|



Multi-Device / FireMonkey - Grafica con el componente PlotGrid.

Para probar el uso del componente PlotGrid rejilla grafica y los gestos del mouse:
= Escoge: New > Multi-Device / FireMonkey Application (segun version)
= |Inserta en el formulario un panel y lo alineas al Top.
= Inserta en el formulario el component Tplotgrid con name: PG1 y o alineas al cliente.
= Pon en el panel tres Labels y dos Spinbox con nombres: Editm y Editn
Cambia sus valores max/min para que adopte valores entre -100 y +100
= Pon en el panel un Button1 con la propiedad text: Dibujar grafica.
= Pulsa doble clic en el botén Button1 de Dibujar grdfica y afiade al cédigo On clic: Button1Click:
begin
PG1.Repaint;
end;
= En el el componente de rejilla grafica plotgrid PG1 selecciona el evento onPaint: PG1.paint
= Escribe el codigo siguiente:

procedure TForml.PGlPaint(Sender: TObject; Canvas: TCanvas;const ARect: TRectF);

var
pl,p2,orig:TpointF; { Tpointf:punto de coordenedas decimales, tpoint: coordenadas enteras}
X,X0,y0:integer;
m,n:single;

Funcién lineal

begin
m:=EditM.Value; Pendiente m: | ¢ o >
: . ;
i Dibujar grafica
n:=EditN.Value; et [ ETEE jar g

//Punto origen en el medio de la rejilla:
orig:=PointF(PGl.Width/2, PG1l.Height/2);
Canvas.BeginScene; //->inicia el lienzo
//-> color de la linea azul:
Canvas.Stroke.Color := TAlphaColorRec.Blue;
//-> grosor de la linea a 2 :
canvas.StrokeThickness := 2;
//escalar a la resolucién de la rejilla:
n:=n*PG1l.Frequency;
//dibujo del lado derecho de la linea:
pl:=Pointf(orig.X,orig.y-n);

//define el primer punto
x:=round(PG1l.Width/2); //posicién x en la
rejilla del origen x
p2:=Pointf(PGl.Width,orig.y-m*x-n); //define el punto2 a final de la rejilla
canvas.DrawlLine(pl, p2, 1); //dibuja la linea entre los 2 puntos con opacidad

//dibujo del lado izdo
p2:=Pointf(0,orig.y+m*x-n);
canvas.DrawLine(pl, p2, 1);
canvas.EndScene;

Prueba y guarda en una carpeta nueva, la unidad con el nombre: grafical y el proyecto con el nombre: Grafica.

L

Gestos pararotar - mover - zoom 7| GestureManac GestureManager1
+| Gestures
= Afiade un componente GestureManager: GestureManagerl ,
. . . -l InteractiveGest [Zoom,Pan,Rotate]
= Al Formulario Form1, asigna a la propiedad GestureManager el
GestureManagerl Zaom True
= Al Formulario Form1, asigna el evento OnGesture: FromGesture: Pan True
procedure TForm2.FormGesture(Sender: TObject; Rotate True
const [Ref] EventInfo: TGestureEventInfo; var Handled: Boolean);
var
LObj: IControl;
begin
if EventInfo.GestureID = igiRotate then
begin

LObj := Self.ObjectAtPoint(ClientToScreen(EventInfo.Location));
if LObj is Tplotgrid then //si el cliente es el Plotgrid
begin
if (TInteractiveGestureFlag.gfBegin in EventInfo.Flags) then
AnguloAntes := PGl.RotationAngle
else if EventInfo.Angle <> @ then
PG1l.RotationAngle := AnguloAntes - (EventInfo.Angle * 180) / Pi;
end;
end; end;
= Afade la variable publica AnguloAntes:double y comprueba en un dispositivo tactil.
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Firemonkey:
Uso de listas String Grid. Conversor

1. Ideal para organizar listados en varias filas y columas.

2. Escoge: File > New > Multidevice ———— e

3. Inserta en el formulario un Tgridpanel alineado al cliente e G Lo i OO

»  Enlafila 0 columna 0 afiadimos un spinBox con el nombre: e Resd 150
valorl Hectometros- Hm

»  Enlafila 0 columna 1 afiadimos un TEdit con el nombre:
resultadol Decametros- Dam

»  Enlafila 1 columna 0 afiadimos un TstringGrid con el
nombre: magnil metros-m

»  Enlafila 1 columna 1 afiadimos un TstringGrid con el
nombre: resultl Decimetros- dm
En el evento Oncreate del formulario afiadimos los Centimetros- cm
elementos a las listas en tiempo real:

var En Magnil on select cell;

sufimetro:string; var

i:ipteger; Result:Double;

begin i:Integer;

sufimetro:="metros"'; //Longitud Op1,0p2:double;

magnil.RowCount:=15; Begin
magnil.cells[0,0]:="Tera'+sufimetro+'- Tm'; try
magnil.cells[1,0]:="1E12"; Op2:=StrToFloat(Magnil.Cells[1,Arow]);
magnil.cells[0,1]:="Giga '+sufimetro+'- Gm'; Y7/ > pasa a unidades base
magnil.cells[1,1]:="1E9"; for i := @ to Resultl.RowCount-1 do

magnil.cells[0,2]:="Mega’'+sufimetro+'- Mm';
magnil.cells[1,2]:="1E6";
magnil.cells[0,3]:="Miria'+sufimetro+'- Mm';
magnil.cells[1,3]:="1E5";
magnil.cells[0,4]:="Kilo"'+sufimetro+'- Km';
magnil.cells[1,4]:="1E3";
magnil.cells[0,5]:="Hecto'+sufimetro+'- Hm';
magnil.cells[1,5]:="1E2";
magnil.cells[0,6]:="Deca'+sufimetro+'- Dam';
magnil.cells[1,6]:="10";
magnil.cells[0,7]:=sufimetro+'- m';
magnil.cells[1,7]:="1";
magnil.cells[0,8]:="Deci'+sufimetro+'- dm';
magnil.cells[1,8]:='0,1';
magnil.cells[0,9]:="Centi'+sufimetro+'- cm';
magnil.cells[1,9]:="1E-2";
magnil.cells[0,10]:="Mili"+sufimetro+'- mm';
magnil.cells[1,10]:="1E-3";
magnil.cells[@,11]:="Micra’'+sufimetro +'- pm';
magnil.cells[1,11]:="1E-6";
magnil.cells[0,12]:="Nano'+sufimetro+'- nm';
magnil.cells[1,12]:="1E-9"';
magnil.cells[0,13]:="Angstromio'+'- A';
magnil.cells[1,13]:="1E-12";
magnil.cells[0,14]:="'Pico'+sufimetro+'- pm';
magnil.cells[1,14]:="1E-15";
Magnil.EndUpdate;

Resultl.RowCount:=15;

for

i := 0@ to Resultl.RowCount-1 do

Resultl.Cells[0,i]:=magnil.cells[0,1i];

Resultl.Cells[1,i]:=FloatToStr(Op2*Valorl.Value/StrT
oFloat(Magnil.Cells[1,1i]));
//Actualizamos resultados...
if Resultl.Selected<® then i:=0 else
i:=Resultl.Selected;
if Resultl.Selected<>@ then Resultl.SelectRow(9)
else Resultl.SelectRow(1);
Resultl.SelectRow(i);
activar el evento
except
Valorl.Text:="'1"'; //evita recursividad
End

//cambio de fila para

En ResultlSelectCell:

begin
Resultadol.Text:=Resultl.cells[1,Arow];
End;

Prueba y guarda en una carpeta nueva, la unidad
con el nombre: unitl y el proyecto con el nombre:
Conversor.



Ejercicio Uso de StrinGrid y arrays con Firemonkey: Division por Ruffinni

=  Crea un nuevo proyecto llamado Ruffini (File > New > Multidevice)
= Afade los componentes de la imagen adjunta:

v' 1 spinbox
v 5lables
v’ 2 StrinGrid
» Llama a las Stringrids con el nombre: coef
y tabla . . Calcular e
= Llama al coef divisor a
= Afade el evento en el botén: -
procedure TForml.FormCreate(Sender);
var co:integer;
begin
for co := @ to round(grado.Value) do
coef.Cells[co,0]:='0";
end;
procedure TForml.ButtonlClick(Sender: TObject); procedure TForml.GradoChange(Sender: TObject);
var begin
d:real; if grado.Value<coef.ColumnCount-1 then
fi,co,I:integer; //fila,columna . .
begin begin //quita columnas
d:=strtofloat(a.Text)*-1; //cambiamos el signo coef.Columns[tabla.ColumnCount-1].DisposeOf;
tabla.cells[@,1]:=floattostr(d); tabla.Columns[tabla.ColumnCount-1].DisposeOf;
for co := 1 to round(grado.Value) do //ponemos los end
coeficientes

i else if grado.Value>coef.ColumnCount-1 then
if coef.Cells[co-1,0]="" then tabla.cells[co,0]:='0"

begin //anade columnas
else tabla.cells[co,0]:=coef.Cells[co-1,0];

. coef.AddObject(TStringColumn.Create(Self));
//bajamos el primer coef;

tabla.AddObject(TStringColumn.Create(Self));

co:=1; //->celda[col,fil]
P coef.Cells[tabla.ColumnCount-1,0]:='0";

. coef.Columns[tabla.ColumnCount-1].Width:=50
tabla.cells[co,fi]:=tabla.cells[co,@]; tabla.Columns[tabla.ColumnCount-1].Width:=50
for co:=1 to round(grado.Value) do
begin end;

//multiplicamos y ponemos arriba izquierda

tabla.Cells[co+1,fi-1]:=

floattostr(d*strtofloat(tabla.cells[co,fi])); end;

//sumamos y ponemos abajo:

if tabla.cells[co+1,fi-2]="" then
tabla.cells[co+1,fi-2]:="0";
tabla.Cells[co+1,fi]:=floattostr(strtofloat(tabla.cell
s[co+l,fi-2])+strtofloat(tabla.cells[co+1l,fi-1]));

end;

tabla.RealignContent;

end;
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Sensores mobile. Antorcha android (version apaptada Samples\FlashLight)

= Descarga de internet imagen de bombilla o similar y de un botén encendido y apagado:
= Crea un nuevo proyecto llamado Linterna (File > New > Multidevice
application) =] Form
* Afiade el componente TCamera y los components de la imagen derecha:— =14 LayoutContenedor

= Alinea el LayoutContenedor al cliente y el LayoutBotones al centro. .;_TShL'ght
i E-iE LayoutButtons

= Cambia la propiedad Kind Camera TCameraCompaonent - + Apagada
a Back Camera 1 search | . &3 Encendido
|Properties| Events © fildly MultiResBitmap
Active [ False <= Labell
Kind BackCamera cooooooo ) Cotrelinterna30 oo
+| LiveBindings DegLiveBindings Designer Camera
»|Name Camera
StyleMame
* Afiade el codigo: Tag L

procedure TForml.FormCreate(Sender: TObject);

begin
apagado.Enabled := Camera.HasFlash;
Camera.Active := True; @
end;
procedure TForml.ApagadoClick(Sender: TObject);
begin E]
apagado.Visible := False; Camera
encendido.Visible := True;
Camera.TorchMode := TTorchMode.ModeOn; // En C++: Camera->TorchMode = TTorchMode: :ModeOn;
end;

procedure TForml.EncendidoClick(Sender: TObject);

begin

apagado.Visible := True;

encendido.Visible := False;

Camera.TorchMode := TTorchMode.ModeOff; // En C++: Camera->TorchMode = TTorchMode: :ModeOff;
end;

= Compila en dispositivo: En el Project Manager, selecciona la plataforma Android y conecta un mévil Android al
Puerto USB. Recuerda activas las opciones del desarrollador (pulsando varias veces en el numero de
compilacidn) en el modvil y tener instalado el driver ADB driver installer.

= Ejecutar y comprobar: Escoje Run > Run Without Debugging

= Guarda el Proyecto: Linternay la unidad: Linternal. Uses Permissions
P . i Target
ermisos. X . X Debug configuration - Android platform  ~ Apply... Sa
= Activar en Project — Opcions: v Camera
. A Lo ) ; ) - Body sensors Dfalse
= En el dispositivo mavil, ir a Ajustes — Aplicaciones y habilitar el Call phone [ fase
permiso de la plicacién: v' Camera Camers ] true
Continue a call started in another app Dfalse
Mejoras:

1.- Modo intermitente:
Afade un timer y un botén para modo intermitente. Pon el el timer el Cédigo:
procedure TForml.TimerlTimer(Sender: TObject);

begin
if Camera.TorchMode = TTorchMode.ModeOn +then Camera.TorchMode := TTorchMode.Modeoff
else Camera.TorchMode := TTorchMode.ModeOn;

end;

2.- Afiade las sombras y extras que se muestran en el ejemplo:
C:\Users\Public\Documents\Embarcadero\Studio\16.0\Samples\Object Pascal\Mobile Samples\Device Sensors and
Services\FlashLight



Sensores mobile. Localizador sensor (version apaptada Samples)

Crea un nuevo proyecto llamado Localizador (File > New > Multidevice application)

Afiade los components de la imagen:—
=] Form1
Localizadar -+ ListBox1
La propiedad del numberbox Lat seradel | . . . . . % locationSeh _;"'_ILat'tUd
tipo decimal Float, con 3 decimales y . :
valores comprendidos entre max: 80 y min Localizar
-80
Latitud 0
La propiedad del numberbox Long sera
del tipo decimal Fl_oat, con 3 decimales y Longitud 0
valores comprendidos entre max: 180 y
min -180 . ;
Situar en map P
+[5] WebBrowser1
= PeretibeiTe
Afiade el codigo: A
procedure TForml.ActivadorSwitch(Sender: TObject);
begin
LocationSensorl.Active := Activador.IsChecked; //-> activa el location sensor
end;
procedure TForml.LocationSensorlLocationChanged(Sender: TObject;
const OldLocation, NewLocation: TLocationCoord2D);
begin
Lat.Value:=NewLocation.Latitude; //->devuelve posicién latitud del GPS
Long.Value:=NewlLocation.Longitude; //->devuelve posicidén longitud del GPS
ButtonlClick(Sender); //->situa en el mapa
end;
procedure TForml.ButtonlClick(Sender: TObject);
begin
formatsettings.DecimalSeparator:='."'; //->formato decimal punto americano

WebBrowserl.Navigate('https://maps.google.com/maps?q="+floattostr(Lat.vValue)+', '+
floattostr(Long.Value));
end;

Compilar en el dispositivo: Conecta un moévil Android al Puerto USB y en el Project Manager, selecciona la
plataforma Android. Recuerda activas las opciones del desarrollador (pulsando varias veces en el numero de
compilacién) en el modvil y tener instalado el driver ADB driver installer.

Ejecutar y comprobar: Escoje Run > Run Without Debugging

Guarda el Proyecto: Localizador y la unidad: Localizadorl.
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Sensores mobile. Orientacidn SeNsor (version apaptada Samples)

Propiedades: PR
El Botdn de Inclinacién muestra el
angulo de rotacion en grados en el Sl
eieX,YyZ 2
Activar sensor:
El Boton de Origen muestra las
coordenadas X,Y y Z del vector que Tilt x:
apunta al norte magnético, medido )
en microteslas.
Tilt Y:
= Crea un nuevo proyecto llamado
Localizador (File > New > Tilt Z:
Multidevice application)
= Afade los components de la .
imagen. Heading X:
* Afade el cédigo y guardal con
el nombre sensorl L Heading Y:
Heading Z:

OrientationSensorlSensorChoosing(
Sender: TObject; const Sensors: TSensorArray;
var ChoseSensorIndex: Integer);
var
I: Integer;
Found: Integer;
begin
Found :
for I :
begin
if botonInclinacion.IsPressed and
(TCustomOrientationSensor.TProperty.TiltX in
TCustomOrientationSensor(Sensors[I]).AvailablePr
operties) then
begin
Found := I;
Break;

_1;
@ to High(Sensors) do

end
else if botonOrigen.IsPressed and
(TCustomOrientationSensor.TProperty.HeadingX in
TCustomOrientationSensor(Sensors[I]).AvailablePr
operties) then
begin
Found := I;
Break;
end;
end;

if Found < © then

begin
Found := 0;
botonInclinacion.IsPressed := True;
botonOrigen.IsPressed := False;

ShowMessage('Brujula no disponible');
end;

ChoseSensorIndex := Found;
end;

botonInclinacionClick(Sender: TObject);

begin
OrientationSensorl.Active := False;
botonOrigen.IsPressed := False;
botonInclinacion.IsPressed := True;

OrientationSensorl.Active :=
swActivar.IsChecked;

~ Inclinacién -

= Layoutl

=+Ef ListBox1

-{E IbHeadingX

& IbHeading¥

-{& IbHeadingZ

B IbOrientationsensor
w00 swhctivar

= IbTiltx

g bTilty

= IbTiltZ

OrientationSensor

(L3 Timer1

OrientationSensor

end;

TimerlTimer(Sender: TObject);

begin
1bTiltX.Text := Format('Tilt X: %f',

[OrientationSensorl.Sensor.TiltX]);
1bTiltY.Text := Format('Tilt Y: %f',

[OrientationSensorl.Sensor.TiltY]);
1bTiltZ.Text := Format('Tilt Z: %f',

[OrientationSensorl.Sensor.TiltZ]);
lbHeadingX.Text := Format('Heading X: %f',

[OrientationSensorl.Sensor.HeadingX]);
lbHeadingY.Text := Format('Heading Y: %f',

[OrientationSensorl.Sensor.HeadingY]);
lbHeadingZ.Text := Format('Heading z: %f',

[OrientationSensorl.Sensor.HeadingZ]);

end;

FormActivate(Sender: TObject);
begin
{$ifdef I10S}

{$ifndef CPUARM}

1bOrientationSensor.Text := 'Sin sensor’;
swOrientationSensorActive.Enabled := False;
{$endif}
{$endif}
end;

botonOrigenClick(Sender: TObject);
begin
OrientationSensorl.Active := False;
botonInclinacion.IsPressed := False;
botonOrigen.IsPressed := True;
OrientationSensorl.Active :=
swActivar.IsChecked;
end;
swActivarSwitch(
Sender: TObject);
begin
{ activate or deactivate the orientation
sensor }
OrientationSensorl.Active :=
swActivar.IsChecked;
Timerl.Enabled := swActivar.IsChecked;
end;



Transmision Bluetooth. Teoria

Los dispositivos BlueTooth pueden actuar como Masters o como Slaves (Amos o esclavos). La diferencia es que un
BlueTooth Slave solo puede conectarse a un master y a nadie mas, en cambio un master BlueTooth, puede
conectarse a varios Slaves o permitir que ellos se conecten y recibir y solicitar informacién de todos ellos, arbitrando
las transferencias de informacion ( Hasta un maximo de 7 Slaves).

Asi pues un nodo BlueTooth puede ser Master o Slave y dispone de una direccién Unica, asi como de un nombre
para identificarse y muy habitualmente también incluye un PIN de conexién o nimero de identificacion que debe
teclearse para ganar acceso al mismo.

Como el BlueTooth lo desarrollé6 Nokia para conectar teléfonos moviles, a otros dispositivos como auriculares,
microfonos o conexiones al audio del coche, existe un procedimiento definido que se llama Pairing (o
emparejamiento) que vincula a dos dispositivos Bluetooth.

Cuando vinculas dos dispositivos BT, se inicia un proceso en el que ellos se identifican por nombre y direccion
interna y se solicitan la clave PIN para autorizar la conexion.

Si el emparejamiento se realiza con éxito, ambos nodos suelen guardar la identificacion del otro y cuando se
encuentran cerca se vuelven a vincular sin necesidad de intervencion manual. Por eso el CD de tu coche reconoce el
movil de tu bolsillo en cuanto te subes y puedes reproducir la musica que tienes en tu Smartphone.

Aunque para que tu BlueTooth pueda enviar o recibir musica, debe aceptar otra norma posterior llamada Advanced
Audio Distribution Profile (A2DP) y que en caso de ser algun sistema antiguo te impedira la reproduccion.

Naturalmente, a lo largo de los afios la norma ha ido variando y existen varias versiones de la misma, con
compatibilidad siempre con las versiones anteriores que se diferencian en la distancia que pueden alcanzar (entre 50
y 100 metros, tedricamente y sin obstaculos) ademas de la velocidad de transferencia.

LOS COMANDOS AT

La transmission serie RS232 solo utilizaba dos hilos de comunicaciones, no habia méas remedio que incorporar una
orden de atencion que significara que a continuacién venia una orden de programacion del modem, que no debia ser
transmitida al otro extremo. Es decir que las ordenes eran del tipo “AT+Orden”, donde AT era el comando
especificado de atencion y al conjunto de ellas se llamé comandos AT. Lisa commandos para HC-06.

COMMAND

FUNCTION

AT Test UART Connection
AT+RESET Reset Device

AT+VERSION Query firmware version
AT+ORGL Restore settings to Factory Defaults
AT+ADDR Query Device Bluetooth Address
AT+NAME Query/Set Device Name
AT+RNAME Query Remote Bluetooth Device’s
AT+ROLE Query/Set Device Role
AT+CLASS Query/Set Class of Device CoD
AT+IAC Query/Set Inquire Access Code
AT+INQM Query/Set Inquire Access Mode

AT+PSWDAT+PIN

Query/Set Pairing Passkey

AT+UART Query/Set UART parameter
AT+CMODE Query/Set Connection Mode
AT+BIND Query/Set Binding Bluetooth Address
AT+POLAR Query/Set LED Output Polarity
AT+PIO Set/Reset a User 1/O pin
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Sensores mobile. Bluetooth (version apaptada de Samples)

Afiadir la libreria a uses: System.Bluetooth
Y los objetos en la declaracién public:

» FBluetoothManager: TBluetoothManager;
» FDiscoverDevices: TBluetoothDevicelList;
» FPairedDevices: TBluetoothDeviceList;

» FAdapter: TBluetoothAdapter;

Afadir el procedure manualmente:
procedure ListaDispositivos(const Sender: TObject;
const ADevices: TBluetoothDeviceList);

procedure TForml.BConectarClick(Sender:TObject);
begin

if FBluetoothManager.ConnectionState =
TBluetoothConnectionState.Connected then
begin

if ComboDevices.ItemIndex > -1 then
FAdapter.Pair(FDiscoverDevices[ComboDevices.Item
Index])

Else ShowMessage('Dispositivo no seleccionado');
end;
end;

procedure TForml.BDesconectarClick(Sender:
TObject);
begin

if FBluetoothManager.ConnectionState =
TBluetoothConnectionState.Connected then
begin

if ComboParejas.ItemIndex > -1 then
FAdapter.UnPair(FPairedDevices[ComboParejas.Item
Index])
else ShowMessage('Dispositivo emparejado no
seleccionado');
end;
end;

procedure TForml.BEmparejadosClick(Sender:
TObject);
var

I: Integer;
begin
if FBluetoothManager.ConnectionState =
TBluetoothConnectionState.Connected then
begin

ComboParejas.Clear;

FPairedDevices :=
FBluetoothManager.GetPairedDevices;

if FPairedDevices.Count > @ then

for I:= @ to FPairedDevices.Count - 1 do

ComboParejas.Items.Add(FPairedDevices[I].DeviceN
ame)

else

ComboParejas.Items.Add('No hay dispositivos

emparejados');

end;
end;

BBuscar e BConectar
Buscar dispositivos ‘ﬂ_«l'll . Conectar
Indicador1
ComboDevices w
Bemparejados Bdesconectar
Emparejados Desconectar
ComboParejas v

procedure TFormil.BuscarClick(Sender: TObject);

begin
AniIndicatorl.Visible := True;
Buscar.Text := 'Buscando...';
Buscar.Enabled := False;

ComboDevices.Clear;
if FBluetoothManager.ConnectionState =
TBluetoothConnectionState.Connected then
begin
Labell.Text := 'Dispositivo Bluetooth
detectado
"'+FBluetoothManager.CurrentAdapter.AdapterNa
me+'"";
FBluetoothManager.StartDiscovery(10000);
FBluetoothManager.OnDiscoveryEnd :=
ListaDispositivos;
end;
end;

procedure TForml.ListaDispositivos (const
Sender: TObject; const ADevices:
TBluetoothDevicelist);

var
I: Integer;

begin
Buscar.Text := 'Terminado';
Buscar.Enabled := True;
AniIndicatorl.Visible := False;
FDiscoverDevices := ADevices;

ComboDevices.Clear;
if ComboDevices.Count=-1 then
ComboDevices.Items.Add( 'No hay dispositivos')

else
for I := @ to ADevices.Count - 1 do
ComboDevices.Items.Add(ADevices[I].DeviceName
+ ' -> "' + ADevices[I].Address);
ComboDevices.ItemIndex := 0;
end;

procedure TForml.FormShow(Sender: TObject);
begin

try
FBluetoothManager:=TBluetoothManager.Current;
FAdapter:=FBluetoothManager.CurrentAdapter;

except

ShowMessage('Bluetooth no detectado');

end;

end;




FireMonkey: Manipular objetosBD (versi6n apaptada de docwiki.embarcadero.com)
4. Escoge: New > Multi-Device / FireMonkey Application > FireMonkey 3D Application
o File > New > Other > Delphi Projects > FireMonkey 3D Application (segun la versién)

5. Afade los siguientes componentes 3D de la Tool Palette al Form4
formulario:

= 1 TLight de la paleta Scenes
= 2 TCubes de la paleta Shapes.

6. Ajusta su posicion arrastando el objeto, y su tamafio, desde la
marca azul de su izquierda, como en la imagen.

() Bitmap Editor

7. Para cambiar la propiedad Material del primer cubo es e
necesario en la versién XE3 afiadir al formulario un
componente: TTextureMaterialSource: Selecciona en el Object
Inspector, la TextureMaterialSource, la propiedad: Texture [...]
>Edit.

Se abrira la ventana editor. Pulsa en el boton Load para cargar oSS B
la textura deseada dese un bitmap y clica en OK al finalizar. Gl S

Asigna al primer cubo el materialsource: »3 TextureMaterialSource1 O cop
TextureMaterialSourcel

8. Para cambiar la iluminacion del segundo cubo, es neceario en la version Xe3 afiadir
al formulario un componente a TLightMaterialSource

Para ajustar la propiedad: Texture [...] >Edit. Se abrira la ventana editor.

Pulsa en el boton Load para cargar la textura deseada dese un bitmap y clica en OK
al finalizar.

Asigna al segundo cubo el materialsource: LightMaterialSourcel
9. Compila la aplicacion para observar la diferencia en la textura entre los dos cubos.

Load...

Save...

oK

Cancel

Clear

Afadir y ajustar objetos 2D, como botones, en espacios 3D:

Para ello arastra desde la paleta 3dlayers,
un component de capa: TLayer3D sobre Tamafio
el formulario y pon, sobre este, un botén:

TButton. Ancho: | € 4 > Mame |SpinAncho
Para similar una superficie 2D, cambia el i Name | Spinélto
tlpo_ de proyeccién del 'I_'Layer3D: _En el Posicién Max 100
Object Inspector, cambia las propiedades: y B = B Min -100
Projection = pjScreen //vista plana . T Name |SpinX
Align = alMostRight . . B :IE:( -12?)0
W'dth = 180 . MName | SpinZ
Afiade 3 TGroupBoxes sobre el objeto fotacion S
TLayer3D. Pon la propiedad de los 3, X: ame |
Align to alTop. A Mame | Tracky
Afiade los objetos y cambia el nombre de z Name | Trackz
los objetos que se muestran en la
imagen.

Afadimos los spinbox para el valor.


http://docwiki.embarcadero.com/Libraries/XE3/en/FMX.Materials.TTextureMaterialSource
http://docwiki.embarcadero.com/Libraries/XE3/en/FMX.Materials.TLightMaterialSource
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Eventos:

= Utilizamos el mismo procedimiento para el ancho y alto: SpinAnchoChange

= Utilizamos el mismo procedimiento al cambiar los tres objetos SpinEdit de posicién: SpinAnchoChange
= Utilizamos el mismo procedimiento al cambiar los tres objetos TrackBar de rotacién: TracKXChange

procedure TForm4.FormlDCreate(Sender: TObject); !/l -> 1lamado en el evento Oncreate del Form
begin
//inicializa tamafio:
SpinAncho.Value:=Cubel.Width; //pone el spinancho al ancho del cubo
SpinAlto.Value:=Cubel.Height; //pone el spinalto al alto del cubo

//inicializa posicidn
SpinX.Value:=Cubel.Position.X;
SpinY.Value:=Cubel.Position.Y;
SpinZ.Value:=Cubel.Position.ZzZ;

//inicializa rotacidn
TrackX.Value:=Cubel.RotationAngle.X;
TrackY.Value:=Cubel.RotationAngle.Y;
TrackZ.Value:=Cubel.RotationAngle.Z;

end;

procedure TForml.SpinAnchoChange(Sender: TObject);

begin

if sender=SpinAncho then Cubel.Width:=SpinAncho.Value // si es llamado desde el spinancho..

else Cubel.Height:= SpinAlto.Value; //sino es que es llamado desde el spinalto
end;

procedure TForml.SpinXChange(Sender: TObject);

begin
Cubel.Position.X:=SpinX.Value; // posicidén x del cubo la que tenga el SpinX
Cubel.Position.Y:=SpinY.Value; // posicidén y del cubo la que tenga el SpinY
Cubel.Position.Z:=SpinZ.Value; // posicidén z del cubo la que tenga el Spinz
end;

procedure TForml.TrackXChange(Sender: TObject);

begin
Cubel.RotationAngle.X:= TrackX.Value; // rotacién x del cubo la que tenga el TrackX
Cubel.RotationAngle.Y:= TrackY.Value; // rotacién y del cubo la que tenga el TrackY
Cubel.RotationAngle.Z:= TrackZ.Value; // rotacién z del cubo la que tenga el TrackZ

end;



Firemonkey: Introduccion a juego Flappy

= Crea un nuevo proyecto llamado Flappy (File > New > Multidevice application)

Creacion de la pantalla de Introduccion:

= Asigna el tamafio a la ventana: 360 width x 480 Height aprox.

" Afadiremos: 3 Imagenes, 1 label, 1 botén y 1 Stylebook.

= En el Stylebook, cargaremos el estilo Air de la carpeta Samples (Apply and close).

= Al Formulario Forml le asignaremos ese
Stylebook1

» Propiedades del botén: Name: PlayBtn —
Text: Play — Textsettings Fontsize: 24 —
StyleSettings Fontcolor: False
» Propiedades del label: Name: Titulo — Text: FI
Flappy - FontColor: Purple — Size: 48 — E#STitwlo appy
Align: Top - Margin Top 50 Z'I‘:;“E‘;‘f'e’“;;mm =
» Propiedades de la Imagel: Name: Fondo — £+ pajarol RyRonkt
Align: Contents — Cargar el MultiresBitMap: &% MultiResBitmap
Fondo.png
» Propiedades de la Image2: Name: Pajaro —  intro Tintro
Align: Center — Cargar el MultiresBitMap: (O search
Pajarol.png JProperties Events |
Action

= Integrar dentro del Label Titulo, un
GlowEffect (Softness 0.4 color gold) y un
FloatAnimation (Position.Y de Startvalue 30 a
stopvalue 67 Duration: 0.5)

ActiveControl
Border (TFormBorc

B ®

Borderlcons [biSystemM
BorderStyle | Sizeable

» | Caption Flappy
ClientHeight 480
Clientwidth 360

Corre el programa (Run ) para comprobar que
el titulo oscila en vertical.
Guarda la unidad con el nombre: ulntro

Cadigo al pulsar el boton Play:

procedure TMenuForm.PlayBtnClick(Sender: TObject);

begin

Game.Iniciar;

Intro.Hide;

{$IFDEF MSWINDOWS}

Game.ShowModal; //si es windows llama a la otra ventana en modo modal
{$ELSE}

Intro.Show; //si no es windows muestra la ventana

{$ENDIF}

end;

Creacion de la pantalla del juego:
Escoge del menu: File — New — Multi-device Form Delphi. Tipo HDForm. Mismo tamafio que el form anterior.
Nombre del form: Game. Nombre de la unidad: uGame
La primera capa Layout: Nombre: ReadyLayout, dentro de esta afiadimos los siguientes objetos:
» Un Label: ReadyLbl con texto Text: Readdy! - size 48 — GlowEffect Gold —
Align Horizontal
» Un rectangulo: Fill: Orange — Stroke: White - Corner rounded con un label
en su interior con el texto: “Pulsa para mantener el pajaro en vuelo”
» Poner esta capa ReadyLayout en Visible:False

» Evento la hacer clic en la capa:
procedure TGame.ReadyLayoutClick(Sender: TObject);

begin
ReadyLayout.Visible := False;
puntuacion.Visible := True;
Timerl.Enabled:=True;

end;

La seqgunda capa Layout: Nombre: GameOverLayout, dentro de esta
afadimos los siguientes objetos con la disposicién de la figura

1 Label con el texto: Game Over _
1 Rectangulo color crema con de esquinas redondeadas y dos labels dentro ; LbIPuntuacion

2 Botones para Salir y Volver a jugar con el cédigo: : o

Salir:  game.close; //Intro.show; e
Volver: game.iniciar; i

Hacemos la capa GameOverLayout visible false. - Salir ~ Replay

Puntuacion

El formulario Game:
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Propiedad Quality: HighPerformance
Evento al ocultar: TGame.FormHide(Sender: TObject):

Objetos:

» Afadimos una imagen de fondo. LLamada fondo y cargamos el MultiresBitMap:

Fondo.png

» Afadimos tres imagenes: pajaroA y pajaroB visible false y pajaro visible true, donde )
cargamos los bitmaps de pajaro.png y pajaro2.png. En el bitmap de pajaroA tendra las PajaroA
alas subidas y en el bitmap del pajaro B tendra las alas bajadas.

Nota: este sprite lo puedes descargar desde la entrada Google: “flappy bird sprite” @

» Afladimos un Timer: Timerl

Timerl.Enabled := False;
Intro.Show;

Pajaro

Timer1

PajaroB

» Afiadimos una capa Layout de nombre tubo que contendra dos rectangulos: TopTubo

y TopTuboCap como en la imagen:

» Afadimos un rectangle con el nombre Suelo y align al Bottom, color tierra.

var
Game: TGame;
Desplazatubos:integer;
factor:single;
EnemyList: TStringlList;
Score: Integer; //puntuacion

PajaroFlag:boolean; //variables permiso para mover

pajaro
JuegoAcabado:boolean;

uses ulntro;

procedure TGame.FormCreate
begin
EnemyList := TStringList.Create;
factor:= 1.5; //factor de escala
GameOverLayout.Position.Y := Game.Height;
end;

procedure TGame.FormDestroy(Sender: TObject);
begin

EnemyList.Free;
end;

procedure TGame.FormHide(Sender: TObject);
begin

Timerl.Enabled := False;

Intro.Show;
end;

procedure TGame.FormMouseDown
Shift: TShiftState; X, Y: Single);
begin
if Timerl.enabled=True then
begin
if pajaro.Position.Y<75 then
begin
pajaro.Position.Y := ©;
end
else
begin
pajaro.Position.Y := pajaro.Position.Y-75;
//sube 75 pixeles
end;
pajaro.RotationAngle := ©; //mira al frente
end;
end;

procedure TGame.ReadyLayoutClick

begin
ReadyLayout.Visible := False;
puntuacion.Visible := True;
Timerl.Enabled:=True;

end;

procedure TGame.TimerlTimer Lé Tubo
const EII:I TopTubo
VelocidadTubos = 2; [ TopTubeCap
//velocidad de paso de los tubos i }
var
R: TLayout;
I: Integer;
POffset,WOffset: Integer;
R1, R2: TRect; //rectangulos
para colisién

begin
Game.BeginUpdate;
if Timerl.Enabled=true then

begin
JuegoAcabado := False;
//si toca suelo se acaba el
juego. ..

if (Pajaro.Position.Y +
Pajaro.Height)>Suelo.Position.Y
then

begin
JuegoAcabado := True;
end;

if Desplazatubos=0 then
begin
if (Random<®.5) then
begin
WOffset := round((200*Factor));
end
else
begin
WOffset := round((250*Factor));
end;
if (Random<@.5) then
begin
POffset := round((-125*Factor));
end
else
begin
POffset := round((-25*Factor));
end;

R := TLayout(Tubo.Clone(Self)); //clona el objeto tubo
EnemyList.AddObject('',R); //anade el objeto R a la
lista

R.Parent := Game;

R.Visible := True; //muestra el objeto tubo

R.Position.X := Game.Width+R.Width; //lo pone a la

derecha

R.Position.Y := (@-WOffset)+POffset; //posiciona arriba

+ altura aleatoria

R := TLayout(Tubo.Clone(Self)); //clona otro objeto

tubo
EnemyList.AddObject('',R); //afade el objeto R a la
lista
R.Parent := Game;
R.Visible := True;

R.Position.X := Game.Width+R.Width;
R.Position.Y := (Game.Height-R.Height+WOffset)+POffset;
//posiciona abajo + altura aleatoria



R.RotationAngle
end;

:= 180; //lo gira 180 grados

if Desplazatubos>(VelocidadTubos*30) then
begin
Desplazatubos := 0;
end
else
begin
Inc(Desplazatubos); //aumenta el desplazamiento
end;
//Rectangulo R1 esta definido por el area del pajaro
R1 :=
Rect(Trunc(Pajaro.Position.X),Trunc(Pajaro.Position.Y),T
runc(Pajaro.Position.X+Pajaro.Width),Trunc(Pajaro.Positi
on.Y+Pajaro.Height));

for I := EnemyList.Count-1 downto @ do
begin
if Assigned(EnemyList.Objects[I]) then
begin
R := TLayout(EnemyList.Objects[I]);
R.Position.X := R.Position.X-5;
//Rectangulo R2 esta definido por el area del tubo
R2 :=
Rect(Trunc(R.Position.X),Trunc(R.Position.Y),Trunc(R.P
osition.X+R.Width),Trunc(R.Position.Y+R.Height));
//si hay interseccién entre las dos areas...
if ChequeaColision(R1,R2)=True then
begin
JuegoAcabado
end
else
begin
if (((R.Position.X+(R.Width/2))<Pajaro.Position.X)
AND (R.Tag=1) AND (R.TagFloat=0)) then
begin
R.TagFloat := 1;
Puntua(Score+1);
end;
end;

:= True;

if (R.Position.X<((R.Width*-1)-10)) then
begin
R.DisposeOf;
EnemyList.Delete(I);
end;
end;
end;

if Pajaro.RotationAngle<90 then
Pajaro.RotationAngle := Pajaro.RotationAngle+5;

Pajaro.Position.Y :=
Pajaro.Position.Y+(Max(Pajaro.RotationAngle,1)/5);
//(recuerda poner libreria math para usar Max)

if PajaroFlag=False then

begin
Pajaro.Bitmap.Assign(PajaroB.Bitmap);
PajaroFlag := True;
end
else
begin

Pajaro.Bitmap.Assign(PajaroA.Bitmap);
PajaroFlag := False;

end;

if JuegoAcabado=True then GameOver;
end;
Suelo.BringToFront;
puntuacion.BringToFront;
if JuegoAcabado=true then GameOverlLayout.BringToFront;
Game.EndUpdate;
end;

procedure TGame.Puntua(I: Integer);

begin

Score := I;

puntuacion.Text := IntToStr(Score);
end;

procedure TGame.BtnSalirClick(Sender: TObject);
begin

Game.Close;

Intro.Show;
end;

procedure TGame.BtnVolverClick(Sender: TObject);
begin

game.iniciar;
end;

function TGame.ChequeaColision( R1, R2
LongInt = 4; OffSetX :
begin
//Rectangulo R1 esta definido por el area del pajaro
//Rectangulo R2 esta definido por el area del tubo
//Detectar si hay intereseccidén entre las dos areas..
//Automatico: -> Result:=IntersectRect(R1,R2);
//Manual: ->
{Result:=( NOT ((R1l.Bottom - (OffSetY * 2) < R2.Top +
OffSetY) or(R1.Top + OffSetY > R2.Bottom - (OffSety *
2)) or( R1.Right - (OffSetX * 2) < R2.Left +
OffSetX) or( Rl.Left + OffSetX > R2.Right - (OffSetX
*2))))5}

end;

: TRect; OffSety
LongInt = 4): Boolean;

procedure TGame.GameOver;
begin
JuegoAcabado := True;
Timerl.enabled:=false;
GameOverLayout.BringToFront;

GameOverlLayout.Visible := True;
Puntuacion.Visible := False;
end;

procedure Tgame.Iniciar;

var

I: Integer;

R: TLayout;

begin
JuegoAcabado := False;
GameOverlLayout.Visible := False;

pajaro.Position.X := 96;
pajaro.Position.Y := 248;
pajaro.RotationAngle := 0;
ReadyLayout.Visible := True;
puntua(®);

end;
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Conversor de monedas de FireMonkey/Multi-device con servicio web

= Selecciona desde el menu Add —> New - Multidevice / FireMonkey Application.

= Elegimos una aplicacién FireMonkey HD y comenzaremos por
desarrollar una aplicacién Windows 32 Bits.

Disefio del formulario:
= Colocamos 2 Edit y 3 Labels como se muestra en la imagen:

= Colocamos un ListBox y configuramos las siguientes propiedades:
StyleLookup = transparentlistboxstyle XE4: GroupingKind = gsGrouped

Clic derecho del mouse en el ListBox donde seleccionaremos la opcién

Eurcs

Label2

Seleccione moneda:
Dolar USs

Pesos
Lioras
Yen

Jgze B

Addltem y agregamos: 5 ListBoxltem’s en XE 4: 2 ListBoxGroupHeader's Dolar CAN

Cambiamos el texto de cada item en la propiedad Text por el nombre de s

cada moneda y dejamos la primra activada (Is selected). 1S

En Xe4 y XE5 puedes afiadir las banderas de cada pais en la propiedad — : ;

ltemData - BitMap También | —— Y 0
Servicio de datos web: Bl o 0.00

= El siguiente paso es generar nuestra clase que consumira el Servicio
Web del Banco de México y que nos proporcionara las paridades o tipos de cambio de las monedas que
vamos a utilizar en nuestra aplicacion, el WSDL de este servicio web es el siguiente:
http://www.banxico.org.mx/DgieWSWeb/DgieWS?WSDL

= Escoge del med: Component: Import — WSDL para  gyimper il i
importar el WSDL a nuestra aplicacion con el WSDL Location
asistente que se muestra. Escoger los valores por Input Location information for the WSDL you would fke to import,

defecto. Al final nos generara un archivo pas.

= Este importador genera el cédigo necesario para
poder consumir el servicioWeb y ya so6lo nos resta
escribir el codigo para que nuestra aplicacion se
conecte y nos muestre las paridades para cada
una de las monedas seleccionadas.

= Afadimos un afadir un componente THTTPRIO
de la carpeta webservices a nuestro formulario, y
afiadir la informacion necesaria a éste. Llamamos
al método “tiposDeCambioBanxicoRequest” del

WSDL Source
Location of WSDL File or URL:
http: ffwww.banxico.org. mx/DgieWsWeb /DgieWs?WsDL E]

Authentication

User Name:
Password:

Proxy:

servicio
Properties | Events |[HTTPRIO1 THTTFRIO
= Al seleccionar la moneda deseada de la lista, | Canverter HTTPRIO1.Converterl
. [HTTPWebNode  |HTTPRIO1.HTTPWebNodel
pasamos el texto de cada moneda, al objeto de Name HTTPRIOT
destino: Port DgieWSPort sTog
procedure TForml.ListBox1Change(Sender: Service DgieWs
Tag 0 HTTPRIOA
TObject); URL
begin WSDLLocation hittp:/ /www.banxico.org.mx/DgieWSWeb /DgieWs?WSDL

Label2.Text:=ListBox1l.Items[ListBox1l.ItemIndex];
1bMonedaExt.ItemData.Bitmap := (Sender as TListBoxItem).ItemData.Bitmap;
end;
» Escribimos el cédigo necesario en el evento OnExit del Edit2 donde capturamos la cantidad a convertir para
que nos muestre el valor en euros de acuerdo a la moneda seleccionada.
procedure TForml.Edit2Exit(Sender: TObject);
begin
valorME

StringReplace(edit2.Text,'$"',"'",[rfReplaceAll]);
valorME := StringReplace(valorME,',',"'',[rfReplaceAll]);
Editl.Text:= format('%5.2m", [strtoCurr(ValorME)*ParidadSel])
end;
= Compilamos. Nuestro servidor de aplicaciones PAServer debe estar en ejecucién para poder realizar la
compilacién de la aplicacion.



Aplicacion Multi-device (Firemonkey) usando SQLite: Notas

Podemos usar dbExpress o FireDAC para conectarse a la Base de Datos. Para plataformas moviles, mejor
usar las bases de datos InterBase ToGo o SQLite. Pueden ejecutarse sobre dispositivos iOS y Android.
» Escoge una nueva apliacién (File > New > Multi-Device Application)

A Crear la base de Datos y la tabla en el Data Explorer
1. Ve al panel Data Explorer,

» En el modo DBExpres: Click-derecho en el nodo SQLite || Ll | O
» En el modo FireDAC : Click-derecho en el nodo SQLiteDatabase # DataSnap Server
Selecciona: Add New Conn(_—:‘,cnonz add SQLite Connection @& Firebird

2. Pon el nombre de la conexién,

7 InterBase

Por ejemplo: Lista Mame for connection: |Listal - 5 SQliegatak
Cancel 5 Add Mew Connection
3. Especifica la ubicacién del archivo de base de datos: Test \Wizard Revert To Defaults
Por ejemplo:
.\Documents\Embarcadero\Studio\Projects\Basesdatos\Lista Parameter Value
En el modo DBExpres (DBX)
En el cuadro de modificacion, en avanzadas, busca la Pooled False
propiedad FaillfMissing y ponla a False (ordena crear un Database  [cadero\Studio|Projects Basesdatos\Listd |

nuevo fichero de base de datos si no existe).

. . . crepm me ~ . User_Name

Nota: Si no existe la propiedadFailifMissing puedes afadirla = ;

con el botén derecho: add Passuor
En el modo FireDAC: (FD) ) Advanced Properties: Modo DBX

De modo similar, pon la propiedad OpenMode: Create UTF8: | property value

Si no existe la crea en formato UTFS8. Database C:\WUsers\Public\Documents\RAD Studio\12.0\Sa
5. Clica en el boton para probar la conexioén y cierra la o S ne

tana con OK DriverPackageloader TDBXSqliteDriverLoader, DEXSqiteDriver 190.bpl

ven i ., ) , DriverUnit Data.DbxSglite
6. Arrastar esta conexion sot_)re el form_ularlo y te apareceré el FailfMissing Faice]
componente tdfConection: Listaconection. MetaDataPackageloader  TDBXSaliteMetaDataCommandFactory,DbxSdite

7. En el Object Inspector, cambia las propiedades del TFDConnection:
»  LoginPrompt a False (sin loquearse).

»  Connected a True.

Cambia el Lockingmode de exclusive a hormal.

Notal: Si se muestra el mensaje:; Failed: "sglited.dll not feund”
Asegurate que el archivo: sqlite3.dll esta en system o descargalo desde: http://www.sqlite.org/download.html.

Crear la Tabla [ & Tables
a. En el modo DBX: Refresh
En el Data Explorer, click-derecho en Tables, y luego seleccione New Table

desde el menu contextual
Escribe el nombre del campo: Elemento del tipo TEXTo y B
guarda la tabla con el nombre: Lista.

Mame Save table Data Type Predision
b. En el modo FireDAC: Elementa INTEGER = w 10

Afiade al formulario un: TFDQuery y cambia las
propiedades:

» Name property to FDQueryCreateTable.

» SQL property: CREATE TABLE IF NOT EXISTS ltem (Elemento TEXT NOT NULL)
Clic derecho en FDQueryCreateTable y escoge Execute.

c. Mediante un admintrador sqlite..
La antigua version del navegador Mozilla Firefox, permite instalar el complemento: SQLite Manager.
Para ejecutarlo: Pulsa la tecla Alt para activar el menu del Firefox y escoge: Herramientas — SqliteManager.
Otra opcion es descargar e instalar la aplicacion gratuita: SQlite administrator de sgliteadmin.orbmu2k.de
Para crear la base de datos: Base de datos — Nueva base de datos: Notas, e indica la carpeta a guardar.
Para cear la tabla: Escoge del menu:
Tabla — Crear tabla. Utiliza los valores de

la figura. Definir Columnas
SQL: CREATE TABLE "main”."lista Mombre Columna  Tipo Datos Clave Primaria? Autoinc?  Permitir Mull?

("elemento" VARCHAR)
VARCHAR ~| [si S Si

Base de Datos: | main  ~ | Nombre Tabla: ||ista
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B Crear el formulario para Android:

1°. Suelta un TToolBar sobre el Formulario.
2°, Suelta un TButton sobre el componente ToolBar. Cambia las propiedades:
¢ Name: ButtonAdd.
e StyleLookup: addtoolbuttonbordered o mejor: addtoolbuttonbordered. Align Left — Margin: 2
3°. Suelta un TButton sobre el componente ToolBar. Cambia las propiedades:
e Name: ButtonDelete.
¢ StyleLookup: deletetoolbutton.
e Text: Borrar
¢ Visible a False. Align Right — Margin: 2
4°, Suelte un TLabel sobre el componente ToolBar. Cambia las propiedades:
¢ Align: alClient.
e StyleLookup: toollabel.
o Text: Lista o Lista de tareas 5 X Bormar
e TextAlign o TextSettings - HorzAlign: taCenter.
50, Arrastra un componente TListBox sobre el formulario.
O un TListView. Cambia la propiedad: Align: alClient.

Conectando a los Datos

1°. Suelta la tabla Lista si no lo has hecho ya, para crear el componente TSQLConnection y TSQLDataSet en
el Formulario (en FireDAC: ListaConection y ListaTable o NotasConection y NotasTable)

2°. En el componente Connection del Formulario, tener la propiedad Connected en True.

3°.  El componente Lista Table del Formulario y cambia la propiedad
Active a True.

4°, Selecciona View > LiveBindings Designer o
View >Tools o Tool Windows > LiveBindings Designer segun

Lista >  Borrar

versiones. _
O pulsa en la opcion Bind Visually del ListBox -
50, Selecciona el elemento de la Lista y arrastra sobre ltemText del Eaincninn =i
Listbox1. Como en la imagen. Synch i
Opcional: Usar el asistente LiveBinding Wizard &N porque ademas te em. Text & Elemento
afiade un componente Navigator. hem Detail o

Hacer Visible el Boton Delete

Seleccione ListBox1 y defina el siguiente manejador de evento para el evento OnltemClick:
» En Delphi: ButtonDelete.Visible := ListBox1l.Selected <> nil;

» En C++: ButtonDelete->Visible = (ListBoxl->Selected != NULL);

Agregar Entrada a la Lista con el botdn + add

Suelta un componente TSQLQuery (Si usas DBExpress) o un TFDQuery (si usas FireDAC) al formulario.
En el Object Inspector cambia la Propiedad Name a SQLQuerylnsert y conecta con SQLConnection
Poner la propiedad SQL como se muestra: INSERT INTO lista (Elemento) VALUES (:Elemento)

»
»
»
»

En la propiedad Params, expande (...). SQLQueryL.Params[0] TPzram
Selecciona el parametro Elemento y cambia a tipo texto: DataType a ftString. [Propertes | Events

» Pulsa en el formualrio, doble-click sobre el componente AddButton. DataType ftString
Afiade el siguiente cAdigo para el evento OnClick: » |Name Elemento

procedure TForml.ButtonAddClick(Sender: TObject);
var
Textoentrada: String;
begin
try
if InputQuery('Entre Nuevo elemento', 'Name', Textoentrada) and (Textoentrada.Trim <> '') then
begin
SQLQueryInsert.ParamByName('Elemento').AsString := Textoentrada;
SQLQueryInsert.ExecSQL();
lista.Refresh;
ListBox1.Repaint;
ButtonDelete.Visible:= ListBoxl.Selected <> nil;
end;
except
on e: Exception do
begin
ShowMessage(e.Message);
end;
end;
end;



En C++:
String caption = "Enter New Item";
String Prompts[1];
Prompts[@] = "Name:";
String Defaults[1];
Defaults[@] = "";
_di_TInputCloseQueryProc Met = new InputQueryMethod(&0nInputQuery Close);
TDialogServiceAsync: :InputQuery(caption, Prompts, @, Defaults, @, (TInputCloseQueryProc *)Met);

La funcion InputQuery muestra un cuadro de dialogo que pide al usuario final que introduzca un texto. Esta
funcion devuelve True cuando el usuario selecciona OK, asi que usted puede agregar datos a la base de datos
sé6lo cuando el usuario selecciona OK y el texto contenga algunos datos

Eliminar una Entrada de la Lista con el botdon Delete

1. Suelte un componente TSQLQuery al formulario.
2. Establecer las siguientes propiedades en el Object Inspector:
e Poner la propiedad Name a SQLQueryDelete.
e Poner la propiedad SQLConnection a SQLITECONNECTION.
e Poner la propiedad SQL como se muestra: DELETE FROM LISTA WHERE elemento = :elemento
e Poner el botén Expand (...) sobre la propiedad Params.
e Poner el parametro Elelemnto a DataType ftString.
3. En el Form Designer, doble-click al componente DeleteButton.
Agregue el siguiente cédigo a este manejador de evento:
procedure TForml.ButtonDeleteClick(Sender: TObject);
var
Textoentrada: String;
begin
Textoentrada:= ListBox1l.Selected.Text;
try
SQLQueryDelete.ParamByName( ‘Elemento’).AsString := Textoentrada;
SQLQueryDelete.ExecSQL();
Lista.Refresh;
ButtonDelete.Visible := ListBox1l.Selected <> nil;
except
on e: Exception do
begin
SHowMessage(e.Message);
end;
end;
end;
En C++:

{
String TaskName = ((TListViewItem*)(ListViewl->Selected))->Text;

try {
FDQueryDelete->ParamByName("Elemento")->AsString = TaskName;
FDQueryDelete->ExecSQL();
FDQueryl->Close();
FDQueryl->0Open();
ButtonDelete->Visible = (ListViewl->Selected != NULL);

catch (Exception &e) {
ShowMessage(e.Message);
}

Probar: Para realizar las pruebas de afiadir y eliminar a la lista puedes realizarlas bajo la plataforma Win32

Almacenar la base de datos local en el movil:
Es necesario realizar las siguientes acciones:
Cambiar la configuracién (para conectarse al archivo de base de datos) a un archivo local bajo el folder
Documents (para Dispositivos iOS) o internal storage (para Dispositivos Android).

Antes de poder ejecutar la aplicacion en el moévil, es necesario configurar el despliegue de su archivo de base

de datos:

. Abrir el Deployment Manager seleccionando Project > Deployment.

. Seleccione Add Files, y seleccione el archivo de base de datos antes creado Lista.db

. cambie Remote Path a StartUp\Documents\ (para iOS) o assets\internal\ (para Android).

. Seleccione la columna Platforms (doble-click en el ellipsis [...] en la linea de Lista.db):

. Aseglrese que iOS Simulator y iOS Device o Android estan presentes para Lista.db

. Quita Win32 desde la lista si esta presente (no hay que copiar archivos de base de datos para Win32).

. Cambia el combo desplegable superior a: All-Configurations - iOS Device platform o All-Configurations -
Android platform y asegurese que Lista.db esta lista se inicia en StartUp\Documents\ o assets\internal.

Especificando la Ubicacion de la base de datos SQLite sobre el Dispositivo Movil

OONEFEA~AWNPE
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1. En el Form Designer, seleccione el componente Lista.
2. En el Object Inspector, doble-click al evento BeforeConnect.
3. Afiada el siguiente cédigo al manejador de evento:
procedure TForml.SQLConnectionSQLiteBeforeConnect(Sender: TObject);
begin
{$IF DEFINED(i0S) or DEFINED(ANDROID)} //si la plataforma es IOS o Android ...
Notas.Params.Values[ 'Database'] := TPath.Combine(TPath.GetDocumentsPath, 'Notas.s3db");
//->0 ...
FDConnectionl.Params.Values[ 'Database’] :=
TPath.Combine(TPath.GetDocumentsPath, ‘'shoplist.s3db');
{$ENDIF}
end;
Agrega System.IOUtils en la uses clause de tu unidad para el registro TPath.

Crear una Tabla si No Existe
Puedes crear una tabla cuando la tabla no existe, usando la sentencia CREATE TABLE IF NOT EXISTS.
Puedes crear una tabla después que el componente SQLConnection se conecte a la base de datos y antes que
el componente TSQLDataSet se conecte a la tabla. Usa los siguientes pasos:
1. En el Form Designer, selecciona el componente ShoppingList o Notas
2. En el Object Inspector, doble-click en el evento: AfterConnect.
3. Agrega el siguiente cédigo para este evento:

procedure TForml.ShoppinglListAfterConnect(Sender: TObject);

begin

SEoppingList.ExecuteDir‘ect( "CREATE TABLE IF NOT EXISTS Item (ShopItem TEXT NOT NULL)');

end;
Comprueba la Aplicacién en un mévil con Android:

» Conecta el mévil por USB al PC, con permisos y de depuracion USB activados y driver ADB android

» En el Project Manager, selecciona la plataforma android.

» Escoge alguno de los siguientes comandos: » Run > Run o » Run > Run Without Debugging

Comprueba su funcionamiento en el mévil.
Para ampliacién, Véase:
http://docwiki.embarcadero.com/RADStudio/Tokyo/en/Mobile Tutorial: Using FireDAC and SQLite (iOS and Android)



http://docwiki.embarcadero.com/RADStudio/Tokyo/en/Mobile_Tutorial:_Using_FireDAC_and_SQLite_(iOS_and_Android)

Ejercico 2 App mobile con SQIlite y FireDAC Lista de tareas

Crear la base de datos y la tabla:
» Si tienes instalado el complemento en Mozilla Firefox, escoge del menu(Alt): Herramientas — SqliteManager
0 ejecuta SQlite administrator descargado de sqliteadmin.orbmu2k.de

» Para crear la base de datos: £ campos Tabla BB Nombre Tabla:  [Tareas
Base de datos — Nueva base de datos: Tareas, e indica lugar

) . Nombre Campo  Tipo Campo Valor Por Omi...  Consl

a guardar: ...projects\Tareas\Tareas.sdb Pid INTEGER  PRIMARY KEY AUTOINCREMENT

» Crea la tabla Tareas con los campos que se muestran en la gltitum VARCHAR(100) NULL
imagen. Etipo VARCHAR(50) Personal MNULL

. .. . . . Elfecha DATE CURRENT_DATE  NULL

Crea una aplicacién Multi-device nueva en Delphi: = detalle VARCHAR(200) NULL
» Escoge una nueva apliacion (File-New-Multi-Device App) Sfinalizado  BOOLEAN 0 NULL

Crear la conexién con la base de datos
En el panel Data Explorer, FireDAC: Click-derecho en el nodo SQLiteDatabase - |4/ ox |3
Selecciona: Add New Connection. @ DataSnap Server
Pon el nombre de la conexién: Tareas @ Firebird
Abre la database: ...Projects\Tareas\Tareas.sdb @ InterBase
Establece: Lockingmode: normal ; DateTimeFormat: DateTime
- Arrastra la tabla Tareas sobre el formulario para que aparezcan los objetos: & -
TareasConnection y TareasTable. e
Activa sus propiedades: Conected: True y Active: true. | Gerearn
- Arrastra sobre el formulario un componente tTabControl. Afiade, al menos, 3 items y alinea al cliente.
- En la primera pestafia, afiade un toolbar con un botén a la derecha con el texto Nueva.
- Afade un ListView alineado al cliente. Pulsa el botén derecho encima y escoge: Bind Visualy.

- Tablteml Tabkem? Tabltem3 111l il
= (=] @ @

(&) & Nuew ©
E E &

Add New Connection

- Enlaza * del BindSourceDB con
Synch del ListView1, y el campo
titulo con el elemento Item.text como
en la magen. —

-

= ndingsListBindSourceDB1 TareasCennection

Slo prueba texto [ >

tipo TareasTable
- Afade el codigo al Boton Nueva:  TabControll.ActiveTab:=Tabiteml;

tareasTable.Append;
Disefio del Tabitem2 para detalles.
Selecciona el segundo tabTabltem2 y Activa el -
modo Bind Visualy o LiveBindings [ Listviewi )
Para generar los controles enlazados: ErErEiLTAg -
Pulsa el botén derecho sobre el BindSource: titulo y ls’"“: 2 (ComboBoxtipo |
escoge: Link to new Control.. TEdit. I:E:IL::cupData titulo |Selectedvalve |
Sobre tipo —: Link to new Control.. TComboBox mrr——— = i:::m
con los items: Personal y Trabajo T R focha m
Sobre fecha —: Link to new Control.. TDateEdit. - detalle
Sobre fecha —: Link to new Control.. TDEdit. finalzade
Sobre finalizado podriamos afiadir un control pate -
tCheckBox o un switch. Text
SelectedDateTime{Self) IsChecked|

Afadimos una Toolbar con dos botones para Cancelar y Guardar, como

1=
en la imagen. Con los siguientes cédigos: e Tobttem e R
Para Guardar: if tareasTable.State in [dsEdit,dsInsert] then Cancelar Guardar
tareasTable.Post;
TabControll.ActiveTab:=Tabitemi; fitulo

prueba texto

Para Cancelar: tareasTable.Cancel;
TabControll.ActiveTab:=Tabiteml;

Para ocultar las pestafas, agregar al evento OnFormShow: TabControll.TabPosition:= TTabPosition.None;
Para ir desde el ListView a la segunda pestafia. Agregar en el evento Onltemclick:
TabControll.ActiveTab:=Tabitem2;
tareasTable.Edit;
Botdn para Borrar: tareasTable.Delete;
tareasTable.Refresh;
TabControll.ActiveTab:=Tabiteml;
Componente tSwitch controlado de manera manual: En la segunada pestafia, afiade y escribe en su evento
OnSwitch: if Switchl.IsChecked then
TareasTablefinalizado.Value:=True
else TareasTablefinalizado.Value:=False;
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Opciones:
También puedes cambiar el codigo al pulsar en el

botén para Guardar la tarea:
Luego se debera actualizar el switch al cambiar de

elemento en la lista listview on Change:
Shwitchl.Ischecked:=

procedure TForml.BGuardarClick(Sender: TObject);
begin
if tareasTable.State in [dsEdit,dsInsert] then
begin

if Switchl.IsChecked then
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TareasTablefinalizado.Value:=True

else TareasTablefinalizado.Value:=False;
end;
tareasTable.Post;
TabControll.ActiveTab:=Tabiteml;
end;

TareasTablefinalizado.Value;

Otro modo mas facil es vincular el swicth
visualmente con LiveBindings:

Afadir imagenes en la lista Listview para control de finalizado:
En el panel Structure, selecciona la lista listViewl — ltemApaerance. ImageListitemBottomDetail.
Afiade una ImageList con los iconos: Listo y pendiente, vinculados al campo finalizado.

Asignar conexién para dispositivo mévil:
» En el componente: TareasConnection, quitar la ruta del archivo Tareas.sdb y en el evento BeforeConect,

afiadir el cddigo para la ruta:
{$IF DEFINED(iOS) or DEFINED(ANDROID)}
TareasConnection.Params.Values[ 'Database’]
{$ENDIF}

» Agrega System.lOUtils en la uses clause de tu unidad para el registro TPath.

» Selecciona en el Project Manager, el target: Android.

» Desde el explorador de Windows, arrastrar el archivo Tareas.sdb sobre el proyecto del Project manager,

» Abrir el Deployment manager (Project — Deployment), busca el archivo Tareas.sdb y cambia la ruta remota
por: assets\internal\ para All configuration - Android Platform. Deploy

» Compila la aplicaciéon en un dispositivo Android conectado. Ver: https://youtu.be/K6yBTXwac70

:= TPath.Combine(TPath.GetDocumentsPath, ‘Tareas.sdb’);

Si existe error de DEF en la conexién FireDAC: Quitar ConectionDefName y poner una ConectionName en la
TareasConnection y en la Conectionname de la TFDqguery con el mismo nombre.

Es recomendable generar la conexién en ejecucion:
with TareasConnection do

begin
Params.Clear;
DriverName:= 'SQLite’;
Params.Values[ 'Database']:=System.Ioutils.TPath.Combine(System.Ioutils.TPath.GetHomePath(), 'Tareas.sdb');
Connected:= True;

end;
TareasTable.SQL.Text:="'SELECT * FROM Tareas';
TareasTable.Active:=true;


https://youtu.be/K6yBTXwac7o

Procedimientos y funciones bésicas - Delphi (alfabético)

Abs
AnsiCompareStr

AnsiCompareText

AnsiLowerCase
AnsiUpperCase
Append
AppendStr
ArcTan
AssignCrt
Assigned

AssignFile

BlockRead
BlockWrite
Break
ChangeFileExt
ChDir

Chr

CloseFile
ClrEol
ClrScr
Concat
Continue
Copy

Cos

Date

DateTimeToFileDate

Returns the absolute value of the argument.
Performs a case sensitive compare of two
strings.

Performs a non-case sensitive compare of
two strings.

Converts characters to lowercase.

Converts characters to uppercase.

Opens an existing file for appending.

Adds a given string to an existing string
Returns the arc tangent of the argument.
Associates a text file with a CRT window.
Tests to determine if a procedural, pointer, or
Delphi object variable is nil.

Assigns the name of an external file to a file
variable.

Reads one or more records into a variable.
Writes one or more records from a variable.
Terminates a for, while, or repeat statement.
Changes a file's extension.

Changes the current directory.

Returns a character with a specified ordinal
number.

Closes an open file.

Clears all characters from the cursor position
to the end of the line without moving the
cursor.

Clears the screen and returns the cursor to
the upper left corner.

Concatenates a sequence of strings.
Continues a for, while, or repeat statement.
Returns a substring of a string.

Returns the cosine of the argument (x is an
angle, in radians).

Returns the current date.

Converts the Delphi date format to
the DOS date format.

DateTimeToStr Converts a value from time format to a string.
DateTimeToString Converts a value from time format to a string.
DateToStr Converts a value from date format to a string.
DayOfWeek Returns the current day of the week

Dec Decrements a variable.

DecodeDate Decodes the specified date

DecodeTime Decodes the specifies time.

Delete Deletes a substring from a string.

DeleteFile Deletes the given file.

DiskFree Returns the amount of free disk space.
DiskSize Returns the size of the specified disk.
EncodeDate Returns values specified in date format.
EncodeTime Returns values specified in time format.

Eof Returns the end-of-file status.

Eoln Returns the end-of-line status of a text file.
Erase Erases an external file.

Exit Exits immediately from the current block.

Exp Returns the exponential of the argument.

ExpandFileName
ExtractFileExt
ExtractFileName
ExtractFilePath
FileAge
FileClose

FileDateToDateTime

FileExists
FileGetAttr
FileGetDate

FileOpen
FilePos
FileRead
FileSearch

FileSeek
FileSetAttr
FileSetDate
FileSize
FillChar

FindClose
FindFirst

FindNext

Expands the given file name.

Returns the file extension.

Returns the file name.

Returns the complete file path.

Returns the age of the file.

Closes afile.

Converts a DOS date format to the

Delphi date format.

Returns True if file exists.

Returns file attributes

Returns the DOS date-and-time stamp of the

file.

Opens a specific file.

Returns the current file position of a file.

Reads from a specific file.

Searches through the directories for a specific

file.

Changes the current position of the file.

Sets file attributes

Sets the DOS date-and-time stamp of the file.

Returns the current size of a file.

Fills a specified number (count) of contiguous

bytes with a specified value.

Terminates a FindFirst/FindNext sequence.
Searches a directory for a specified file name
and set of attributes.

Returns the next entry that matches the name
and attributes.

FloatToDecimal
FloatToStrF
FloatToStr
FloatToText
FloatToTextFmt
FmtLoadStr
FmtStr

Format

FormatBuf
FormatDateTime

FormatFloat

Frac

Free
FreeMem
GetDir
GetMem

GotoXY
Halt

Hi
High

Inc
Include
InitWinCrt

Insert
Int
IntToHex
IntToStr
IOResult

IsValidldent
KeyPressed

Length
Ln

Lo
LoadStr

Low

LowerCase
MaxAvail

MemAvail

MKDir
Move
New

NewsStr
Now
Odd
Ofs
Ord

ParamCount

ParamStr
Pi

Pos

Pred

Ptr

Random
Randomize

Converts a floating-point value to a decimal
representation.
Converts the floating-point value to its string
representation.
Converts the floating-point value to its string
representation.
Converts the given floating-point value to its
decimal representation.
Converts the given floating-point value to its
decimal representation.
Loads a string from a program's resource string
table
Formats a series of arguments and the results
are returned in the parameter Result.
Formats a series of arguments and returns the
result as a Pascal string.
Formats a series of arguments
Formats a date and time using the specified
format.
Formats the floating-point value using the
format string given by Format.
Returns the fractional part of the argument.
Destroys an object instance.
Disposes a dynamic variable of a given size.
Returns the current directory of specified drive.
Creates a dynamic variable of the specified size
and puts the address of the block in a pointer
variable.
Moves the cursor to the given coordinates
within the virtual screen.
Stops program execution and returns to the
operating system.
Returns the high-order byte of the argument.
Returns the highest value in the range of the
argument.
Increments a variable.
Includes an element in a set.
Creates the CRT window if it has not already
been created.
Inserts a substring into a string.
Returns the Integer part of the argument.
Converts an integer to a hexidecimal
Converts an integer to a string
Returns the status of the last I/O operation
performed.
Returns true if the given string is a valid
identifier.
Determines if a key has been pressed on the
keyboard.
Returns the dynamic length of a string.
Returns the natural logarithm of the argument.
Returns the low-order Byte of the argument.
Loads the string resource from the application's
executable file.
Returns the lowest value in the range of the
argument.
Lowercases the given string
Returns the size of the largest contiguous free
block in the heap.
Returns the amount of all free memory in the
heap.
Creates a subdirectory.
Copies bytes from source to dest.
Creates a new dynamic variable and sets a
pointer variable to point to it.
Allocates a new string on the heap.
Returns the current date and time.
Tests if the argument is an odd number.
Returns the offset of a specified object.
Returns the ordinal number of an ordinal-type
value.
Returns the number of parameters passed to
the program on the command line.
Returns a specified command-line parameter.
Returns the value of Pi.
Searches for a substring in a string.
Returns the predecessor of the argument.
Converts a segment base and an offset
address to a pointer-type value.
Returns a random number.
Initializes the built-in random number
generator with a random value.
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Read For typed files, reads a file component into a StrLIComp Compares two strings, up to a maximum
variable. For text files, reads one or more length, without case sensitivity.
values . StrLower Converts a string to lower case.
ReadBuf Inputs a line from the CRT window. StrMove Copies characters from one string to another.
ReadKey Reads a character from the keyboard. StrNew Allocates a string on a heap.
Readln Executes the Read procedure, then skips to StrPas Converts a null-terminated string to a Pascal-
the next line of the file. style string.
ReAllocMem Deallocates a block from the heap. StrPCopy Copies a Pascal-style string to a null-
Rename Renames an external file. terminated string.
RenameFile Renames a file. StrPos Returns a pointer to the first occurrence of a
Reset Opens an existing file. string in another string.
Rewrite Creates and opens a new file. StrScan Returns a pointer to the first occurrence of a
RmDir Removes an empty subdirectory. character in a string.
Round Rounds a real-type value to an Integer-type StrRScan Returns a pointer to the last occurrence of a
value. character in a string.
RunError Stops program execution. StrToDate Coverts a string to a date format.
ScrollTo Scrolls the CRT window to show a screen StrToDateTime Converts a string to a date/time format.
location. StrToFloat Converts the given string to a floating-point
Seek Moves the current position of a file to a value.
specified component. StrTolnt Converts a string to an integer
SeekEof Returns the end-of-file status of a file. StrTolntDef Converts a string to an integer or the default
SeekEoln Returns the end-of-line status of a file. StrToTime Converts a string to a time format.
Seg Returns the segment of a specified object. StrUpper Converts a string to upper case.
SetTextBuf Assigns an I/O buffer to a text file. Succ Returns the successor of the argument.
Sin Returns the sine of the argument. Swap Swaps the high- and low-order bytes of the
SizeOf Returns the number of bytes occupied by the argument.
argument. TextToFloat Converts the null-terminated string to a
SPtr Returns the current value of the SP register. floating-point value.
Sar Returns the square of the argument. Time Returns the current time.
Sart Returns the square root of the argument. TimeToStr Converts a time format to a string.
SSeg Returns the current value of the SS register. TrackCursor Scrolls the CRT window if necessary to
Str Converts a numeric value to a string. ensure that the cursor is visible.
StrCat Appends a copy of one string to the end of Trunc Truncates a real-type value to an Integer-type
another and returns the concatenated string. value.
StrComp Compares two strings. Truncate Truncates the file at the current file position.
StrCopy Copies one string to another. TypeOf Returns a pointer to an object type's virtual
StrDispose Disposes a string on a heap. method table.
StrECopy Copies one string to another and returns a UpCase Converts a character to uppercase.
pointer to the end of the resulting string. UpperCase Uppercases the given string.
StrEnd Returns a pointer to the end of a string. Val Converts a string value to its numeric
StrFmt Formats a series of arguments. representation.
StrLCat Appends characters from one string to the WhereX Returns the X coordinate of the current cursor
end of another and returns the concatenated location.
string. WhereY Returns the Y coordinate of the current cursor
StriComp Compares two strings without case location.
sensitivity. Write For typed files, writes a variable into a file
StrLComp Compares two strings, up to a maximum component. For text files, writes one or more
length. values to the file
StrLCopy Copies characters from one string to another. WriteBuf Writes a block of characters to the CRT
StrLen Returns the number of characters in Str. window.
StrLFmt Formats a series of arguments and the result WriteChar Writes a single character to the CRT window.
contains a pointer to the destination buffer. Writeln



